## Contents

### Using Crucible

- Supported platforms ........................................ 5
- Installing Crucible on Windows ............................ 9
- Installing Crucible on Linux and Mac .................... 11
- Configuring JIRA Integration in the Setup Wizard ...... 14
- Starting to use Crucible ..................................... 21
- Installing and upgrading Git ............................... 27

- Using Crucible ............................................... 30
  - Using the Crucible screens ............................... 31
    - Browsing all reviews .................................. 33
    - Browsing source files ................................ 35
    - Browsing projects .................................... 37
    - Changing your User Profile ............................ 38
    - Using favourites ...................................... 38
    - Using Wiki Markup in Crucible ....................... 40
    - Using RSS feeds in Crucible ......................... 45
    - Using keyboard shortcuts in Crucible ............... 45
    - Crucible icons ........................................ 47
  - The Crucible workflow .................................... 51
    - Defining your workflow ................................ 55
    - Roles and status classifications ...................... 57
  - Creating a review ......................................... 58
    - Creating a review from JIRA ......................... 61
    - Creating a review from a URL ....................... 62
    - Creating a Snippet Review ............................ 63
    - Creating reviews from the command line ............. 63
  - Adding content to the review ............................ 66
    - Iterative reviews ..................................... 73
    - Creating patch files for pre-commit reviews ....... 75
  - Choosing reviewers ....................................... 80
  - Performing the review .................................... 82
    - Starting a review ..................................... 83
    - Commenting on reviews ................................ 84
    - Sending a review's comments via email ................ 87
    - Change set discussions ................................ 87
    - Flagging defects ....................................... 88
    - Viewing reports ....................................... 89
      - Review Coverage report .............................. 91
    - Completing your review ................................ 95
    - Using the Review History Dialog ...................... 97
  - Summarizing and closing the review ...................... 98
  - Managing your reviews .................................... 100
    - Using Review Reminders ................................ 100
    - Moving a review to another project ................... 101
    - Using Progress Tracking ................................ 102
    - Using Time Tracking ................................... 104
    - Viewing people's statistics in Crucible ............. 105
    - Viewing Project Statistics ............................ 109
    - Deleting a review ...................................... 111
  - Searching Crucible ........................................ 112
    - JIRA integration in Crucible .......................... 117
    - Creating JIRA issues from the review ............... 121
    - Transitioning JIRA issues ............................. 122
  - Administering Crucible ................................... 123
    - Best practices for Crucible configuration .......... 124
    - Crucible and FishEye ................................. 124
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administering projects</td>
<td>125</td>
</tr>
<tr>
<td>Creating a project</td>
<td>126</td>
</tr>
<tr>
<td>Storing all revisions under review</td>
<td>128</td>
</tr>
<tr>
<td>Enabling the moderator role</td>
<td>128</td>
</tr>
<tr>
<td>Setting default review objectives</td>
<td>129</td>
</tr>
<tr>
<td>Editing a project</td>
<td>130</td>
</tr>
<tr>
<td>Configuring repositories</td>
<td>132</td>
</tr>
<tr>
<td>Setting up a Git repository in Crucible</td>
<td>133</td>
</tr>
<tr>
<td>Setting up a Perforce repository in Crucible alone</td>
<td>135</td>
</tr>
<tr>
<td>Setting up a Subversion repository in Crucible alone</td>
<td>136</td>
</tr>
<tr>
<td>Enabling reviews from the server file system in Crucible</td>
<td>138</td>
</tr>
<tr>
<td>Setting up a repository via FishEye</td>
<td>138</td>
</tr>
<tr>
<td>Configuring commit hooks</td>
<td>138</td>
</tr>
<tr>
<td>Setting up users and security</td>
<td>143</td>
</tr>
<tr>
<td>Permissions</td>
<td>143</td>
</tr>
<tr>
<td>Creating a permission scheme</td>
<td>144</td>
</tr>
<tr>
<td>Associating a permission scheme with a project</td>
<td>146</td>
</tr>
<tr>
<td>Agile permissions schemes in Crucible</td>
<td>148</td>
</tr>
<tr>
<td>Migrating to an external database</td>
<td>149</td>
</tr>
<tr>
<td>Migrating to MySQL</td>
<td>150</td>
</tr>
<tr>
<td>Migrating to Oracle</td>
<td>154</td>
</tr>
<tr>
<td>Migrating to PostgreSQL</td>
<td>156</td>
</tr>
<tr>
<td>Migrating to SQL Server</td>
<td>159</td>
</tr>
<tr>
<td>Backing up and restoring Crucible data</td>
<td>162</td>
</tr>
<tr>
<td>Customizing Crucible</td>
<td>169</td>
</tr>
<tr>
<td>Customising the welcome message</td>
<td>169</td>
</tr>
<tr>
<td>Customising email notifications</td>
<td>170</td>
</tr>
<tr>
<td>Freemarker Data Model for Email Templates</td>
<td>172</td>
</tr>
<tr>
<td>Customising the defect classifications</td>
<td>172</td>
</tr>
<tr>
<td>Configuring user managed mappings</td>
<td>175</td>
</tr>
<tr>
<td>Enabling Access Logging in Crucible</td>
<td>175</td>
</tr>
<tr>
<td>Linking Crucible to JIRA</td>
<td>177</td>
</tr>
<tr>
<td>Supported fields for inline issue creation</td>
<td>179</td>
</tr>
<tr>
<td>Using Crucible gadgets</td>
<td>181</td>
</tr>
<tr>
<td>Linking to another application</td>
<td>183</td>
</tr>
<tr>
<td>Running Crucible as a Windows service</td>
<td>184</td>
</tr>
<tr>
<td>Managing add-ons</td>
<td>187</td>
</tr>
<tr>
<td>Crucible FAQ</td>
<td>188</td>
</tr>
<tr>
<td>Crucible Resources</td>
<td>189</td>
</tr>
<tr>
<td>General FAQs</td>
<td>190</td>
</tr>
<tr>
<td>Can I deploy Crucible or FishEye as a WAR?</td>
<td>190</td>
</tr>
<tr>
<td>How do I force reviews to include SVN property changes?</td>
<td>190</td>
</tr>
<tr>
<td>How to Automate Daily Crucible Backups</td>
<td>191</td>
</tr>
<tr>
<td>Licensing FAQ</td>
<td>191</td>
</tr>
<tr>
<td>What happens if I decide to stop using FishEye with Crucible</td>
<td>191</td>
</tr>
<tr>
<td>Do I need a FishEye license to run Crucible?</td>
<td>192</td>
</tr>
<tr>
<td>Updating your Crucible license</td>
<td>193</td>
</tr>
<tr>
<td>Support Policies</td>
<td>193</td>
</tr>
<tr>
<td>Bug Fixing Policy</td>
<td>193</td>
</tr>
<tr>
<td>New Features Policy</td>
<td>194</td>
</tr>
<tr>
<td>Security Bugfix Policy</td>
<td>195</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>195</td>
</tr>
<tr>
<td>JIRA Integration Issues</td>
<td>196</td>
</tr>
<tr>
<td>Problems with very long comments and MySQL migration</td>
<td>196</td>
</tr>
<tr>
<td>Contributing to the Crucible documentation</td>
<td>197</td>
</tr>
<tr>
<td>Glossary</td>
<td>198</td>
</tr>
<tr>
<td>approve</td>
<td>198</td>
</tr>
<tr>
<td>authors in Crucible</td>
<td>198</td>
</tr>
<tr>
<td>code review</td>
<td>198</td>
</tr>
<tr>
<td>comment</td>
<td>198</td>
</tr>
<tr>
<td>creator</td>
<td>199</td>
</tr>
<tr>
<td>defect</td>
<td>199</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------</td>
</tr>
<tr>
<td>moderator</td>
<td>199</td>
</tr>
<tr>
<td>participant</td>
<td>199</td>
</tr>
<tr>
<td>permission scheme</td>
<td>199</td>
</tr>
<tr>
<td>permissions in Crucible</td>
<td>199</td>
</tr>
<tr>
<td>projects in Crucible</td>
<td>200</td>
</tr>
<tr>
<td>review duration</td>
<td>201</td>
</tr>
<tr>
<td>reviewer</td>
<td>201</td>
</tr>
<tr>
<td>role</td>
<td>201</td>
</tr>
<tr>
<td>state</td>
<td>201</td>
</tr>
<tr>
<td>statement of objective</td>
<td>201</td>
</tr>
<tr>
<td>users in Crucible</td>
<td>201</td>
</tr>
<tr>
<td>Collecting analytics in Crucible</td>
<td>201</td>
</tr>
<tr>
<td>Releases</td>
<td>202</td>
</tr>
</tbody>
</table>
Getting Started

Atlassian Crucible is the on-premises code review solution for enterprise teams. It allows your development teams to catch major defects, improve code architecture, and discuss desired improvements, without the need for meetings.

This section describes how to install, set up and get started with Crucible.

System requirements

Crucible is a Java web application, that works with all modern browsers. See our Supported platforms page to find out about system requirements.

Download and install Crucible

- Windows
- Mac
- Linux

Start using Crucible

For a short introduction see Starting to use Crucible. You’ll learn how to:

- Add a repository
- Create a project
- Create and perform reviews

Integrate Crucible with other Atlassian applications

As a first step, see JIRA integration in Crucible.

Read more about using Crucible

To find out more about using Crucible with your team, see Using Crucible.

To find out how to manage the Crucible server, see Administering Crucible.

Supported platforms

This page lists the supported platforms for Crucible 4.0.x and its minor releases.

Key: ☑ = Supported  🚫 = Deprecated  ✗ = Not Supported

<table>
<thead>
<tr>
<th>Java</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle JRE / JDK</td>
<td>1.8</td>
<td>1.7</td>
</tr>
</tbody>
</table>

Crucible requires the Java Runtime (JDK or JRE), version as noted. Pre-release/Early access versions of Java are not supported.

We highly recommend that you use the Oracle JVM (or OpenJDK for Linux only). Other Java implementations have not been tested.

You can download an Oracle Java Runtime.

For the OpenJDK, download and install
OpenJDK | 1.8 (Linux only)

Instructions for Linux flavors are at [http://openjdk.java.net/install/](http://openjdk.java.net/install/).

Please note:
- Once you have installed the Java, you need to set the JAVA_HOME environment variable. See [Installing Crucible on Windows](#) or [Installing Crucible on Linux and Mac](#) for details.
- If you are using a 64-bit JVM, please ensure that you’ve set your max heap size (\texttt{--Xmx}) to a reasonable value, considering the RAM requirements of your system.

Support for Java 7 was removed in Crucible 3.9, as previously announced.

### Operating Systems

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Compatibility</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows</td>
<td>✓</td>
</tr>
<tr>
<td>Linux</td>
<td>✓</td>
</tr>
<tr>
<td>Apple Mac OS X</td>
<td>✓</td>
</tr>
</tbody>
</table>

Crucible is a pure Java application and should run on any platform provided the requirements for the JRE or JDK are satisfied.

Although Crucible can be run in virtualized environments, Atlassian is not yet able to provide technical support for performance-related problems in a virtualized environment. If you do chose to run Crucible in a VM, please ensure that you choose a VM with good IO throughput.

### Databases

<table>
<thead>
<tr>
<th>Database</th>
<th>Compatibility</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>HSQLDB</td>
<td>✓ Bundled; for evaluation only</td>
<td>The Crucible built-in database, running HSQLDB, is somewhat susceptible to data loss during system crashes. We recommend that you do not use HSQLDB for production systems. External databases are generally more resistant to data loss during a system crash and are more suited for production use. See the <a href="#">Crucible Database documentation</a> for further details.</td>
</tr>
</tbody>
</table>
| MySQL        | ✓ MySQL Enterprise Server 5.1+ | For MySQL:
  - ❌ For 5.1, versions earlier than 5.1.10 are not supported
  - ❌ For 5.6, versions earlier than 5.6.11 are not supported
  - ❌ For 5.7, versions earlier than 5.7.5 are not supported
  - ❌ Support for MySQL 5.0 was removed in Crucible 3.3. See [End of Support Announcements for Crucible](#).
  - ❌ MariaDB and Percona variants of

<table>
<thead>
<tr>
<th>PostgreSQL</th>
<th>✓ 9.0, 9.1, 9.2, 9.3, 9.4</th>
<th>For MySQL:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>✓ 8.3, 8.4</td>
<td></td>
</tr>
<tr>
<td></td>
<td>❌ 8.2</td>
<td></td>
</tr>
<tr>
<td>Database</td>
<td>Supported versions</td>
<td>Note</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Oracle</td>
<td>12c, 11g</td>
<td>MySQL are not supported, and are known to cause issues when used with Crucible.</td>
</tr>
<tr>
<td>SQL Server</td>
<td>2012, 2008, 2008 R2, 2005</td>
<td>Support for PostgreSQL 8.2 was removed in Crucible 3.3. See End of Support Announcements for Crucible.</td>
</tr>
</tbody>
</table>

**Web browsers**

<table>
<thead>
<tr>
<th>Browser</th>
<th>Supported versions</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Internet Explorer</td>
<td>10.0, 11.0, 9.0</td>
<td>Minimum screen resolution of 1024x768. Recommended screen resolution of 1280x768 or above. Support for Internet Explorer 9 was removed in Crucible 3.9. See End of Support Announcements for Crucible.</td>
</tr>
<tr>
<td>Mozilla Firefox</td>
<td>Latest stable version supported 3.6, 4.0</td>
<td>Support for Firefox 3.6 and 4.0 was removed in Crucible 3.7.</td>
</tr>
<tr>
<td>Safari</td>
<td>Latest stable version supported 4, 5</td>
<td>Support for Safari 4 and 5 was removed in FishEye 3.7.</td>
</tr>
<tr>
<td>Chrome</td>
<td>Latest stable version supported</td>
<td></td>
</tr>
</tbody>
</table>

**Version Control Systems**

<table>
<thead>
<tr>
<th>System</th>
<th>Server: 1.1, 1.2, 1.3, 1.4, 1.5, 1.6, 1.7, 1.8, 1.8</th>
<th>Client: SVNKit (bundled &amp; the default), Native JavaHL 1.8, Native JavaHL 1.7, Native JavaHL 1.6</th>
<th>Crucible 3.1, and later, do not support the native JavaHL 1.6 client. See Native support for SVN for discussion.</th>
</tr>
</thead>
<tbody>
<tr>
<td>CVS (and CVSNT)</td>
<td>All versions</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Perforce</td>
<td>Client version 2007.3 or later, Server version 2005.1 or later</td>
<td>The Server must support the ztag tagged protocol.</td>
<td>Perforce Streams, introduced in 2011.1, is not currently supported. See <a href="open">FE-3886</a> - support for Streams in p4</td>
</tr>
<tr>
<td>Documentation for Crucible 4.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------------------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Git</strong></td>
<td>These are the versions of Git that we currently test Crucible against.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>🔄 2.8.2</td>
<td>✗ Git 1.8.4.3 is not supported. See BSERV-4101 - Clone and fetch fail with &quot;protocol error: impossibly long line&quot; [CLOSED]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>🔄 2.7.3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>🔄 2.6.1, 2.6.5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>🔄 2.5.4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>🔄 2.4.10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>🔄 2.3.10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>🔄 2.2.3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>🔄 2.1.4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>🔄 2.0.5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>🔄 1.9.5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>🔄 1.8.0.3, 1.8.1.5, 1.8.2.3, 1.8.3.4, 1.8.4.5, 1.8.5.6</td>
<td>[Security vulnerability CVE-2014-9390] affects multiple Git versions. Crucible itself is not affected, however you should update your clients to a patched maintenance version: v1.8.5.6, v1.9.5, v2.0.5, v2.1.4 and v2.2.1 or newer.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>🔄 1.7.1.1, 1.7.2.5, 1.7.3.5, 1.7.4.5, 1.7.5.4, 1.7.6.6, 1.7.7.7, 1.7.8.6, 1.7.9.7, 1.7.10.5, 1.7.11.7, 1.7.12.4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Mercurial</strong></td>
<td>These are the versions of Meercurial that we currently test Crucible against.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>🔄 3.0.2, 3.1.2, 3.2.4, 3.3.3, 3.4.2, 3.5.2, 3.6.3, 3.7.2</td>
<td>As of version 3.6.3, Crucible supports Meercurial 3.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>🔄 2.0.2, 2.1.2, 2.2.3, 2.3.2, 2.4, 2.5, 2, 2.6.3, 2.7.2, 2.8.2, 2.9.1</td>
<td>✗ Meercurial 2.1 has a bug that makes it incompatible with Crucible. Please use Meercurial 2.1.1 or later. You should restart Crucible after upgrading Meercurial.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>🔄 1.5.1, 1.5.4, 1.6.4, 1.7.5, 1.8.4, 1.9.3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Atlassian applications</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Crowd</strong></td>
<td>From version 2.8.x, FishEye bundles the Crowd 2.4.1 client library, and supports the Crowd 2.4.x server, and later versions.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>✔ Crowd 2.4.x+</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>✔ Crowd client library: 2.4.1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>JIRA</strong></td>
<td>The JIRA FishEye Plugin is bundled with JIRA. If you are using earlier versions of JIRA you can upgrade the plugin in JIRA to get support for Crucible.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>✔ JIRA FishEye Plugin 6.1.0+</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Deployment Notes for Source Code Repositories

Crucible can also store uploaded files in its own database, removing the need for any kind of repository. A number of external databases are supported when Crucible is used with FishEye. See the FishEye Supported Platforms.

#### WAR deployment

FishEye/Crucible is a standalone Java program. It cannot be deployed to web application servers such as WebSphere, Weblogic or Tomcat.
Single sign on with Atlassian Crowd
From version 2.8.x, FishEye bundles the Crowd 2.4.1 client library, and supports the Crowd 2.4.x server, and later versions.

Installing Crucible on Windows

1. Check supported platforms
Better check the Supported platforms page first; it lists the application servers, databases, operating systems, web browsers and JDKs that we have tested Crucible with, and that we recommend.

Atlassian only officially supports Crucible running on x86 hardware and 64-bit derivatives of x86 hardware.

2. Create a dedicated Crucible user (recommended)
For production installations, we recommend that you create a new dedicated Windows user that will run Crucible on your system. This user:

- Should not have admin privileges.
- Should be a non-privileged user with read, write and execute access on the Crucible home (install) directory and instance (data) directory. These directories are described below.
- Should only have read access to your repositories.

If you created a dedicated Crucible user, ensure you are logged in as this user to complete the remaining instructions.

3. Check your version of Java
In a command prompt, run this:

```
java -version
```

The version of Java should be 1.8.x.

The recommended way to install Crucible is to use the installer, which installs Crucible as a Windows service – see step 5 below.

If you don’t see a supported version of Java, then get Java...

Download and install the Java Platform JDK from Oracle’s website.

⚠️ We recommend that the Java install path should not contain spaces, so don’t install into C:\Program Files\Java\. Instead, use a path like C:\Java.

Now try running 'java -version' again to check the installation. The version of Java should be 1.8.x.

4. Check that Windows can find Java

Windows uses the JAVA_HOME environment variable to find Java. To check that, in a new command prompt, run:
echo %JAVA_HOME%

You should see a path to the Java install location. We recommend that this path does not contain spaces, and that JAVA_HOME should point to the JDK home path.  

If you don’t see a path without spaces...

- If you see a path with spaces, like C:\Program Files\Java\, then sorry, but go back to 3. and reinstall Java to a location that doesn’t have spaces.
- If you don’t see a path at all, or if you just see %JAVA_HOME%, then set JAVA_HOME as follows:

For Windows 7:

1. Go to Start, search for “sys env” and choose Edit the system environment variables.
2. Click Environment Variables, and then New under ‘System variables’.
3. Enter “JAVA_HOME” as the Variable name, and the absolute path to where you installed Java JDK as the Variable value, that is, something like C:\Java\jdk1.7.0_51. Don’t use a trailing backslash. We recommend that JAVA_HOME should point to the JDK home path.
4. Now, in a new command prompt, try running ‘java -version’. You should see the same version of Java as you saw above.

5. Now it’s time to get Crucible

Download the Crucible installer from the Atlassian download site.

There are 32-bit and 64-bit installers for Crucible on Windows. Each installer adds Crucible as a Windows service, and starts the service, automatically. The express install creates, by default, a Data directory and a separate install directory in C:\Atlassian. The custom install mode allows you to choose different locations for the install and Data directories, with the restriction that the Data directory must not be contained in the install directory.

- The installer creates the FISHEYE_INST system environment variable.
- The path to the installation directory is referred to as the <Crucible home directory> in these instructions.
- You need separate Crucible data directories if you want to run multiple copies of Crucible.
- If you expect a large number of users for this Crucible installation, and Crucible will be connected to an external database, consider installing Crucible on a different server from the one running the external database, for improved performance.
- If you have a large number of repositories, we recommend you increase the default number of files that Crucible is allowed to open. See the following knowledge base article for more info: Subversion Indexer Paused with "Too many open files" Error.
- For Crucible 3.4.4 and later, you can edit JVM parameters for the Windows service by going to Start > All Programs > Crucible > Configure Crucible. Ensure that you restart the Crucible service when finished. Do not reference any environment variables in the settings (e.g. %FISHEYE_INST%). Instead, set the actual path.

6. Visit Crucible!

Give the Crucible service a minute to launch. Then, in a web browser on the same machine, go to http://localhost:8060/ (or, from another machine, type http://hostname:8060/, where hostname is the name of the machine where you installed Crucible).

Enter your license, then an admin password, to finish the setup. Note that this password is for the ‘built-in’ Crucible admin user. You can log in as this user, if necessary, by clicking the Administration link in the page footer. See also How to reset the Administration Page password in Fisheye or Crucible.

You can postpone setting up JIRA integration until later if you wish; see Configuring JIRA integration in the Setup Wizard.
7. Connect to an external database (recommended)

If you intend to use this Crucible installation in a production environment, it is highly recommended that you use one of the supported external databases. See Migrating to an external database.

If you are evaluating Crucible, or don’t wish to do this now, Crucible will happily use its embedded database, and you can easily migrate later.

8. Set up your mail server

Configure the Crucible email server so that users can get notifications from Crucible. See Configuring SMTP.

9. Add users and repositories

Now is the time to set up your users in Crucible, and to tell Crucible about any existing repositories you have. Please read Starting to use Crucible for the details.

Crucible will perform an initial index of your repositories, during which it accesses, indexes and organizes a view of your repositories (including all historical items) back to the earliest commits. If you are evaluating Crucible, we suggest that you index a single project, so you can use Crucible as soon as possible. If you choose to index your entire repository, be aware that this can take a long time (possibly days) for massive or complex repositories and can be more complex to set up (especially for Subversion). The basic process is slightly different for each SCM type.

10. Stop Crucible (optional)

Control the Crucible service from the Windows administration console. Alternatively, in a command prompt, change directory to `<Crucible home directory>` and run this:

```
bin\stop.bat
```

Installing Crucible on Linux and Mac

Hey! We’re going to install Crucible on a Linux box, or a Mac. There are a few steps involved, but we think you’ll find it easy to follow along. If you already have FishEye installed, you should read Upgrading from FishEye to Crucible instead.

1. Check supported platforms

Better check the Supported platforms page first; it lists the application servers, databases, operating systems, web browsers and JDKs that we have tested Crucible with, and that we recommend.

Atlassian only officially supports Crucible running on x86 hardware and 64-bit derivatives of x86 hardware.

Related pages:
- Installing Crucible on Windows
- Starting to use Crucible
- Supported platforms

2. Create a dedicated Crucible user (recommended)

For production installations, we recommend that you create a new user account on your operating system that is dedicated to running Crucible. This user:

- Should not have admin privileges.
- Should be a non-privileged user with read, write and execute access on the Crucible home (install) directory and instance (data) directory. These directories are described below.
- Should only have read access to your repositories.
If you created a dedicated Crucible user, ensure you are logged in as this user to complete the remaining instructions.

3. Check your version of Java

In a terminal, run this:

```bash
terminal java -version
```

The version of Java should be 1.8.x.

If you don't see a supported version of Java, then get Java...

Download and install the Oracle Java Platform JDK, or OpenJDK.

Now try running 'java -version' again to check the installation. The version of Java should be 1.8.x.

4. Check that the system can find Java

In a terminal, run this:

```bash
terminal echo $JAVA_HOME
```

You should see a path something like:

<table>
<thead>
<tr>
<th>OS</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>OSX</td>
<td>/System/Library/Frameworks/JavaVM.framework/Versions/CurrentJDK/Home/</td>
</tr>
<tr>
<td>Linux</td>
<td>/usr/lib/jvm/default-java</td>
</tr>
</tbody>
</table>

If you don't see a path to the Java location, then set JAVA_HOME...

**Linux**

Do either of the following:

- If JAVA_HOME is not set, log in with 'root' level permissions and run:

  ```bash
terminal echo JAVA_HOME="path/to/JAVA_HOME" >> /etc/environment
```

  where path/to/JAVA_HOME may be like: /usr/lib/jvm/default-java

- If JAVA_HOME needs to be changed, open the /etc/environment file in a text editor and modify the value for JAVA_HOME to:

  ```bash
  JAVA_HOME="path/to/JAVA_HOME"
  ```

  It should look like:

  ```bash
  JAVA_HOME=/usr/lib/jvm/default-java
  ```

**Mac**

Insert the following in your ~/.profile file:

```bash
JAVA_HOME="path/to/JAVA_HOME"
export JAVA_HOME
```

where path/to/JAVA_HOME may be like: /System/Library/Frameworks/JavaVM.framework/Versions/CurrentJDK/Home/

Refresh your ~/.profile in the terminal and run:

```bash
source ~/.profile
$JAVA_HOME/bin/java -version
```

You should see a version of Java that is 1.8.x or higher, like:

```bash
java version "1.8.0_05"
```
5. Now it’s time to get Crucible

1. Download Crucible from the Atlassian download site.
2. Please check your unzip program before extracting the downloaded zip file. Some archive-extract programs cause errors when unzipping the Crucible zip file:
   - Windows users must avoid the Windows built-in unzip utility, as it doesn’t extract all the files. Use a third-party unzip program like 7-Zip or Winzip.
   - Solaris users will need to use GNU tar to handle the long file names.
3. Extract the downloaded file to an install location:
   - Folder names in the path to your Crucible executable should not have spaces in them. The path to the extracted directory is referred to as the <Crucible home directory> in these instructions. If you use FishEye and Crucible together, they run as one instance, and use the same home directory – see Crucible and FishEye.
   - If you expect to have a large number of users for this Crucible installation, and Crucible will be connected to an external database, consider installing Crucible on a different server from the one running the external database, for improved performance.

6. Tell Crucible where to store your data

The Crucible instance directory is where your Crucible data is stored.

1. Create your Crucible instance directory.
2. Tell Crucible where you created the instance directory by adding a FISHEYE_INST environment variable as follows:

<table>
<thead>
<tr>
<th>Linux</th>
<th>Mac</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open the /etc/environment file in a text editor and insert: FISHEYE_INST=&quot;path/to/&lt;Crucible instance directory&gt;&quot;</td>
<td>Open the ~/.profile file for the current user in a text editor and insert: FISHEYE_INST=&quot;path/to/&lt;Crucible instance directory&gt;&quot; export FISHEYE_INST</td>
</tr>
</tbody>
</table>

3. Now copy the newly extracted <Crucible home directory>/config.xml file to the root of your new Crucible instance directory.

⚠️ You should not locate your Crucible instance directory inside the <Crucible home directory> — they should be entirely separate locations. If you do put the instance directory in the <Crucible home directory> it will be overwritten, and lost, when Crucible gets upgraded. And by the way, you’ll need separate Crucible instance directories if you want to run multiple copies of Crucible.

If you have a large number of repositories, we recommend you increase the default number of files that FishEye is allowed to open. See the following knowledge base article for more info: Subversion Indexer Paused with "Too many open files" Error.

7. Start Crucible!

In a terminal, change directory to <Crucible home directory> and run this:

```
bin/start.sh
```

After a few moments, in a web browser on the same machine, go to http://localhost:8060/ (or, from another machine, type http://hostname:8060/ , where hostname is the name of the machine where you extracted Crucible).
Enter your license, then an admin password, to finish the setup.

You can postpone setting up JIRA integration until later if you wish; see Configuring JIRA integration in the Setup Wizard.

8. Connect to an external database (recommended)

If you intend to use this Crucible installation in a production environment, it is highly recommended that you use one of the supported external databases. See Migrating to an external database.

If you are evaluating Crucible, or don't wish to do this now, Crucible will happily use its embedded database, and you can easily migrate later.

9. Set up your mail server

Configure the Crucible email server so that users can get notifications from Crucible. See Configuring SMTP.

10. Add users and repositories

Now is the time to set up your users in Crucible, and to tell Crucible about any existing repositories you have. Please read Starting to use Crucible for the details.

Crucible will perform an initial index of your repositories, during which it accesses, indexes and organizes a view of your repositories (including all historical items) back to the earliest commits. If you are evaluating Crucible, we suggest that you index a single project, so you can use Crucible as soon as possible. If you choose to index your entire repository, be aware that this can take a long time (possibly days) for massive or complex repositories and can be more complex to set up (especially for Subversion). The basic process is slightly different for each SCM type.

11. Stop Crucible (optional)

In a terminal, change directory to <Crucible home directory> and run this:

```
bin/stop.sh
```

Configuring JIRA Integration in the Setup Wizard

This page describes the ‘Connect to JIRA‘ screen of the Crucible setup wizard.

You can connect your application to a JIRA server, to manage your users via JIRA and share information with JIRA. When you are installing the application, the setup wizard gives you the opportunity to configure the JIRA connection automatically. This is a quick way of setting up your JIRA integration with the most common options.

You can also configure the JIRA connections via the application administration screens. In that case, you will need to set up connections individually. There are two parts to the integration process:

- A peer-to-peer link between JIRA and the application for sharing information and facilitating integration features. This link is set up via Application Links.
- A client-server link between the application and JIRA for delegating user and group management to your JIRA server.

Requirements: You need JIRA 4.3 or later.

On this page:
- Connecting to JIRA in the Setup Wizard
- Troubleshooting
- Notes
Connecting to JIRA in the Setup Wizard

To configure JIRA integration while running the Crucible setup wizard:

1. Enter the following information on the ‘Connect to JIRA’ step of the setup wizard:
   - **JIRA Base URL** – The web address of your JIRA server. Examples:
     - http://www.example.com:8080/jira/
     - http://jira.example.com
   - **Admin Username** and **Admin Password** – The credentials of a user with the ‘JIRA System Administrators’ global permission in JIRA.
   - **FishEye/Crucible Base URL** – Click ‘Advanced Options’ to see this field. JIRA will use this URL to access your FishEye/Crucible server. The URL you give here will override the base URL specified in your FishEye/Crucible administration console, for the purposes of the JIRA connection.
   - **Groups to synchronize** – Click ‘Advanced Options’ to see this field. Select at least one JIRA group to synchronize. The default group is `jira-users`. JIRA will synchronize all changes in the `jira-users` user information on a regular basis. The default synchronization interval is 1 hour.
   - **Admin Groups** – Click ‘Advanced Options’ to see this field. Specify a JIRA group whose members should have administrative access to FishEye/Crucible. The default group is `jira-administrat ors`.

2. Click the ‘Connect to JIRA’ button.
3. Finish the setup process.
4. Configure the following setting in JIRA: Allow remote API access.

**Screenshot: Connecting to JIRA in the FishEye/Crucible setup wizard**

Troubleshooting

- Click to see troubleshooting information...
This section describes the possible problems that may occur when integrating your application with JIRA via the setup wizard, and the solutions for each problem.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
</table>
| The setup wizard displays one of the following error messages:  
  - Failed to create application link from JIRA server at `<URL>` to this `<application>` server at `<URL>`.  
  - Failed to create application link from this `<application>` server at `<URL>` to JIRA server at `<URL>`.  
  - Failed to authenticate application link from JIRA server at `<URL>` to this `<application>` server at `<URL>`.  
  - Failed to authenticate application link from `<application>` server at `<URL>` to this JIRA server at `<URL>`. | The setup wizard failed to complete registration of the peer-to-peer application link with JIRA. JIRA integration is only partially configured. | Remove the partial configuration if it exists, try the ‘Connect to JIRA’ step again, and then continue with the setup. Detailed instructions are below. |
| The setup wizard displays one of the following error messages:  
  - Failed to register `<application>` configuration in JIRA for shared user management. Received invalid response from JIRA: `<response>`.  
  - Failed to register `<application>` configuration in JIRA for shared user management. Received: `<response>`. | The setup wizard failed to complete registration of the client-server link with JIRA for user management. The peer-to-peer link was successfully created, but integration is only partially configured. | Remove the partial configuration if it exists, try the ‘Connect to JIRA’ step again, and then continue with the setup. Detailed instructions are below. |
| The setup wizard displays the following error message:  
  - Error setting Crowd authentication | The setup wizard successfully established the peer-to-peer link with JIRA, but could not persist the client-server link for user management in your `conf.xml` file. This may be caused by a problem in your environment, such as a full disk. | Please investigate and fix the problem that prevented the application from saving the configuration file to disk. Then remove the partial configuration if it exists, try the ‘Connect to JIRA’ step again, and then continue with the setup. Detailed instructions are below. |
| The setup wizard displays the following error message:  
  - Error reloading Crowd authentication | The setup wizard has completed the integration of your application with JIRA, but is unable to start synchronizing the JIRA users with your application. | Restart your application. You should then be able to continue with the setup wizard. If this solution does not work, please contact Atlassian Support. |
The setup wizard displays the following error message:

- An error occurred: java.lang.IllegalArgumentException: Could not create the application in JIRA/Crowd (code: 500). Please refer to the logs for details.

The setup wizard has not completed the integration of your application with JIRA. The links are only partially configured. The problem occurred because there is already a user management configuration in JIRA for this <application> URL.

Remove the partial configuration if it exists, try the ‘Connect to JIRA’ step again, and then continue with the setup. Detailed instructions are below.

No users can log in after you have set up the application with JIRA integration.

Possible causes:
- There are no users in the group that you specified on the 'Connect to JIRA' screen.
- For FishEye: There are no groups specified in the ‘groups to synchronize’ section of your administration console.
- For Stash: You may not have granted any JIRA groups or users permissions to log in to Stash.

Go to JIRA and add some usernames to the group.

- For FishEye: Go to the FishEye administration screens and specify at least one group to synchronize. The default is ‘jira-users’.
- For Stash: Grant the Stash User permission to the relevant JIRA groups on the Stash Global permissions page.

If this solution does not work, please contact Atlassian Support.

### Solution 1: Removing a Partial Configuration – The Easiest Way

If the application’s setup wizard fails part-way through setting up the JIRA integration, you may need to remove the partial configuration from JIRA before continuing with your application setup. Please follow the steps below.

Remove the partial configuration if it exists, try the ‘Connect to JIRA’ step again, and then continue with the setup wizard:

1. Log in to JIRA as a user with the ‘JIRA System Administrators’ global permission.
2. Click the ‘Administration’ link on the JIRA top navigation bar.
3. Remove the application link from JIRA, if it exists:
   a. Click Application Links in the JIRA administration menu. The 'Configure Application Links' page will appear, showing the application links that have been set up.
   b. Look for a link to your application. It will have a base URL of the application linked to JIRA. For example:
      - If you want to remove a link between JIRA and FishEye, look for the one where the Application URL matches the base URL of your FishEye server.
      - If you want to remove a link between JIRA and Confluence, look for the one where the Application URL matches the base URL of your Confluence server.
      - If you want to remove a link between JIRA and Stash, look for the one where the Application URL matches the base URL of your Stash server.
   c. Click Delete next to the application link that you want to delete.
   d. A confirmation screen will appear. Click Confirm to delete the application link.
4. Remove the user management configuration from JIRA, if it exists:
   a. Go to the JIRA administration screen for configuring the applications that have been set up to use JIRA for user management:
      - In JIRA 4.3: Click ‘Other Applications’ in the ‘Users, Groups & Roles’ section of the JIRA administration screen.
      - In JIRA 4.4: Select ‘Administration’ > ‘Users’ > ‘JIRA User Server’.
   b. Look for a link to your application. It will have a name matching this format:
<Type> - <HostName> - <Application ID>

For example:

FishEye / Crucible - localhost -
92004b08-5657-3048-b5dc-f886e662ba15

Or:

Confluence - localhost -
92004b08-5657-3048-b5dc-f886e662ba15

If you have multiple servers of the same type running on the same host, you will need to match the application ID of your application with the one shown in JIRA. To find the application ID:

- Go to the following URL in your browser:
  ```
  <baseUrl>/rest/applinks/1.0/manifest
  ```
  Replace `<baseUrl>` with the base URL of your application.
  For example:
  ```
  http://localhost:8060/rest/applinks/1.0/manifest
  ```
  - The application links manifest will appear. Check the application ID in the `<id>` element.

5. In JIRA, click 'Delete' next to the application that you want to remove.

Go back to the setup wizard and try the 'Connect to JIRA' step again.

**Solution 2: Removing a Partial Configuration – The Longer Way**

If solution 1 above does not work, you may need to remove the partial configuration and then add the full integration manually. Please follow these steps:

1. Skip the 'Connect to JIRA' step and continue with the setup wizard, to complete the initial configuration of the application.
2. Log in to JIRA as a user with the 'JIRA System Administrators' global permission.
3. Click the 'Administration' link on the JIRA top navigation bar.
4. Remove the application link from JIRA, if it exists:
   a. Click Application Links in the JIRA administration menu. The 'Configure Application Links' page will appear, showing the application links that have been set up.
   b. Look for a link to your application. It will have a base URL of the application linked to JIRA. For example:
      - If you want to remove a link between JIRA and FishEye, look for the one where the Application URL matches the base URL of your FishEye server.
      - If you want to remove a link between JIRA and Confluence, look for the one where the Application URL matches the base URL of your Confluence server.
      - If you want to remove a link between JIRA and Stash, look for the one where the Application URL matches the base URL of your Stash server.
   c. Click Delete next to the application link that you want to delete.
   d. A confirmation screen will appear. Click Confirm to delete the application link.
5. Remove the user management configuration from JIRA, if it exists:
   a. Go to the JIRA administration screen for configuring the applications that have been set up to use JIRA for user management:
      - In JIRA 4.3: Click 'Other Applications' in the 'Users, Groups & Roles' section of the
JIRA administration screen.

- In JIRA 4.4: Select 'Administration' > 'Users' > 'JIRA User Server'.
- Look for a link to your application. It will have a name matching this format:

  `<Type> - <HostName> - <Application ID>`

For example:

```
FishEye / Crucible - localhost -
92004b08-5657-3048-b5dc-f886e662ba15
```

Or:

```
Confluence - localhost -
92004b08-5657-3048-b5dc-f886e662ba15
```

If you have multiple servers of the same type running on the same host, you will need to match the application ID of your application with the one shown in JIRA. To find the application ID:

- Go to the following URL in your browser:

  `<baseUrl>/rest/applinks/1.0/manifest`

Replace `<baseUrl>` with the base URL of your application.

For example:

```
http://localhost:8060/rest/applinks/1.0/manifest
```

- The application links manifest will appear. Check the application ID in the `<id>` element.
- In JIRA, click 'Delete' next to the application that you want to remove.

6. Add the application link in JIRA again, so that you now have a two-way trusted link between JIRA and your application:

a. Click Add Application Link. Step 1 of the link wizard will appear.

b. Enter the server URL of the application that you want to link to (the 'remote application').

c. Click Next.

d. Enter the following information:

   - **Create a link back to this server** – Check to add a two-way link between the two applications.
   - **Username** and **Password** – Enter the credentials for a username that has administrator access to the remote application.
     *Note:* These credentials are only used to authenticate you to the remote application, so that Application Links can make the changes required for the new link. The credentials are not saved.
   - **Reciprocal Link URL** – The URL you give here will override the base URL specified in your remote application's administration console, for the purposes of the application links connection. Application Links will use this URL to access the remote application.

e. Click Next.

f. Enter the information required to configure authentication for your application link:

   - **The servers have the same set of users** – Check this box, because the users are the same in both applications.
   - **These servers fully trust each other** – Check this box, because you trust the code in both applications and are sure both applications will maintain the security of their private keys.

*For more information about configuring authentication, see Configuring authentication for an application link.*

g. Click Create.
7. Configure a new connection for user management in JIRA:
   a. Go to the JIRA administration screen for configuring the applications that have been set up to use JIRA for user management:
      - In JIRA 4.3: Click 'Other Applications' in the 'Users, Groups & Roles' section of the JIRA administration screen.
      - In JIRA 4.4: Select 'Administration' > 'Users' > 'JIRA User Server'.
   b. Add an application.
   c. Enter the application name and password that your application will use when accessing JIRA.
   d. Enter the IP address or addresses of your application. Valid values are:
      - A full IP address, e.g. 192.168.10.12.
      - A wildcard IP range, using CIDR notation, e.g. 192.168.10.1/16. For more information, see the introduction to CIDR notation on Wikipedia and RFC 4632.
   e. Save the new application.

8. Set up the JIRA user directory in the application.
   - For Confluence:
     a. Go to the Confluence Administration Console.
     b. Click 'User Directories' in the left-hand panel.
     c. Add a directory and select type 'Atlassian JIRA'.
     d. Enter the following information:
        - Name – Enter the name of your JIRA server.
        - Server URL – Enter web address of your JIRA server. Examples:
          http://www.example.com:8080/jira/
          http://jira.example.com
        - Application name and Application password – Enter the values that you defined for Confluence in the settings on JIRA.
     e. Save the directory settings.
     f. Define the directory order by clicking the blue up- and down-arrows next to each directory on the 'User Directories' screen.
        For details see Connecting to Crowd or JIRA for User Management.
   - For FishEye/Crucible:
     a. Click Authentication (under 'Security Settings').
     b. Click Setup JIRA/Crowd authentication. Note, if LDAP authentication has already been set up, you will need to remove that before connecting to JIRA for user management.
     c. Make the following settings:

<table>
<thead>
<tr>
<th>Authenticate against</th>
<th>Select a JIRA instance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application name and password</td>
<td>Enter the values that you defined for your application in the settings on JIRA.</td>
</tr>
<tr>
<td>JIRA URL</td>
<td>The web address of your JIRA server. Examples:</td>
</tr>
<tr>
<td>Auto-add</td>
<td>Select Create a FishEye user on successful login so that your JIRA users will be automatically added as a FishEye user when they first log in.</td>
</tr>
<tr>
<td>Periodically synchronise users with JIRA</td>
<td>Select Yes to ensure that JIRA will synchronize all changes in the user information on a regular basis. Change the value for Syncrhonise Period if required.</td>
</tr>
</tbody>
</table>
When Synchronisation Happens | Select an option depending on whether you want to allow changes to user attributes from within FishEye.
---|---
Single Sign On | Select Disabled. SSO is not available when using JIRA for user management and if enabled will make the integration fail.

d. Click **Next** and select at least one user group to be synchronised from JIRA. If necessary, you could create a new group in JIRA, such as 'fisheye-users', and select this group here.
e. Click **Save**.
   • For Stash:
      a. Go to the Stash administration area.
      b. Click **User Directories** in the left-hand panel.
      c. **Add** a directory and select type **Atlassian JIRA**.
      d. Enter the following information:
         - **Name** – Enter the name of your JIRA server.
         - **Server URL** – Enter web address of your JIRA server. Examples:
           ```
           http://www.example.com:8080/jira/
           http://jira.example.com
           ```
         - **Application name** and **Application password** – Enter the values that you defined for Stash in the settings on JIRA.
e. Save the directory settings.
f. Define the directory order by clicking the blue up- and down-arrows next to each directory on the 'User Directories' screen.
   For details see [Connecting Stash to JIRA for user management](#).

**Having trouble integrating your Atlassian products with application links?**
We've developed a [guide to troubleshooting application links](#), to help you out. Take a look at it if you need a hand getting around any errors or roadblocks with setting up application links.

### Notes

When you connect to JIRA in the setup wizard, the setup procedure will configure **Trusted Applications authentication** for your application. Please be aware of the following security implications:

- Trusted applications are a **potential security risk**. When you configure Trusted Applications authentication, you are allowing one application to access another as any user. This allows all of the built-in security measures to be bypassed. Do not configure a trusted application unless you know that all code in the application you are trusting will behave itself at all times, and you are sure that the application will maintain the security of its private key.

### Starting to use Crucible

This page introduces the basics of using Crucible. By the end, you'll know how to:

- **Add a repository**
- **Create a project**
- **Create and perform reviews**

For more information, see the [Crucible user's guide](#).

### Assumptions

We're assuming that:
• You have installed and started the latest version of Crucible. See the details at Installing Crucible on Windows or Installing Crucible on Linux and Mac.
• You are using a supported browser.
• You have admin permission in Crucible.

Add a repository

First up we’re going to add a repository to Crucible.

Go to the Admin area by clicking on the ‘cog’ at the top right and choosing Administration:

Click Add repository in the Repositories listing of the Administration area:

Choose the repository type and fill in the name and description.

In the repository configuration put the location of your repository. Fill in the authentication details if necessary.

Finally, indicate whether or not you would like diff indexing turned on and if the repository should be indexed right away, then click Add to finish the process.
Your repository is now created in **Crucible** and the indexing should have started.

### Repositories

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
<th>Location</th>
<th>State</th>
<th>Last Update</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>jplot</td>
<td>Mercurial</td>
<td>JS charts library</td>
<td><a href="https://bitbucket.org/cheonello/jplot/">https://bitbucket.org/cheonello/jplot/</a></td>
<td>Running</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Create a project in Crucible**

Crucible comes with a default project, with the key CR, but you will probably want to create your own projects to contain your reviews. This is achieved in a couple of steps.

Click **Add a new project** in the **Projects** listing of the Administration area.
Fill in the form with the default settings for the project and hit **Save**.

You'll see your new project in the **Projects** listing.

**Create a review**

Now that you have your own project you can create reviews in it.

Of course, you'll need to be logged in to create a review.

From the header, click **Create review** to open the review creation form:
Choose the project in which you want to create the review:

In the next screen, click Browse changesets to see the list of changesets available for the review.

Select the changesets that you want to be reviewed, then click Edit Details:
Now add reviewers and update the review information, then click **Start Review**:

The review is now created and the reviewers will have been notified that a review is pending.
In order to close a review, when you are the moderator, you need to click on **Summarize** at the top right and then close the review from the dialog:

**Summarize Review**

**Summarize the review outcomes (optional)**

There's a bug with FF1 but an issue has been created for it.

**Installing and upgrading Git**

This page describes how to install or upgrade Git on the Crucible server:

- Check your version of Git
- Install or upgrade Git on Linux
- Install or upgrade Git on Mac OS X
- Install or upgrade Git on Windows
• Restart Crucible

Check your version of Git

The versions of Git supported by Crucible are listed on Supported platforms.

You can check your current version of Git by running the `git --version` command in a terminal (Linux, Mac OS X) or command prompt (Windows).

For example:

```
$ git --version
git version 1.7.7.3
```

If you don’t see a supported version of Git, you’ll need to either upgrade Git or perform a fresh install, as described below.

Install or upgrade Git on Linux

Use your package manager to install Git. For example, on Ubuntu 13.10, use:

```
sudo apt-get install git
```

If you are using a different Linux distribution, you may need to use a different package repository to get the latest stable version of Git.

Now check the Git version – you should see the new version of Git.

If you still can’t see the Git version, you may need to add the Git install location to your path. Open your `~/.profile` file in a text editor and add this line, where `<path/to/git>` is the install location for Git:

```
export PATH=$PATH:<path/to/git>
```

You can use the `which git` command to find the install location for Git.

Install or upgrade Git on Mac OS X

This section describes how to install the latest stable Git release on your Mac. It does not describe how to update the version of Git that is bundled with Apple’s Xcode.

Download the latest stable Git release from the Git website. Click on the downloaded .dmg file, then double-click the .pkg icon to run the installer. This will install the new version of Git over the existing version:
Now check the Git version – you should see the new version of Git.

If you still can't see the Git version, you may need to add the Git install location to your path. Open your ~/.profile file in a text editor and add this line, where <path/to/git> is the install location for Git:

```
export PATH=$PATH:<path/to/git>
```

You can use the `which git` command to find the install location for Git.

### Install or upgrade Git on Windows

Download the [Full installer for official Git for Windows](https://git-scm.com/download/win). Installing Git for Windows (previously known as msysGit) also installs a supported version of Perl.

⚠️ Git for Windows is the only supported distribution when running Crucible on Windows. Cygwin Git is not supported and has known issues.

Run the Git installer, ensuring that you install into the same location as any existing Git installation. You can use `where git` to locate existing installations.

Ensure that `git.exe` is available in the path:

- Choose either Option 2, Run Git from the Windows Command Prompt, or Option 3, Run Git and included Unix tools from the Windows Command Prompt. Both these options will work with Crucible.
- Do not select Option 1, Use Git Bash only, when installing or upgrading Git for the Crucible server – this will not work with Crucible.
Now, check the Git version – you should see the new version of Git.

Restart Crucible

You'll need to stop and restart Crucible so that it will pick up the upgraded version of Git.

On Windows:

Control the Crucible service from the Windows administration console. Alternatively, in a command prompt, change directory to `<Crucible home directory>` and run:

```
bin\start.bat
```

On Linux and Mac OS X:

In a terminal, change directory to `<Crucible home directory>` and run:

```
bin\start.sh
```

Using Crucible

Atlassian Crucible is the on-premises code review solution for enterprise teams. It allows your development teams to catch major defects, improve code architecture, and discuss desired improvements, without the need for meetings.

This page provides an overview of how to use Crucible.

1. Point Crucible to your repositories

Crucible is all about code reviews. It's no surprise then that Crucible needs access to your source code.

A Crucible administrator can connect a repository managed by any of these tools:

- Bitbucket Server
2. Set up a Crucible project

A Crucible project allows you to

- define default moderators, authors and reviewers for the reviews in that project.
- define which people are eligible to be reviewers for the reviews in that project.
- use permission schemes to restrict who can perform particular actions (e.g. 'Create Review') in that project.

A Crucible administrator can create new projects – see Creating a project.

3. Review something!

When you create a review you'll want to:

- Add the files, changesets or other content that you want to be reviewed.
- Choose the people who you want to be reviewers.

We've found that reviews should be created with care to get the best value from them:

- Avoid overloading the review. Reviews should be focused on just a few necessary files.
- Avoid overcrowding the review. Reviewers should be selected with care, and should be guided individually on what to look for.

See Creating a review for more information.

Using the Crucible screens

This page gives an overview of the Crucible interface and the actions that can be carried out.

On this page:

- Dashboard
- Header
- Recent activity
- Related pages

Dashboard

The dashboard is the first screen you see when you log into FishEye/Crucible. The dashboard displays reviews and system activity related to you, and provides filtering for your recent repositories and projects. The dashboard can be accessed from anywhere in the application by clicking the FishEye/Crucible icon in the header.

Click View review dashboard to see more information about your reviews.

Screenshot: The Crucible dashboard (with FishEye), showing current reviews and recent activity
The table below explains the tabs in the Crucible header:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Function</th>
<th>Appears</th>
</tr>
</thead>
<tbody>
<tr>
<td>Repositories</td>
<td>Displays contents of connected source repositories.</td>
<td>Only when FishEye is used with Crucible.</td>
</tr>
<tr>
<td></td>
<td>The dropdown menu has links to recently visited repositories.</td>
<td>Only when FishEye is used with Crucible for logged-in users.</td>
</tr>
<tr>
<td>Projects</td>
<td>Displays reviews and content from specific projects.</td>
<td>All screens</td>
</tr>
<tr>
<td></td>
<td>The dropdown menu has links to recently visited projects.</td>
<td>All screens for logged-in users.</td>
</tr>
<tr>
<td>People</td>
<td>Displays metrics on the users of the Crucible instance.</td>
<td>All screens</td>
</tr>
<tr>
<td></td>
<td>The dropdown menu has links to recently visited user pages.</td>
<td>All screens for logged-in users.</td>
</tr>
<tr>
<td>Reviews</td>
<td>Allows you to search and report on reviews.</td>
<td>All screens</td>
</tr>
<tr>
<td></td>
<td>The dropdown menu has links to recently visited reviews, as well as links to the Crucible Inbox and Outbox.</td>
<td>All screens for logged-in users.</td>
</tr>
</tbody>
</table>

Choose Reviews > Review dashboard to see the Review Dashboard that has more information about your reviews.
Recent activity

The dashboard has an activity stream that displays recent commit activity and reviews activity. The activity stream will display your own activity as well as information from projects, reviews, people, repositories, etc, that you have selected as favorites. For more information on favorites, see Using favourites.

Browsing commit activity

Commit activity includes files commits to repositories that you have selected as favorites. Click the Commits tab to filter the activity stream to display only source activity.

Browsing reviews activity

Reviews activity includes updates to reviews in all projects that you have selected as favorites. See Browsing all reviews for more information about browsing reviews. Click the Reviews tab to filter the activity stream to display only reviews activity (see screenshot below).

Related pages

Browsing source files  
Browsing projects  
Viewing People's Statistics in Crucible  
Viewing reports  
Searching Crucible  
Using RSS feeds in Crucible  
Changing your User Profile

Browsing all reviews

To browse reviews in Crucible, choose Reviews > Review dashboard.

The dashboard displays reviews according to the filters you click in the sidebar:

- Your reviews
- Other reviews
- Custom filter
- Reports
- Related topics

Your reviews

By default, the dashboard shows the reviews you are involved in.

- Browse your reviews by clicking the links under 'My Reviews' and 'My Snippets' in the sidebar.

<table>
<thead>
<tr>
<th>Inbox</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>To Review</strong></td>
</tr>
<tr>
<td><strong>Ready to Close</strong></td>
</tr>
<tr>
<td><strong>In Draft</strong></td>
</tr>
<tr>
<td><strong>Require My Approval</strong></td>
</tr>
</tbody>
</table>

Outbox
### Out for Review
Reviews that you are a participant of, that have review work that is yet to be completed by other reviewers.

### Completed
Reviews that you are a participant of, and have been completed.

### Archive

<table>
<thead>
<tr>
<th>Reviews that you are a participant of, that have been summarized and closed.</th>
</tr>
</thead>
</table>

### Closed
Reviews that you are a participant of, that have been summarized and closed.

### Abandoned
Reviews that you are a participant of, that have been abandoned. You may wish to delete these reviews.

### My Open Snippets
All open snippets created by you.

### My Snippets
All snippets created by you.

### Screenshot: Browsing your reviews

#### Review Dashboard

<table>
<thead>
<tr>
<th>State</th>
<th>Review</th>
<th>Owner</th>
<th>Name</th>
<th>Files</th>
<th>Comments</th>
<th>Age</th>
<th>Due</th>
<th>Reviewers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Review</td>
<td>TEST-313</td>
<td></td>
<td></td>
<td>1</td>
<td>3</td>
<td>9 months</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Draft</td>
<td>TEST-323</td>
<td>Donish</td>
<td></td>
<td>3</td>
<td>0</td>
<td>6 months and 14 days</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Draft</td>
<td>TEST-309</td>
<td></td>
<td></td>
<td>0</td>
<td>0</td>
<td>5 months</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Draft</td>
<td>TEST-399</td>
<td></td>
<td></td>
<td>0</td>
<td>0</td>
<td>3 months and 4 days</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Draft</td>
<td>CR-PE-7366</td>
<td>CPFUC-2747; update wording</td>
<td></td>
<td>5</td>
<td>0</td>
<td>2 months and 28 days</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Other reviews

- **Browse reviews for all people by clicking the links under 'Everyone's Reviews' and 'Everyone's Snippets' in the sidebar:**

#### All Open Reviews
Reviews that have not been summarized and closed yet.

#### All Closed Reviews
Reviews that have been summarized and closed.

#### All Reviews
All reviews, including open reviews, closed reviews and draft reviews.

#### All Open Snippets
All open snippets.

#### All Snippets
All snippets, i.e. open and closed snippets.

### Screenshot: Browsing all open reviews
Custom filter

You can filter reviews by author or by projects that you have selected as favorites.

Reports

Click Reports at the top of the screen to generate reports on review blockers for all people. You can also filter reviews by status, e.g. 'Open', 'Closed'.

Related topics

Viewing reports

Browsing source files

When FishEye is installed with Crucible, the Repositories tab is available in the header.

To browse source files:

1. Choose Repositories > All repositories from the header. The 'Repositories' view will be displayed, showing summary information if you have multiple repositories set up. See the 'Viewing all repositories' screenshot below.
2. Click the name for a repository to view its contents. See the 'Viewing a repository' screenshot below.
3. Browse the repository for the desired source file using the directory tree in the left menu. See the 'Viewing a file' screenshot below.
4. You can view various information about the file:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Activity
Shows recent activity for the item. There are a number of sub-options here:
- **All** — The default view, showing commits, reviews and JIRA issues.
- **Commits** — Shows commits in the activity stream.
- **Reviews** — Shows review activity in the activity stream.
- **Filter commits** — Applies constraints to the current activity stream.
- **Expand all** — Shows more detail for all changesets.
- **Scroll to changeset** — Displays the changeset ID specified

### Revisions
When viewing a file, shows the latest revisions of the file.

### Users
Shows the commit history of the different users that have committed changes on the item.

### Reports
Shows activity charts for the item. Various chart options can be selected in the left navigation bar.

### Source
Shows the contents of the file.

ℹ️ To download files, click the **Source** tab for the desired file, then right-click **Raw**.

**Screenshot: Viewing all repositories**

**Screenshot: Viewing a repository**

**Screenshot: Viewing a file**
Browsing projects
To browse the content in a project, click Projects at the top of the page and choose a recent project, or choose All projects and click on a project name in the table.

The page for the project has the following sections:

Left navigation panel
Displays an overview of the project's history, statistics and activity.

Activity tab
Lists recent commit and review activity on separate sub-tabs, and all these together on the All sub-tab.
Click Expand all to see more detail for every commit or review.

Reviews tab
Lists all the reviews for the project.

The Projects tab is only visible in Crucible. Read more about the definition of a project.

Screenshot: The Crucible Project View
Changing your User Profile

See Changing your User Profile in the FishEye documentation.

Using favourites

This page describes how to use 'favorites' in Crucible.

You can add code reviews, people and repositories to your favorites. This allows you to customize the information that you see in your activity stream. Try favoriting items that you are currently working on, to get greater relevance and context in your activity stream.

You can view all your favorites at once in your profile – choose Favorites from your User menu (the one with your avatar).

On this page:

- Adding favorites
- Managing favorites

Adding favorites

To add an item to your favorites, follow one of these options:

<table>
<thead>
<tr>
<th>Item</th>
<th>Favorite it by...</th>
<th>Looks like this...</th>
</tr>
</thead>
</table>

Created by Atlassian in 2016. Licensed under a Creative Commons Attribution 2.5 Australia License.
<table>
<thead>
<tr>
<th>Feature</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Review</td>
<td>Hover over the review name, for example in the 'Open Reviews' list of the Reviews Dashboard. In the popup, click the cog icon and choose <strong>Add to Favorites</strong>.</td>
</tr>
<tr>
<td>Review comment thread</td>
<td>Click the grey star in the first comment of the comment thread.</td>
</tr>
<tr>
<td>Project</td>
<td>Click the grey star beside the project's name in the 'All Projects' list. See <strong>Browsing projects</strong>.</td>
</tr>
<tr>
<td>Person</td>
<td>Hover over a person's username and click <strong>Follow</strong>.</td>
</tr>
<tr>
<td>Repository</td>
<td>(Requires FishEye) &lt;br&gt; In the 'Repositories' list, click the grey star beside the repository's name. See <strong>Browsing source files</strong>.</td>
</tr>
</tbody>
</table>
Managing favorites

You can manage your favorites from your profile in Crucible — choose Favorites from your User menu (the one with your avatar):

![Profile settings](image)

Click the star beside a favorite to change its label or to delete it:

![Update favourite](image)

Using Wiki Markup in Crucible

Crucible supports Wiki Markup text formatting in comments and review descriptions.

The text markup notation on this page is a reference showing the available formatting commands.

ℹ️ When using FishEye, you can also render Wiki Markup in commit messages.

**Headings**

<table>
<thead>
<tr>
<th>Notation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>h1</td>
<td>Turns text into a heading at size 1.</td>
</tr>
<tr>
<td><strong>Biggest Text</strong></td>
<td></td>
</tr>
</tbody>
</table>
Text Effects

Text effects are used to change the formatting of words and sentences.

<table>
<thead>
<tr>
<th>Notation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>bold</em></td>
<td>Makes text appear <strong>bold</strong>.</td>
</tr>
<tr>
<td><em>italic</em></td>
<td>Makes text appear in <em>italics</em>.</td>
</tr>
<tr>
<td>+underline+</td>
<td>Makes text appear underlined.</td>
</tr>
<tr>
<td>??citation??</td>
<td>Makes text appear in —citation form.</td>
</tr>
<tr>
<td>-strikethrough-</td>
<td>Makes text appear struck through.</td>
</tr>
<tr>
<td>^superscript^</td>
<td>Makes text appear in superscript.</td>
</tr>
<tr>
<td><del>subscript</del></td>
<td>Makes text appear in subscript.</td>
</tr>
</tbody>
</table>

{{{monospaced}}} | Placing double curly-brackets around text makes it appear monospaced. |

**bq. Block Quote** | To make an entire paragraph into a block quotation, place "bq. " before it.  
Example:  
| Some block quoted text |
Text Breaks

Wiki Markup allows you to insert breaks or different kinds of hyphens and dashes.

<table>
<thead>
<tr>
<th>Notation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(empty line)</td>
<td>Produces a new paragraph</td>
</tr>
<tr>
<td>\</td>
<td>Creates a line break.</td>
</tr>
<tr>
<td>---</td>
<td>Creates a horizontal ruler.</td>
</tr>
<tr>
<td>---</td>
<td>Produces em dash — symbol.</td>
</tr>
<tr>
<td>--</td>
<td>Produces en dash – symbol.</td>
</tr>
</tbody>
</table>

Links

Creating links is easy with Wiki Markup.

<table>
<thead>
<tr>
<th>Notation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Crucible Review CR-FE-100]</td>
<td>Creates a link to a Crucible review or FishEye artifact using the internal key reference for the item.</td>
</tr>
<tr>
<td>[Atlassian Crucible][<a href="http://atlassian.com">http://atlassian.com</a>]</td>
<td>Creates a link to an external resource, special characters that come after the URL and are not part of it must be separated with a space. External links are denoted with an arrow icon. Examples:</td>
</tr>
<tr>
<td></td>
<td>• <a href="http://www.atlassian.com/crucible">http://www.atlassian.com/crucible</a></td>
</tr>
<tr>
<td></td>
<td>• <a href="http://www.atlassian.com/crucible">Atlassian Crucible</a> Note: The square brackets [, ], around external links are optional in the case you do not want to use any alternate text for the link (i.e. just display the raw URL).</td>
</tr>
</tbody>
</table>
[mailto:mail@example.com] Creates a link to an email address.  
Example: mail@example.com

[file:///c:/temp/foo.txt] [file:///z:/file/on/network/share.txt] Creates a download link to a file on your computer or on a network share that you have mapped to a drive. To access the file, you must right click on the link and choose "Save Target As".

{anchor:anchornname} Creates a bookmark anchor inside the page. You can then create links directly to that anchor. So a link like this: [My Page#here] will link to wherever in "My Page" there is an {anchor:here} macro, and the link [#there] will link to wherever in the current page there is an {anchor:there} macro.

Lists
Lists allow you to present information as a series of ordered items. Use asterisks * for bulleted lists and hash symbols # for numbered lists.

<table>
<thead>
<tr>
<th>Notation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>* A bulleted list</td>
<td>Examples:</td>
</tr>
<tr>
<td>* Second item</td>
<td>• A bulleted list</td>
</tr>
<tr>
<td>** indented item 1</td>
<td>• Second item</td>
</tr>
<tr>
<td>** indented item 2</td>
<td>• indented item 1</td>
</tr>
<tr>
<td># A numbered list</td>
<td>1. A numbered list</td>
</tr>
<tr>
<td># Second item</td>
<td>2. Second item</td>
</tr>
<tr>
<td>## indented item 1</td>
<td>a. indented item 1</td>
</tr>
<tr>
<td>## indented item 2</td>
<td>b. indented item 2</td>
</tr>
</tbody>
</table>

Images
Images can be referenced from remote sources only.

<table>
<thead>
<tr>
<th>Notation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![<a href="http://www.host.com/image.gif">http://www.host.com/image.gif</a>!</td>
<td>The image will be displayed from the remote source.</td>
</tr>
<tr>
<td>![<a href="http://www.host.com/image.gif">http://www.host.com/image.gif</a></td>
<td>align=right, vspace=4!</td>
</tr>
</tbody>
</table>

Tables
Tables allow you to organize content in a rows and columns, with a header row if required.

<table>
<thead>
<tr>
<th>Notation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The code above produces a table that looks like this:

<table>
<thead>
<tr>
<th>heading 1</th>
<th>heading 2</th>
<th>heading 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>col A1</td>
<td>col A2</td>
<td>col A3</td>
</tr>
<tr>
<td>col B1</td>
<td>col B2</td>
<td>col B3</td>
</tr>
</tbody>
</table>
### Advanced Formatting

This section covers panels, code windows and showing plain text with no formatting.

<table>
<thead>
<tr>
<th>Notation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>{noformat}</code></td>
<td>Makes a preformatted block of text with no syntax highlighting. All the optional parameters of the <code>{noformat}</code> macro are valid for the <code>{panel}</code> macro as well. Example:</td>
</tr>
<tr>
<td></td>
<td><strong>This is a no-formatted piece of text, so <em>no</em> <em>formatting</em> is done here.</strong></td>
</tr>
<tr>
<td><code>{panel}</code></td>
<td>Embraces a block of text within a fully customizable panel. The optional parameters you can define are as follows.</td>
</tr>
</tbody>
</table>
| | • title: Title of the panel  
| | • borderStyle: The style of the border this panel uses (solid, dashed and other valid CSS border styles)  
| | • borderColor: The color of the border this panel uses  
| | • borderWidth: The width of the border this panel uses  
| | • bgColor: The background color of this panel  
| | • titleBGColor: The background color of the title section of this panel  
| | Examples: |
| | **Some text in a basic panel** |
| | **My Title** |
| | **Some text with a title** |
The code macro displays a preformatted block for showing code with syntax highlighting. All the optional parameters of the {panel} macro are valid for {code}. The default language is Java but you can specify JavaScript, ActionScript, XML or SQL.

Examples:

**Java with a title bar:**

```java
public String getFoo()
{
    return foo;
}
```

**A basic display with XML code:**

```xml
<test>
    <another tag="attribute"/>
</test>
```

### Miscellaneous Markup Features

Emoticons and often-used images can be easily embedded with the following Wiki Markup Syntax:

<table>
<thead>
<tr>
<th>Notation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\X</td>
<td>Escape special character X (i.e. {)</td>
</tr>
<tr>
<td>:), :{</td>
<td>Graphical emoticons (smileys): 😊, 😞 😢</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Notation</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>:)</td>
<td>😊</td>
</tr>
<tr>
<td>:P</td>
<td>😊</td>
</tr>
<tr>
<td>:D</td>
<td>😃</td>
</tr>
<tr>
<td>:)</td>
<td>😊</td>
</tr>
<tr>
<td>(y)</td>
<td>😊</td>
</tr>
<tr>
<td>(n)</td>
<td>😞</td>
</tr>
<tr>
<td>(i)</td>
<td>😢</td>
</tr>
<tr>
<td>()</td>
<td>😢</td>
</tr>
<tr>
<td>(x)</td>
<td>😢</td>
</tr>
<tr>
<td>(l)</td>
<td>😢</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Notation</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>(+)</td>
<td>🔴</td>
</tr>
<tr>
<td>(-)</td>
<td>🔴</td>
</tr>
<tr>
<td>(?)</td>
<td>🔴</td>
</tr>
<tr>
<td>(on)</td>
<td>🔴</td>
</tr>
<tr>
<td>(off)</td>
<td>🔴</td>
</tr>
<tr>
<td>(*)</td>
<td>🔴</td>
</tr>
<tr>
<td>(*r)</td>
<td>🔴</td>
</tr>
<tr>
<td>(*g)</td>
<td>🔴</td>
</tr>
<tr>
<td>(*b)</td>
<td>🔴</td>
</tr>
<tr>
<td>(*y)</td>
<td>🔴</td>
</tr>
</tbody>
</table>

### Using RSS feeds in Crucible

#### Subscribing to an RSS feed

In Crucible, all pages with an activity stream, and any page that has a list of reviews, will have an RSS option. Right-click the RSS icon and choose **Copy Link Address** to get the URL that you can paste into your RSS reader of choice.

Click the RSS icon to see a page with the RSS feed displayed.

#### Using keyboard shortcuts in Crucible

To see the available shortcuts, navigate to a review in Crucible, then choose **Tools > Keyboard Shortcuts**.

---

*Created by Atlassian in 2016. Licensed under a Creative Commons Attribution 2.5 Australia License.*
### General shortcuts

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>?</td>
<td>Opens reference list of keyboard shortcuts</td>
</tr>
<tr>
<td>escape</td>
<td>Closes reference list of keyboard shortcuts</td>
</tr>
<tr>
<td>alt</td>
<td>Hold down then click and drag to select source line contents</td>
</tr>
<tr>
<td>shift + f</td>
<td>Toggle full screen review mode</td>
</tr>
</tbody>
</table>

### Custom navigation

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>,</td>
<td>(Comma) Go to the previous element (file, comment, defect or diff hunk depending on your current context)</td>
</tr>
<tr>
<td>.</td>
<td>(Period) Go to the next element (file, comment, defect or diff hunk depending on your current context)</td>
</tr>
</tbody>
</table>

### Comment navigation

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>n</td>
<td>Go to next review comment</td>
</tr>
<tr>
<td>p</td>
<td>Go to previous review comment</td>
</tr>
<tr>
<td>shift + p</td>
<td>Go to first review comment</td>
</tr>
<tr>
<td>shift + n</td>
<td>Go to last review comment</td>
</tr>
<tr>
<td>l</td>
<td>Go to next thread (skips replies)</td>
</tr>
<tr>
<td>h</td>
<td>Go to previous thread (skips replies)</td>
</tr>
<tr>
<td>]</td>
<td>Go to next unread comment</td>
</tr>
<tr>
<td>[</td>
<td>Go to previous unread comment</td>
</tr>
<tr>
<td>r</td>
<td>Reply to a comment</td>
</tr>
<tr>
<td>m</td>
<td>Toggle comment read/unread status</td>
</tr>
</tbody>
</table>

### File navigation

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>j</td>
<td>Go to the next element (file, comment, defect or diff hunk depending on your current context)</td>
</tr>
<tr>
<td>k</td>
<td>Go to the previous element (file, comment, defect or diff hunk depending on your current context)</td>
</tr>
<tr>
<td>shift + k</td>
<td>Go to first file</td>
</tr>
<tr>
<td>shift + j</td>
<td>Go to last file</td>
</tr>
<tr>
<td>u</td>
<td>Go to next unreviewed file</td>
</tr>
<tr>
<td>i</td>
<td>Go to previous unreviewed file</td>
</tr>
<tr>
<td>Key</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>y</td>
<td>Set file reviewed and go to next unreviewed file</td>
</tr>
<tr>
<td>shift + y</td>
<td>Toggle file reviewed/unreviewed status</td>
</tr>
<tr>
<td>e</td>
<td>Expand current file</td>
</tr>
<tr>
<td>c</td>
<td>Collapse current file</td>
</tr>
<tr>
<td>shift + e</td>
<td>Expand all files</td>
</tr>
<tr>
<td>shift + c</td>
<td>Collapse all files</td>
</tr>
</tbody>
</table>

**Crucible icons**

This page contains a list of Crucible icons and an explanation what each one represents in the user interface.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="View review-level comments icon" /></td>
<td>View review-level comments</td>
</tr>
<tr>
<td><img src="image2" alt="Go to the previous comment icon" /></td>
<td>Go to the previous comment</td>
</tr>
</tbody>
</table>
The Crucible workflow

This page provides an overview of Crucible workflows, followed by a simple example showing a code review between two people.

On this page:

**Crucible Workflow**

*Example workflow: Two participant code review*

1. The code author starts the review
2. The reviewer comments on the code
3. The author responds to the comments
4. The author closes the review

**Roles**

Crucible is a flexible application that caters for a wide range of team sizes and work styles. You will need to know about the basic roles used in Crucible:
• authors: Usually the creator of the code; the person who will act on the review’s outcome.
• reviewer: A participant that will comment on the source files in the review, raising points and discussion on the work that was done.
• moderator: Usually the person who starts the review and is responsible for deciding the outcomes and closing it. The moderator is disabled for the “agile” permission scheme to simplify workflow.

Crucible Workflow

There are a number of different ways in which you can use Crucible for code reviews. The following diagram shows the basic workflow that applies to most Crucible code reviews.

Diagram: Workflow for One-to-One Reviews

Need more information? Read more about the different forms of workflow in Crucible.

Next, we explore an example workflow for a two-person code review in Crucible.

Example workflow: Two participant code review

This section describes a one-to-one review involving two people. In this example, the code author wears “two hats”, acting as review creator, and code author, managing the review process as well as taking final responsibility for closing the review. The second person is the reviewer.

1. The code author starts the review

To begin, the code author sets up the review. There are a number of ways to do this, but for this example, you start from the FishEye source view of the file you want to review:

In the source view, choose Reviews > Create Review.

If there are multiple projects, the Select Project dialog opens:
Choose a project for this review from the drop-down list, then click Create Review.

The Edit Review Details dialog opens, you can create and issue the review:

In the Edit Review dialog, enter information needed for the review. This includes a title and description for the review, selecting reviewers, a due date and any related JIRA issues. The project and author are pre-selected.

You can also add more content to the review, by clicking Add Content. See Adding content to the review.

When ready, click Done. The review will now be created as a draft:
The draft review opens. In the draft stage, you can check the contents of the review files and add notes for reviewers as comments. During the draft phase, no notification emails are sent out to reviewers. Once finished with the draft phase, click **Start Review**.

The review will now be started and a notification email will go out to all participants. This lets them know that the review is under way and prompts them to take action, providing a URL for direct access to the review.

2. The reviewer comments on the code

The reviewer will receive an email from Crucible with a link that they can follow to the review:

![Review screen](image)

The Review screen displays the source files that are under review. The reviewer clicks file names to see the code to be reviewed. As the reviewer reads the changes, they can **add comments**:

- Click **Add a general comment** (under ‘General Comments’ on the Review screen) to comment on the overall review.
- Click **Add a file comment** (just above the source code listing) to add a general comment about a source code file.
- Click on any line in the source file to enter a comment there (multiple lines can be selected by clicking and dragging).

The reviewer clicks **Post** to add the comment to the review. The reviewer repeats this process for all files in the review. Reviewers can leave the session and resume it later; their work is automatically saved.

When the reviewer has finished their code review work, they click **Complete**.

By default, an email is sent to participants every time a comment is posted. This is an individual setting.
3. The author responds to the comments

During the review process, the author can also make contributions, responding to reviewer comments and making corrections:

4. The author closes the review

When all reviewers have "Completed" their reviews, the author is notified via email. The author clicks the link in the notification email, returning to the Review screen.

The author can then add any final comments, and click **Close** when finished.

This closes the review, signaling the end of work. A final email notification will be sent to the review participants, informing them that the review is now closed. The closed review screen will load, archiving the completed review as read-only.

If the author ever needs to resume work on the closed review, they can simply click **Reopen** when viewing this screen. This returns the status of the review to "Open", without changing the status of existing reviewers. Click **Edit Details** to add reviewers or to change other details of the review.

**Defining your workflow**
This page provides brief outlines of three different ways that a development team could use Crucible for code reviews:

- **Lightweight code commenting with Crucible (individual)**
- **One-to-many reviews without a moderator (Agile team)**
- **Formal group reviews (CMM team)**

For a detailed example of how to perform Crucible reviews with two participants, see *The Crucible workflow.*

**Lightweight code commenting with Crucible (individual)**

1. Author commits new work.
2. Author creates the review, and adds comments using the easy web interface.
3. Author summarizes and closes the review, saving the code comments in Crucible (and not in the code repository).

**One-to-many reviews without a moderator (Agile team)**

1. Author creates the review.
2. Author invites reviewers to take part in the review.
3. Reviewers make comments on the code.
4. Author responds to reviewer comments, making follow-up comments as necessary.
5. Reviewers complete their reviews.
6. Author summarizes and closes the review.

**Formal group reviews (CMM team)**

1. Author creates the review.
2. Moderator invites reviewers to take part in the review.
3. Reviewers make comments on the code.
4. Author responds to reviewer comments.
5. Follow-up comments are made if necessary.
6. Each discussion point is settled by the Moderator.
7. Moderator summarizes and closes the review.
Roles and status classifications

This page explains the roles and status classifications in Crucible.

- **Roles**
  - Author
  - Creator/Moderator
  - Reviewer
  - User
- **Status classifications**
  - Draft
  - Under Review
  - Summarized
  - Closed
  - Abandoned

**Roles**

**Author**

The *author* is the person primarily responsible for acting on the outcomes of the review. In the vast majority of cases the author will be the person who made the code change under review.

**Creator/Moderator**

The *creator* is the person who *creates the review*. In most cases this person will also act as *moderator*. The *moderator* is the person responsible for *creating* the review, *approving* the review, determining when reviewing is finished, *summarizing* the outcomes and *closing* the review. By default, the moderator is the *creator*. See also *author*, the person whose changes to the code are to be reviewed.

**Reviewer**

A *reviewer* is a person assigned to *review the change*. Reviewers can make *comments* and indicate when they have *completed their review*. The *moderator* and *author* are implicitly considered to be participants of the review, but are not reviewers.

**User**

A *user* is a person using Crucible.

**Status classifications**

**Draft**

Draft Reviews are not yet completed or released to the reviewers.

**Under Review**

Reviews Under Review are either waiting for attention by reviewers or waiting to be summarized.

**Summarized**
Summarized reviews are past the reviewing phase. The moderator can still add conclusions or comments.

**Closed**

Closed reviews are complete.

**Abandoned**

Abandoned reviews are 'in the trash'. Reviews must be Abandoned before they can be deleted.

See also the *Glossary of terms* used in Crucible.

**Creating a review**

This page provides an overview of the steps to create a review in Crucible:

1. Create a review
2. Add content to the review
3. Choose the reviewers
4. Complete other details for the review
5. Start the review

See the *considerations* for when creating reviews at the end of this page.

Note that only people with the 'Create' permission can create a review.

You can also create reviews by:

- Creating a review from JIRA
- Creating a review from a URL
- Creating a Snippet Review
- Creating reviews from the command line

### Create a review

Begin by clicking **Create review** in the header and picking the project for the review (if you have multiple projects):

![Create Review](image)

Click **Create Review**.

### Add content to the review

Click one of the content types to browse or search for files, branches and changesets you want to be reviewed:
Reviews should be created with care to get the best value from them. We've found it's best not to overload the review – they should be focused on just a few necessary files.

See Adding content to the review for more details.

Click Edit Details to choose the reviewers and set other details for the review.

**Choose the reviewers**

You can choose individuals and groups, or allow anyone to join the review:

We've found it's best not to overcrowd the review – reviewers should be selected with care, and should be guided individually on what to look for.

See Choosing reviewers and Enabling the moderator role for more details.

**Complete other details for the review**

You can set other details for the review, including:

- the title and description
- objectives – used to guide the reviewers on what to look for. See Setting default review objectives.
- a due date
- a reminder date
- linked reviews (if any)
• related JIRA issues (if any).

The project, moderator and author are pre-selected.

![Edit Review Details CR-ANERDS-91](image)

If you're ready, click **Start Review** to make the review available to your reviewers.

If you're not ready to start the review, click **Done**. You can come back and work on the draft review some more, later.

**Start a draft review**

The review will be displayed in draft mode. Here, you can check and edit the details as required.

Click **Start Review** to make the review available. See **Performing the review**.

![Angry Nerd Reviews CR-ANERDS-91](image)

When all the reviewers have performed their reviews, you can summarize and close the review.

**Considerations when creating reviews**

**Review effectiveness**

Based on our own experience of over 13000 reviews, we have found that reviews with fewer files and reviewers are more effective. We have seen effects such as:

- Time spent reviewing each file decreases as the number of files increases.
- Reviewers spend less time reviewing as the number of reviewers increases.
- Reviewers find fewer defects as the number of reviewers increases.

We recommend that reviews be created with care to get the best value from them:

- Avoid overloading the review. Reviews should be focused on just a few necessary files.
- Avoid overcrowding the review. Reviewers should be selected with care, and should be guided individually on what to look for.
Crucible performance

The performance of a Crucible instance can be seriously degraded if very large reviews are created. To prevent a user from accidentally causing this, Crucible has a limit on the review content size when creating reviews. The limit is 800 file revisions.

Each version of a file in a review counts as one revision – so when a review is created for a single modified file, that is two revisions. Each subsequent change to the file you add to the review is one more revision. A 'whole file' in a review is only one revision.

If you really need to create a larger review, you can get your system administrator to set the `crucible.review.content.size.limit` property as described on the JVM system properties page, but remember that performance will be poor when creating and viewing very large reviews.

Adding an entire directory's contents to a Crucible review

To add an entire directory's contents to a Crucible review, you will need to search to find all the files, for example using "select revisions from dir /some/dir where is head and not is deleted", or similar logic.

ℹ️ It is currently not possible in Crucible to add all the contents of a directory to a review with one click.

Creating a review from JIRA

This page describes how to create a Crucible review directly from an issue in JIRA, the Atlassian issue-tracking application.

🤔 JIRA must be integrated with Crucible before you can do this. See Linking Crucible to JIRA for information on how to set up an application link with JIRA.

See also Creating JIRA issues from the review.

When using Crucible with JIRA 6.2.x and later

If your instance of Crucible (version 3.3 or later) is linked to JIRA 6.2 (or later), then you can start creating a review from a JIRA issue.

**To create a review from a JIRA issue:**

1. Go to the JIRA issue that relates to the work to be reviewed.
2. Click **Commits** in the Development panel.
3. Click the **FishEye / Crucible** tab.
4. Start the process for creating a review for either a single commit, or for all the commits related to the JIRA issue.
5. In Crucible, the new review is in edit mode:
   - The content of the changelog becomes the content (i.e. files) to be reviewed.
   - The author of the commit becomes the author of the review, if Crucible is aware of this user. Otherwise the creator of the review becomes the author.
   - The creator of the review becomes the moderator.
   - The commit log message is used as both the Title and Statement of Objective.
6. Choose **Tools > Start Review**, in Crucible, when you are ready.

When using Crucible with JIRA 6.1.x and earlier

If you have Crucible linked to a version of JIRA earlier than 6.2 (or if you have instances of Crucible 3.2, or earlier, linked to JIRA 6.2, or later), the integration functionality continues to behave as previously.

Click here if you're using JIRA 6.1 or earlier...

When Crucible is linked with JIRA 6.1.x, or earlier, Crucible content appears on the **Reviews** tab (and FishEye content appears on the **Source** tab) in JIRA.

**To create a review from a JIRA issue:**

1. Go to the issue in JIRA that relates to the work to be reviewed.
2. Under 'Activity', click the **Source** tab.
3. Either:
   a. Click **Create review** to create a new review for a particular changeset.
   b. Click **Create review for all commits** to include all changesets from the JIRA issue in the new review.
4. If a similar review already exists, you can add the changesets to that.
5. In Crucible, the new review is in edit mode:
   - The content of the changeset becomes the content (i.e. files) to be reviewed.
   - The author of the changeset becomes the **author** of the review, if Crucible is aware of this user. Otherwise the **creator** of the review becomes the author.
   - The **creator** of the review becomes the **moderator**.
   - The commit log message is used as both the Title and **Statement of Objective**.
6. Choose **Tools > Start Review**, in Crucible, when you are ready.

The next step is to add reviewers.

**Screenshot: Adding a review from within JIRA**

### Creating a review from a URL

You can set up a URL that you can then click to create a Crucible review.

The format of your URL is as follows:

```
```

The parameters are as follows:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>csid</td>
<td>The changeset ID. You can specify one or more, of the form //repo/csid (where '%2F' is the URL-encoded form of is '/')</td>
<td>Yes</td>
</tr>
<tr>
<td>repo</td>
<td>The name of your repository.</td>
<td>Yes (unless supplied in the csid)</td>
</tr>
<tr>
<td>title</td>
<td>The title of your new Crucible review.</td>
<td>No</td>
</tr>
<tr>
<td>description</td>
<td>The description of your new Crucible review.</td>
<td>No</td>
</tr>
</tbody>
</table>

When you click the URL, you will be prompted to select the relevant **projects** if more than one project exists) in
which to create your review. A new draft review will then be created, including the following information:

- The content of the changeset becomes the content (i.e. files) to be reviewed.
- The author of the changeset becomes the author of the review, if Crucible is aware of this user. Otherwise the creator of the review becomes the author.
- The creator of the review becomes the moderator.
- The commit log message is used as both the Title (unless you have explicitly defined a title in your URL) and Statement of Objective.

All aspects of the review can be changed. To edit any of the above settings, click the title to see the ‘Edit details’ screen. Or you can click the Manage Files tab.

The next step is to add reviewers.

**Creating a Snippet Review**

This page explains how to create a simple code review using the Crucible Snippet Review feature. Snippet Reviews are designed to be lightweight ad-hoc code reviews.

To create a snippet review:

1. Copy the code to be reviewed from the source to your system clipboard.
2. Click Create snippet from the Create review menu in the Crucible toolbar.
3. Enter details for the snippet review:
   - Paste the code into the panel, where indicated.
   - Click on Click to add title near the top to enter a title for your review. If you don't specify a title, one will be automatically created for you.
   - Select a project from Project.
   - Select a programming language from Syntax Highlighting.
4. Click Save to create the snippet review.
5. Invite anyone that you want to participate in the snippet review by sending them the link to the review.
   The link is the review key, just above the review title. Anyone who is allowed to view the snippet is allowed to comment on it, and can close it.
6. Click Reply on any comments to respond.
7. Choose from the Tools menu to either close or delete the snippet review. Anyone can re-open, re-review or close snippet reviews, however, only the creator of a snippet review can delete it.

You can see your own snippets, or everyone's snippets, by choosing Reviews > Review dashboard. See Searching Crucible for information about filtering snippet reviews.

**Screenshots: Creating a Snippet Review (click to view larger images)**

![Step 1](image1.png)  
![Step 2](image2.png)

**Creating reviews from the command line**

You can use the Review CLI tool to create reviews in Crucible, for patches and commits, directly from your terminal. It takes the uncommitted changes in your workspace and creates a review for them in Crucible. The Review CLI tool may be especially useful if:

- you often create pre-commit reviews
- you want to submit a diff from an external tool for review

You can use the tool on Windows, Linux and Mac OS X, for repositories that are managed in:
The tool supports Crucible 3.0, and later versions. Python 2.7 must be installed on your local machine (Python 3 is not supported).

You can use the tool to create new reviews, and to update existing reviews with new patches.

**Known limitations**

- The CLI tool does not yet allow you to create a review for an existing commit.
- The CLI tool takes all the files that have been modified, added or removed in the working copy and submits those for review. It doesn't support choosing only files associated with a specific changeset.
- You can only use the CLI tool to create reviews in projects for which you already have review create permission.

---

**On this page:**

- Installing the Review CLI tool
- Python
- Using the Review CLI tool

**Related pages:**

- Creating a review
- Adding content to the review

---

**Installing the Review CLI tool**

Download the Review CLI tool from either of the following locations in Crucible:

- When creating a review, click **Pre-commit** in the 'Add Content to Review' dialog, then click **Download**:

![Add Content to Review CR-FE-7780](image)

- Choose **Profile settings** from your user menu, and then **Tools**. Click **Download**:

![Profile settings](image)
The script comes pre-configured for the user for the given SCM server. Copy the script to a location somewhere in your system path, for greatest ease of use.

**Python**

Python 2.7 is required.

**Linux**

Python 2.7 should come with your distribution. If not, or if 2.7 isn’t installed, you will need to install the appropriate package. Please refer to your package manager for the appropriate version.

**Windows**

You can install Python by running the latest [Python 2.7 Installer](http://www.python.org/getit/) for Windows.

**MacOS X**

Python 2.7 should come with any modern version of MacOS X. You can also download Python 2.7 from [http://www.python.org/getit/](http://www.python.org/getit/).

**Using the Review CLI tool**

To create a review using the Review CLI tool, run the script from a directory under SCM control that has local, uncommitted changes. The changes will be submitted to Crucible for review.

Call the script with the following command:

```
    crucible.py <arguments list>
```

The Review CLI syntax is consistent with that for Crucible and FishEye smart commits. Examples of syntax usage are provided in the following table:

<table>
<thead>
<tr>
<th>Action</th>
<th>Syntax</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>View usage help</td>
<td><code>crucible.py --help</code></td>
<td>Displays the help with descriptions of all the valid commandline arguments</td>
</tr>
<tr>
<td>Create a pre-commit review interactively</td>
<td><code>crucible.py</code></td>
<td>Gets the patch from the current SCM, prompts for the project and review title, and creates a draft review</td>
</tr>
</tbody>
</table>
Adding content to the review

This page explains how to add content, such as files and changesets, to a Crucible review.

We’ve found that reviews with fewer files and reviewers are more effective. Reviewers spend less time reviewing each file as the number of files increases, so don’t overload the review – help your reviewers to focus on just the essential files.

### Related pages:
- Creating a review
- Iterative reviews
- Choosing reviewers
- Performing the review

### On this page:
- Overview
- Changesets
- Branches
- Repository files
- Search for files
- Patch files for a pre-commit review
- Attachments
- Choose how reviewers see the content

#### Overview

Crucible supports post-commit and pre-commit reviews, depending on the type of content you add to the review:

- **Post-commit reviews** – for code changes that have *already* been committed to the SCM.
- **Pre-commit reviews** – for code changes that have *not yet* been committed to the SCM. Create a patch file for the code changes and then add the patch to the review.

Crucible also supports *iterative* reviews – you can update the review content with new versions. The reviewer can see the different versions of the files, so they can understand the changes that have been made.

#### To add content to a review:

1. Log in to FishEye/Crucible and either:
   - Create a new review, as described on Creating a review, or
   - Open an existing review, for which you are the creator or moderator, and click the ‘Add content’ (➕) button.
2. In the ‘Add content to Review’ dialog, click the option for the type of content you wish to add:

<table>
<thead>
<tr>
<th>Post-commit reviews</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Browse changesets</strong></td>
</tr>
<tr>
<td>Allows you to choose changesets from a repository. Go to Selecting changesets for review below.</td>
</tr>
<tr>
<td><strong>Choose branches</strong></td>
</tr>
<tr>
<td>Allows you to choose branches from a repository. Go to Choosing branches for review below.</td>
</tr>
<tr>
<td><strong>Explore repositories</strong></td>
</tr>
<tr>
<td>Allows you to browse for files in a repository, when FishEye is installed. Go to Selecting repository files for review below.</td>
</tr>
<tr>
<td><strong>Search for files</strong></td>
</tr>
<tr>
<td>Allows you to search a repository for files or changesets, when FishEye is installed. Go to Searching for files to review below.</td>
</tr>
<tr>
<td><strong>Pre-commit</strong></td>
</tr>
<tr>
<td>Allows you to upload patch files to a review, so you can review code changes that have not yet been committed to the SCM. Create a patch file for the code changes and then add the patch to the review. Go to Adding patch files to a pre-commit review below.</td>
</tr>
<tr>
<td><strong>Attachments</strong></td>
</tr>
<tr>
<td>Allows you to upload any file to a review, including binary files and files outside of a repository. Go to Adding attachments to a review below.</td>
</tr>
</tbody>
</table>

Changesets

Click Browse changesets in the ‘Add content to Review’ dialog to add SCM changesets to your review.

By default, Crucible displays a list of the review creator's changesets. You can see other changesets using the following options:

<table>
<thead>
<tr>
<th>Repository</th>
</tr>
</thead>
<tbody>
<tr>
<td>The repositories that contain files that can be reviewed.</td>
</tr>
<tr>
<td><strong>Author</strong></td>
</tr>
<tr>
<td><strong>Branch</strong></td>
</tr>
<tr>
<td><strong>Commit message</strong></td>
</tr>
<tr>
<td><strong>Scroll to changeset</strong></td>
</tr>
</tbody>
</table>

Select the checkbox next to a changeset ID to add the entire changeset. Note that:

- You cannot add individual file revisions to a review, although you can remove them once the changeset is added. Click **Remove all revisions from review** to remove all.
- You can choose how reviewers will see the files you have added (described below) by clicking **Add to Review as**.
- You cannot add changesets that are entirely svnprops changes (i.e. it has no non-metadata changes). For details, see **How do I force reviews to include SVN property changes?**

### Branches

When you select a branch to be reviewed, Crucible displays a list of the changesets on the branch that have not yet been merged to the base branch – you see a quick preview of the changesets that will get added to the review.

Reviewers will only see the changes that have been made on the branch – irrelevant changes are hidden. Furthermore, your reviewers can continue reviewing even if some changes are merged from the branch.

To add a branch to a review, click **Choose branches** on the 'Add content to Review' dialog, then choose the repository that has the branch you want reviewed:
Now choose the branch:

You'll see a list of the recent commits. If that all looks good, click Add branch to review to finish.

You can also create a branch review directly from the activity stream. Once your changeset is indexed and visible in the activity stream, just click on the cog and choose Create review for branch, and continue as above.

Your branch review is quickly and automatically updated whenever new commits are made to the repository branch – review participants get notified and are able to resume their reviews immediately.

You can remove files from a branch review and they won't be added again on the next update, unless there were further changes to those files. Furthermore, your reviewers are able to continue with the review even if some of the changes are merged from the branch to the base branch.

Repository files

Click Explore repositories on the ‘Add content to Review’ dialog to browse the SCM repositories for files to add to your review:

- By default, the folders are sorted by path name but they can also be sorted by last-commit or first-commit.
- To select a particular revision of a file, select **Load full history**... from the revision number list. This will refresh the available options.
- You can choose how reviewers will see the files you have added, as described below.

Note that:
- Empty folders are greyed out.
- The ‘Cog’ menu has options to **Hide empty directories** and to **Hide deleted files**.

![Add Content to Review TEST-323](image)

**Search for files**

Click **Search for files** on the ‘Add content to Review’ dialog to search for files to add to your review. **Search is only available when using FishEye with Crucible.**

Adjust the search filters to find the files you need. If the simple filters are not enough, consider using **EyeQL queries**.

Read more about searching your repositories in the FishEye documentation.

You can choose how reviewers will see the files you have added, as described below.
Patch files for a pre-commit review

Click Pre-commit on the ‘Add content to Review’ dialog to add previously created patch files to a pre-commit review.

Choose an upload method:

<table>
<thead>
<tr>
<th>Select file from the file system</th>
<th>Charset – click the edit icon ( ) to choose the character set being used. UTF-8 is the default.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paste text from clipboard</td>
<td>Patch text — paste your copied text in this text area.</td>
</tr>
</tbody>
</table>

For more information see Creating patch files for pre-commit reviews.
Patch anchoring

A short-coming of patches for code review is the reduced context around code changes because the patch does not include all lines of code from the file. Crucible ‘patch anchoring’ overcomes this by searching for the relevant file content in the connected repositories, and automatically anchoring the patch to the trunk or the branch with the most recent commit activity. Crucible can then seamlessly display more context, as required.

See Using Crucible patch anchoring for more information.

Attachments

Click Attachments on the 'Add content to Review' dialog to add attachments to your review.

You can attach additional files to be used in the review, including binary files, images or code files that are not stored in a version control repository.

<table>
<thead>
<tr>
<th>Charset</th>
<th>Click to choose the character set being used. UTF-8 is the default.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose File</td>
<td>Browse for a file that you want to add to the review.</td>
</tr>
<tr>
<td>Upload</td>
<td>Browse for a file that you want to use as the base of a diff with a previously attached file.</td>
</tr>
</tbody>
</table>

To add another iteration of a file, upload a different version of the file with the same filename. It will be added as a new version.

Choose how reviewers see the content

When you add files to a review, you can set how reviewers will see the files, for example as the whole file, or as a diff.

Choose one of the following options from the Add to Review as list:
Iterative reviews

Crucible supports iterative (cumulative, or incremental) reviews for both post-commit and pre-commit reviews. This allows you to update the review with new versions of files, and changesets (for post-commit reviews) or patches (for pre-commit reviews) that have been created after the review was started.

Iterative reviews allow your team to discuss changing code in the context of a single review. This lets the reviewers see all the related changes together, and to more easily keep track of comments and defects.

On this page:
- Iterative post-commit reviews
- Iterative pre-commit reviews
  - Initial patch upload
  - Iterative patch uploads
- Viewing diffs

Iterative post-commit reviews

To set up an iterative post-commit review, you create a review, and add content to it, in the usual way. Crucible automatically recognizes when files under review have been updated in the repository, and provides the option to add the revision to the review.

Iterative pre-commit reviews

To set up an iterative pre-commit review, you initial patch upload, and to it, in the usual way. Crucible automatically recognizes when files under review have been updated in the repository, and provides the option to add the revision to the review.

See Viewing diffs below for information about the slider and diffs.
Pre-commit reviews make use of patch files that are uploaded to a review. Crucible allows revisions of patch files to be uploaded to the review, and can display diffs for files in the patches. This allows your team to set up and perform iterative pre-commit reviews.

See Creating patch files for pre-commit reviews.

Initial patch upload

When uploading the initial patch for a review, Crucible must be able to anchor the patch to a repository if you subsequently want to upload patch iterations. If Crucible is unable to anchor the patch to a repository, you will only be able to upload the patches as separate files.

You upload the initial patch for a review in the usual way – see Adding content to the review.

Iterative patch uploads

When you add a new iteration of the patch to the review, you can choose which previously uploaded patch it is a revision of. The new patch must be anchored to the same repository as an existing patch.

Note that you cannot add unanchored patches, even if they include full-context diffs. You can include an unanchored file in the anchored patch, however Crucible is unable to provide full context for that.
Viewing diffs

Crucible allows the reviewer to see the different revisions of a file within the same review. The 'slider' in the file view allows you to interactively select which revisions are compared in the displayed diff, and to see the full source content. Comments are connected to, and displayed with, a specific revision. This allows you to review every change that has occurred on a code file over a given range of commits, and lets you see the evolution of the file through various revisions (all within one Crucible review).

These screenshots show how, for a post-commit review, you can drag the slider ‘handles’ so as to display just the changes in the last commit:

Drag the 'handles' to the same commit to see the full source of that version of the file.

When viewing patch files in a pre-commit review, the slider displays the diff for the selected iterations, in a similar way to that for post-commit reviews. Each patch iteration is referred to as a ‘working copy’.

Creating patch files for pre-commit reviews

This page describes how to create patch files from your local repository, how to attach them to a Crucible review and how to use Crucible's Patch Anchoring to retrieve more context from the original file.

A patch file is a portion of a source code file that contains the code changes that you have made – it's a diff that shows the differences between your working copy and the base revision.

A pre-commit review in Crucible allows a developer's code changes, in the form of a patch file, to be reviewed before those changes are committed to the SCM. A typical scenario is where the developer does not have write access to the repository. The developer creates the patch file and adds it to a Crucible review. Once reviewed, the patch is either committed to the repository or is sent back to the author.

You can create the patch file from your local repository:

- using tools in your IDE – described below
- using repository command-line tools
- using the Crucible Review CLI tool – see Creating reviews from the command line

As an enhancement, Crucible's patch anchoring adds context:

- By default, patch files will only show a few lines of code surrounding each change, rather than the entire file and its changes. Patch anchoring overcomes this limitation.

On this page:

Creating a patch file from IntelliJ IDEA 7.0

1. Select a parent folder, sub-folder or file that you have altered, in the Project tool window.
2. Select Version Control > Create Patch:
3. Click **Create Patch**, choose a location to save the patch file to, and click **OK**.

*If you do not have the Create Patch command available in IDEA*

If you have not configured version control in IDEA, you may not have the **Create Patch** option available. If so, use the following steps to create a patch file in IDEA:

1. Select a parent folder, sub-folder or file that you have altered in the Project tool window, right-click it and choose **Local History > Show History**.

2. In the Local History view, right-click the revision number, and choose **Create Patch**.
3. In the Create Patch dialog, choose a location for the patch file and a file name, then click **OK**.

### Creating a patch file in Eclipse 3.3.1.1

1. Find the parent folder, sub-folder or file that you have altered, right-click it and choose **Team > Create Patch**.

2. In the Create Patch window, choose a location on your computer and type an appropriate file name (the file format is plain text):
Creating a patch file from the command line

Create patches yourself, directly from the SCM, using the following commands, where `patch.txt` represents your name for the new patch file.

Then you can use the dedicated Crucible Review CLI tool to create reviews for your patches and commits, directly from your terminal. See Creating reviews from the command line.

<table>
<thead>
<tr>
<th>SCM</th>
<th>Command</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>CVS</td>
<td><code>cvs diff -Nu &gt; patch.txt</code></td>
<td>Creates a patch file with around three lines of code, before and after each change. Revision information is included by default, so if you have FishEye, you may be able to anchor the patch to get full context.</td>
</tr>
<tr>
<td></td>
<td><code>cvs diff -N -U 10000 &gt; patch.txt</code></td>
<td>Creates a patch file that shows all code in the file. <code>10000</code> refers to the number of code lines before and after each change that are included in the patch.</td>
</tr>
<tr>
<td>SVN</td>
<td><code>svn diff &gt; patch.txt</code></td>
<td>Creates a patch file with around three lines of code, before and after each change. Revision information is included by default, so if you have FishEye, you may be able to anchor the patch to get full context. <strong><code>svn diff</code> does not print any information about files copied in the workspace.</strong></td>
</tr>
<tr>
<td>Subversion</td>
<td>Creates a patch file that shows all code in the file.</td>
<td></td>
</tr>
<tr>
<td>------------</td>
<td>------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The built-in diff feature in <code>svn diff</code> does not support specifying lines of context, so you must tell Subversion to use an external diff command.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The second <code>diff</code> in the command needs to be the name of your external diff command. You might need to specify the full path to that command, such as <code>/usr/bin/diff</code>.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• On the Windows platform, you may need a Unix-like emulator such as Cygwin, and install the optional diff command for that.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Perforce</th>
<th>Creates a patch file with around three lines of code, before and after each change.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Revision information is included by default, so if you have FishEye, you may be able to anchor the patch to get full context.</td>
</tr>
<tr>
<td></td>
<td>The <code>-dcu</code> option provides a combination of “context format” and “unified format”. It provides the diff in a standard unified diff format (which we need to parse the diff) as well as revision information (which we need to anchor to FishEye). Later versions of Perforce do not support <code>-dcu</code>, so <code>-z tag</code> should be used instead.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Perforce</th>
<th>Example of using GNU <code>diff</code> to append files individually to the patch in UNIX.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Since Perforce diffs do not include added and deleted files, you should use <code>p4 opened</code> to find such files.</td>
</tr>
<tr>
<td></td>
<td>Replace <code>path_to_added_file</code> with the actual path of your added file. You can follow a similar procedure with deleted files using <code>p4 print</code> to extract the previous version of the file.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Perforce</th>
<th>Perforce does not directly support creating patches that include all lines of code. A workaround is to check out ‘before’ and ‘after’ versions of the file, and use GNU Diff to create a patch between the two files. That file could then be loaded into a Crucible review.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Mercurial</th>
<th>Creates a patch file with around three lines of code, before and after each change.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Revision information is included by default, so if you have FishEye, you may be able to anchor the patch to get full context.</td>
</tr>
<tr>
<td></td>
<td>If you use Git-style diffs (<code>--git</code>), the revision information will not be provided. This means that we cannot anchor the patch to a FishEye repository.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Git</th>
<th>Creates a patch file with around three lines of code, before and after each change.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Revision information is included by default, so if you have FishEye, you may be able to anchor the patch to get full context.</td>
</tr>
</tbody>
</table>

**Using Crucible patch anchoring to automatically add full context**

Crucible’s Patch Anchoring feature allows you to add a regular patch (showing only a few lines of context) to a review. Then, Crucible will automatically search for the relevant file content in the connected repositories. When it finds the files, it will seamlessly add in more context from the files so that you can view all of the lines of code (greatly enhancing the review process).

**To use patch anchoring:**

1. Click Create review in the Crucible header.
2. Click **Pre-commit**. In the dialog that appears, click **Choose File** to locate your file, then **Upload**. Crucible will now search for matches in the files in its database. Crucible will analyze all the paths in the patch, find the branches containing all those paths, then anchor the patch to the trunk or the branch with the most recent commit activity.

Crucible makes a 'best guess' in its processing – you should check that it has anchored the patch to the correct location in your repository.

When you start the review, and view a diff, you will be able to choose more than three lines of context from the Viewing menu.

**Screenshot: Viewing more than three lines with Patch Anchoring**

Choosing reviewers

This page describes how to add reviewers (as a mix of individual users and groups) to a new review, after it has been created. See **Creating a review** for information about creating reviews.

Before a review can be started, you need to choose reviewers. To add reviewers you just click **Edit Details** for the review.

**Adding users to a review**

You can choose reviewers from available Crucible users and groups by typing names into the **Reviewers** field. The users and groups that are available to be reviewers are determined by the project's settings for **Default Reviewers** – see **Creating a project**.

When adding a group to a review, only the first 9 users in the group are added – extra users must be added individually. Note that a Crucible administrator can set the number of users added from a group by using the **cru cible.users.per.group.in.review** property – see **JVM system properties**.

You can also allow any Crucible user to add themselves as a reviewer by selecting **Allow anyone to join**.
Click **Done** to save the review as a draft for later issue.

Click **Start Review** to begin the review immediately.

**Suggested reviewers**

Crucible will automatically suggest reviewers, by analyzing the users that have contributed to the files you've selected and also don't have a lot of open reviews. You can easily pick reviewers from the list of suggestions by clicking.

**Removing reviewers**

You can remove reviewers who no longer need to contribute to the review.

Click **Edit Details** for the review, hover over the reviewer's name, and click the cross.

**Checking the draft and starting the review**

The draft review opens. In the draft stage, the author can check the contents of the review files to ensure they are correct and put in any notes for reviewers as comments. During the draft phase, no notification email is sent out to reviewers. Once the author is finished with the draft phase, they click **Start Review**.
The review will now be started and notification email will go out to all participants. Crucible will now send out an email notification to all the participants. This lets them know that the review is under way and prompts them to take action, providing a URL for direct access to the review. (You can also subscribe to an RSS feed.)

Next steps

You can now begin Performing the review.
If you have a moderator controlling your review process, you can move onto Starting a review.

Performing the review

This page describes how to find and manage the Crucible reviews that relate to you.

On this page:

- Browse your reviews on the Dashboard
- When files change during a review
- Next steps

Deciding what needs to be reviewed

The ‘Statement of Objective’ is a brief description of what the review is intended to achieve. Crucible does not dictate how or what to review. It simply provides a mechanism to record comments.

Browse your reviews on the Dashboard

When you first start Crucible, the Dashboard shows your current reviews and other activity related to you.

Use the Dashboard to manage your reviews – see Browsing all reviews.

All reviews that involve you in any role are listed when you click Inbox or Outbox under the Reviews menu. For example, choose Reviews > Inbox to see reviews that don’t require further action from you, but are still active.

If email notifications are enabled (see SMTP settings in the FishEye documentation), reviewers will receive an email with information about the review. Click the link within the email to go directly to the review.

When files change during a review

If a file in the repository changes during a review, Crucible will visually alert you by showing the File Outdated menu, when viewing the file:

![File Outdated Menu](image)

From the File Outdated menu, you can choose to view the latest revision of the updated file, or add the latest revision to the review:
Next steps

- Starting a review
- Commenting on reviews
- Sending a review's comments via email
- Changeset discussions
- Flagging defects
- Viewing reports
- Completing your review
- Using the Review History Dialog

Starting a review

On this page:

- Starting a review
- Editing a review once started

Starting a review

Starting a review simply means formally starting it – this makes the review available for the selected reviewers to begin reviewing.

Once you have selected the reviewers, the next stage is to notify the reviewers and the author (if different to the moderator) that they can start reviewing. The review has been in 'Draft' state until this point. Only the moderator has the permission to start a review.

To start the review:

- If you are the moderator of the review, click Start Review. Note that only people with the 'Approve' permission can start a review.
- If you are not the moderator of your review, click Send to Moderator. This changes the state to 'Requires Approval' and notifies the moderator. The moderator can change any aspect of the review before starting it.

Once the review has been started, the review state becomes 'Under Review'.

Editing a review once started

You can quickly add files to, or remove files from, the content of a review at any time.

To add files to the review:

- Click Edit Details near the top right of the review, and then Add content to add files.
To remove files from the review:

- click the 'Edit' button at the top of the left navigation panel (highlighted in yellow in the screenshot below), then clicking the red cross beside the files you want to remove.

Commenting on reviews

Comments are at the core of the review experience – reviewers use comments to record discussion around suggested and required changes to the code.

Comments can be added at the level of a review, a file, or a line. Of course, you can also reply to comments.

On this page:

- Locating existing comments
  - Use the Review Activity
  - Use the file tree
- Adding comments
- Draft comments

Locating existing comments

*Use the Review Activity*

The easiest way to browse for comments is to use the Review Activity – click **Activity** when viewing the review (or use the keyboard shortcut ‘shift’ + ‘]’):
The Review Activity shows all the latest comments on the review, so it's easy to catch up on the review, or to find outdated or hidden comments.

The bubble beside the Activity link shows the number of unread comments.

Scroll through the comments or use the keyboard shortcuts:

- 'n' – go to the next comment
- 'p' – go to the previous comment
- 'shift' + 'n' – go to the next unread comment
- 'shift' + 'p' – go to the previous unread comment

Click Mark as read or Mark as unread (or use the 'm' keyboard shortcut) to toggle the comment status.

To see the comment in context just click it (or press the 'return' key) to go to the file where the comment was made.

Use the date link for a comment to connect others to the comment:

Use the file tree

The number beside a filename, in the left-hand panel of a review, indicates the number of comments on that file.

(The number of unread comments, if any, is shown in brackets.)
Adding comments

There are various types of comments that you can add in Crucible:

<table>
<thead>
<tr>
<th>To comment on...</th>
<th>Do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>The whole review</td>
<td>Click <strong>General Comments</strong> (in the left-hand panel), and simply type your comment (under 'General Comments').</td>
</tr>
<tr>
<td>A source file under review</td>
<td>Click on the file in the left-hand panel, then click <strong>Add a file comment</strong> (just above the source code listing).</td>
</tr>
</tbody>
</table>

**Add a file comment**: Click on source lines to add an inline comment.
```css
#snippet-root .snippet-sml-1 {
  display: block;
}
```
Lines of code

Click on a line of code in the displayed source file of a review.

- You can click and drag to select multiple lines, and click individual lines to select or deselect them. The comment will appear in the source at the last line selected.
- Hover over the comment to see the lines to which the comment applies.
- To select text on the page without adding a comment, hold down the Alt key while dragging the cursor.

A revision or changeset

See Changeset discussions.

To reply to a comment, click **Reply** at the bottom of the comment.

⚠️ Only people with the ‘Comment’ permission can add comments. A comment can only be deleted by the author of the comment.

ℹ️ Read about flagging defects too.

Draft comments

You can save your comment as a draft and then edit it later. When you complete the review, you will be prompted to post, discard or edit any remaining draft comments.

Sending a review’s comments via email

You can download all of the comments from a review as plain text, so that you can send that to anyone you want via email. You may wish to do this to allow a person outside the review to quickly scan the content of the comments, or oversee the review activity. Alternatively, you may wish to send all participants this information to let them read the current status of the review and its comments in full.

To send all of a review’s comments via email:

1. In Crucible, navigate to the review in question.
2. Choose **Tools > Download as Text**.
3. Copy the on-screen text and paste it into an email.
4. Send.

Changeset discussions

When using Crucible with FishEye, you can have threaded discussions with other users, on any changeset. To start a discussion, you simply start by adding a comment to a changeset.

ℹ️ You need to be logged in to create changeset comments.

Adding comments to changesets

To add a comment to a changeset:

1. Click on a changeset on the **Commits** tab for the repository. Display comments by clicking **Discuss** at the upper right corner, or the speech bubble icon in the left margin.
2. Click **Add a comment** (under the repository details near the top left).
3. Type your comment. If required, you can tag your comment as being a defect note by clicking **Defect**.
4. Click **Post**.
Once submitted, others can respond to your comment by clicking **Reply**. Replies are threaded as separate comment discussions. You can right-click on the permalink icon to copy a link to the comment. The comment author can edit or delete their own comments.

To hide the changeset comments, click the page icon. You can display the comments panel by clicking the speech bubble icon again.

As you compose a comment, it will auto-save periodically.

*Screenshot: Opening Changeset Discussions*

## Turning changeset discussions on and off

You can turn off changeset discussions in the Admin area:

1. In the Admin area, click **Repositories** (under ‘Repository Settings’ on the left).
2. Find your repository and choose **View** from the ‘cog’ menu in the Actions column.
3. Click **Other Settings** in the left panel.
4. Under ‘Changeset Discussions’ clear the **Allow changeset discussions** checkbox.

By default, changeset discussions are on.

### Notifications

- Comments show up in the activity stream,
- The author of the changeset will get email notifications when comments are added,
- Comment authors will get email notifications when someone replies to their comments.

### Flagging defects

Comments in Crucible can be used to flag a defect in the code under review.

To do this, simply check **Defect** when adding a comment and select a category from the drop-down list.

*Screenshot: Defects*
You may want to mark comments as defects in order to associate defect classifications, or simply to highlight to the author or moderator that the issue you raised in your comment requires attention. You can use the with defects filter to find files that have been flagged with defects.

- Crucible intentionally does not mandate how defects are to be used. The Crucible administrator can customize the defect classifications.

**Viewing reports**

This page describes how to use the Reports tab in Crucible to see lists of people whose action is required on open reviews. These are known as ‘blockers’.

**On this page:**
- Viewing the Review Blockers report
- Viewing the JIRA Blockers report

**See also:**
- Viewing the Review Coverage report

**Viewing the Review Blockers report**

To view a list of people who have open reviews assigned to them:

1. Click the dropdown arrow next to the Reviews tab at the top of the page and select Reports.
2. Click Review Blockers (under the ‘Reports’ sub-tab).
   - Click a user’s name to go to their ‘Activity’ screen.
   - Click a number in the ‘To Complete’ or ‘To Summarize’ column to go to a list of reviews for that user.

**Screenshot: ‘Review Blockers’ Report**
Viewing the JIRA Blockers report

The 'JIRA Blockers' report shows you a list of users whose action is required on open reviews, for a particular set of JIRA issues. The reviews must be explicitly linked to a JIRA issue or mention a JIRA issue key in the summary or the objectives.

To view the 'JIRA Blockers' report:

1. Click the dropdown arrow next to the Reviews tab at the top of the page and select Reports.
2. Click JIRA Blockers (under the 'Reports' sub-tab).
3. Enter details for your JIRA server and project, and click Go. Note that the JIRA project's version field refers to the Fix Version/s field in your JIRA tickets.

The 'JIRA Blockers' report displays the following information:

- A list of JIRA issues for which one or more Crucible reviewers has not completed their review.
- A list of users who have an incomplete Crucible review that relates to a JIRA issue.
- A list of open JIRA issues for which a Crucible review is closed, and vice versa.

Screenshot: 'JIRA Blockers' Report
Review Coverage report

Crucible has useful reports that show you detailed statistics on review activity. The Review Coverage report allows you to see how much of the code, and which files, in your repository have been reviewed, and when. You can also access the reviews.

This feature requires FishEye integrated with Crucible.

On this page:

- Opening the Review Coverage report
- Using the Summary Panel
- Using the Review Coverage Overview
- Using the Individual Committer Stats panel
- Using the Changesets panel

Screenshot: The Review Coverage report
Opening the Review Coverage report

To open the Review Coverage report:

1. Click **Repositories** and choose a repository. The repository you chose sets the scope for the report.
2. If desired, navigate down the tree (in the lefthand panel) and click the desired path you want to view coverage on.
3. Click **Reports** in the secondary toolbar.
4. Click **Review Coverage** from the list of reports in the upper panel.

You can view coverage of any path by navigating down the tree to the desired path you want to view coverage on, before clicking on the **Reports** tab.

Using the Summary Panel

The summary panel displays the following metrics for your selected repository:

- Overall review coverage percentage.
- Change in review coverage percentage since the last reporting period.
- Total number of reviews.
- Total number of comments.
- Total number of reported defects.
- Total number of Lines of Code (LOC).
- Total number of commits.
- Total number of committers.
- Total number of unreviewed lines.
- Total number of lines under review.
- Total number of reviewed lines.
- A ratio of the number of lines unreviewed against reviewed Lines of Code (LOC).

*Screenshot: Summary Panel in the Review Coverage report*
Using the Review Coverage Overview

The Review Coverage Overview shows a timeline of reviews, compared against their percentage of coverage. Hover your mouse cursor over the data points on the graph to see granular information and click through to a detailed weekly report.

You can click the tabs to view the coverage expressed as a percentage of lines of code, changesets or revisions.

*Screenshot: Overview Panel in the Review Coverage report*

Using the Individual Committer Stats panel

The Individual Committer Stats panel lets you choose a user from your Crucible instance and see all the changesets by that committer.

*Screenshot: Individual Committer Statistics in the Review Coverage report*
The Changesets panel lets you see changesets from your Crucible instance (for the time period of the report), and their level of review coverage. This information can be sorted by the columns in this view and uses color coding to denote review coverage (listed in the table below).

## Color Key

<table>
<thead>
<tr>
<th>Color</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>dark green</td>
<td>reviewed</td>
</tr>
<tr>
<td>light green</td>
<td>in review</td>
</tr>
<tr>
<td>red</td>
<td>not reviewed</td>
</tr>
</tbody>
</table>

**Screenshot: Changesets panel in the Review Coverage report**
Completing your review

Once each reviewer has added comments to the review and has nothing further to add, the next step is for them to complete their individual review.

To complete your individual review, go to the review and click Complete at the top of the screen, next to the Tools menu:

Only people with the 'Complete' permission can complete a review.

This notifies the moderator (via email if configured) that you have completed your review.

Reviewers can still continue to add comments until the moderator summarizes the review. The moderator does not have to wait for all reviewers to complete their individual reviews before summarizing.

If you have any draft comments, you will be prompted to post/discard/edit any comments before completing the review.

Screenshot: Draft comments
Warning

You have draft comments
Draft comments that aren't posted will be deleted.

View drafts
Delete drafts
Post drafts

Screenshot: Review complete
Using the Review History Dialog

The Review History dialog shows a chronological list of interactions within a review. You can see rich information about those interactions and control their display. You can sort the information by date, actor, or action.

To open the Review History dialog:

1. Open a review in Crucible.
2. Choose Tools > View Review History from the top right of the screen.

Click the Timeline tab at the top of the History dialog to see the review's events in a horizontal calendar. You can drag the calendar and the timeline at the bottom to scroll to other events.

Click Export as CSV near the top right to export the entire review history, allowing for easy data import into a spreadsheet or other application.

Screenshot: The Crucible Review History dialog
Summarizing and closing the review

Summarize is an optional step before closing a review.

To enable or disable the Summarize step, you will have to configure the permission in your Permission Scheme. Crucible ships with two permission schemes:

- 'Agile' - the summarize step is disabled for all users
- 'Default' - the summarize step is enabled for the moderator

You can choose to either summarize a review or close a review at any time, given that your Permission Scheme allows it. You can skip the summarize step by directly clicking Close.

Note that you need the 'Summarize', 'Close' or 'Re-Open' permission to summarize, close or re-open a review.

Normally, we recommend that you wait for all reviewers to complete their reviews, before summarizing or closing the review.

The reviews that the reviewers have completed will be in your Ready to Close menu on the Dashboard.

To summarize a review,

- Click Summarize at the right of the screen.
- Optionally enter a summary of the review.
- If you have no further comments to add, click Close Review; otherwise, click Continue Without Closing.
On clicking **Summarize**, you may be prompted to confirm the action if there are incomplete reviews or draft comments in the review. These are warnings, however; the review can still be summarized and closed.

**Screenshot: ’Summarize’ button. We can see that Geoff Crain has still not finished reviewing, because there is no green tick next to his name.**

Once the review is in the ’Summarize’ **state**, the moderator can optionally add a review summary, for example, to describe the outcomes/tasks/etc:

**Screenshot: Review Closed**
The summary is sent to all participants and is displayed at the top of the closed review.

- Reviews in the 'Review' or 'Summarize' state can be closed.
- Reviews in the 'Summarize' or 'Closed' state can be re-opened. Re-opening changes the review's state back to 'Under Review', allowing all participants to add comments.
- See this page for a list of the states that a review can be in.

Re-opening a review is not the recommended way to 're-review'. You should create a new review with the reworked changes and link it to its parent review (create a hyperlink back to the original review in the new Review's Objectives field).

Managing your reviews

See:

- Using Review Reminders
- Moving a review to another project
- Using Progress Tracking
- Using Time Tracking
- Viewing people's statistics in Crucible
- Viewing Project Statistics
- Deleting a review

Using Review Reminders

Crucible will automatically send reviewers a reminder email one working day before the deadline.

Review authors and moderators can also do the following:

- Send manual reminders to reviewers whose work is still pending.
- Configure preset reminders for reviews that have a deadline.
Reminders are only sent if Crucible’s SMTP server is configured. Please see Configuring the SMTP server.

Preset Reminders

When a review has a deadline (due date), you can have Crucible send a preset reminder to all of the pending reviewers, some number of working days before the deadline.

To add a reminder, firstly edit the review, then click Add a reminder. You can edit the reminder period.

The Send Reminder setting is only available if the review has a due date set.

Manual Reminders

You can send a reminder to all the reviewers that have not yet completed their review:

Before the review is due, click Share and add recipients and a message. Besides sending reminders to participants, the Share option can also be used to share the review with people external to it:

If the review is overdue, click Send Reminder. The message is pre-populated with recipients who have not yet completed their review.

Moving a review to another project
You can move reviews between projects once they have been created.

To move a review between projects:

1. Open the review and click **Edit Review** at the top of the screen.
2. The 'Edit Review' window will open, allowing you to change various aspects of the review.
3. In the 'Edit review' screen, use the **Project** drop-down menu to select a new parent project for the review.
4. Click **Done** at the bottom of the screen.

**Screenshot: Changing a Review’s Parent Project**

Using Progress Tracking

This page contains instruction on how to use progress tracking in Crucible.

**On this page:**

- How progress tracking works in Crucible
- Viewing the progress tracking totals
- How to adjust progress tracking on a review
- Adjusting settings for progress tracking
- Further reading

How progress tracking works in Crucible
As you work your way through the files in a review, Crucible tracks the ones you have viewed. Whenever you open a file for review, Crucible will automatically mark it as read.

When participating in iterative reviews, progress tracking also takes lines of code and revisions into account.

Viewing the progress tracking totals

The 'Details' section shows a summary of the progress of each participant through the files in the review.

If there is only one file in the review, then the progress tracked will either show 0% or 100%.

Screenshot: Viewing the Progress Tracking Totals

How to adjust progress tracking on a review

You can mark a file as unread by clicking on its name to view the file's contents, and then clicking Leave Unread (at the right of the file’s toolbar). This file is now not included in your progress percentage.

Screenshot: Marking a File as Unread

Adjusting settings for progress tracking

Progress tracking is a configurable user preference – choose Profile settings from your user menu. On the Review settings tab, Auto-mark files as read is on by default – when set to off, you have to mark files as read or unread yourself.
Further reading

You may also want to learn about Crucible's Time Tracking feature.

Using Time Tracking

This page contains instruction on how to use time tracking in Crucible.

On this page:

- How time tracking works in Crucible
- How to adjust the time tracked on a review
- Viewing the time tracking totals
- JIRA integration
- Further reading

How time tracking works in Crucible

Crucible will automatically track the time you spend in a Crucible review. When you open a file for review, a counter in the Review Details panel starts. The time is added to your total when you leave the review screen.

Screenshot: Crucible Time Tracking

How to adjust the time tracked on a review

You can click and type in the time tracking control to adjust the time you have spent during the session.

Viewing the time tracking totals

The 'Details' section shows a summary of the progress and time tracked on each file.

Screenshot: Crucible Tracking Totals
JIRA integration

Using Crucible when integrated with JIRA, you can update time tracking from the following locations:

- The confirmation dialog for a reviewer completing a review,
- The confirmation dialog on closing a review,
- The regular toolbar location in Crucible.

Screenshot: JIRA Time Tracking Integration

Further reading

You may also want to learn about Crucible's Progress Tracking feature.

Viewing people's statistics in Crucible

This page contains instructions on how to use the People tab in Crucible to see charts and activity from people with accounts on the system.

On this page:

- Opening the list of People
- Viewing a Person's Activity Screen
- Viewing charts of a person's activity

Opening the list of People

To view statistics on People in Crucible, (that is, code authors, committers and reviewers) click the People tab at the top of the page.

The list of all people shows all users that have accounts on the system. By default, each user has a unique avatar that is randomly formed from the text in their email address. You can add your own avatar by uploading an image to an external service such as Gravatar, which Crucible supports. See Changing your User Profile.

Screenshot: List of all People in Crucible (when using FishEye with Crucible)
Viewing a Person’s Activity Screen

Click on a username to see a listing of activity for them as well as charts showing statistics for their activity.

The right hand pane displays a list of all activity for this user. You can:

- click the icons to view full commit information in FishEye
- click JIRA issue names to open the work ticket on an item
- click the long button to see the list of files in context
- click the star icon to add an item to your favorites.

The left hand pane displays charts around this activity, including:

- number of active reviews
- charted history of lines of code
- code committing activity
- general statistics.

Screenshot: The People Activity Screen in Crucible
Some users may not appear to have the correct number of Files Changed or LOC, despite regularly committing. In this situation, if they have committed to a directory which is not covered by the regexes in your symbolic definition (i.e. they have committed to a directory that is neither trunk, branches or tags) then that directory will be counted as part of trunk. Also note that creating tags and branches themselves does not count toward the totals.

Viewing charts of a person's activity

To see information on a person's activity charted in detail, click the headings in the left-hand pane. Each heading will show more information on demand, when clicked. The information available and what it means is listed below.

The charts in this section are only available when using FishEye.

Screenshot: People Activity Charts in Crucible

- **About**
  
  The username section shows the email address, then the first and latest commit dates for the person in context. Also displayed are data points for the previous week and all-time. It shows number of commits, number of files changed and number of lines changed.
• **Reviews**
  The Reviews section shows several filters that you can click to constrain the review items shown in the right-hand pane. The options are **To Review, Ready to Close, Out For Review, Open** and **Closed**.

• **Line History**
  The Line History section shows a graph with the number of lines committed to the repository, charted over time.

• **Commit Activity**
  The Commit Activity section shows four smaller charts; the first showing the volume of commits over a 52 week period; the second showing the relative number of commits on days of the week; the third showing the relative number of commits by the hour of the day when they were lodged; the last shows a commit calendar.

• **Committer Mappings**
  The Committer Mappings section displays username mappings from various systems if they have several usernames in play.
Viewing Project Statistics

This page explains the layout of the Project Summary page.

On this page:

- Project Name Panel
- Project Line History Panel
- Project Stats Panel
- Project Commit Activity Chart

When you click through to a Crucible Project from the Projects Tab, the 'Project Summary' screen opens.
In the right hand pane, you can see an activity stream relating to this project. In the left hand pane, you can see various statistics charts relating to the project in context. These appear in a reduced size until you click them, when they will expand to show more information.

Project Name Panel

This contains a short message explaining which Crucible Project and FishEye repositories are being accessed to show the activity stream on the page.

Project Line History Panel

This panel contains a chart showing the lines of code added to the repository, graphed over time.
Project Stats Panel

This panel contains a chart showing numerical data for commits, files changed and lines change, graphed over time.

Screenshot: The Project Stats Panel

<table>
<thead>
<tr>
<th></th>
<th>Last Week</th>
<th>All Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commits:</td>
<td>137</td>
<td>16,033</td>
</tr>
<tr>
<td>Files changed:</td>
<td>543</td>
<td>69,896</td>
</tr>
<tr>
<td>Lines changed:</td>
<td>33,643</td>
<td>594,583</td>
</tr>
</tbody>
</table>

Project Commit Activity Chart

This panel contains a number of charts:

<table>
<thead>
<tr>
<th>Chart</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>52 week commits volume</strong></td>
<td>This chart shows the amount of commits, shown by week over a one year period.</td>
</tr>
<tr>
<td><strong>Commits by day</strong></td>
<td>This chart shows the amount of commits, graphed by day over the past week.</td>
</tr>
<tr>
<td><strong>Commits by hour</strong></td>
<td>This chart shows the amount of commits, graphed by hours over the past day.</td>
</tr>
<tr>
<td><strong>Commit calendar</strong></td>
<td>This chart shows the amount of commits (shown as darker colors to indicate more commits) graphed by month, over years that the repository has been running.</td>
</tr>
</tbody>
</table>

Deleting a review

To delete a review you must first abandon the review. To do that, follow the instructions below.

Deleted reviews cannot be retrieved.

**Related page:**

- Deleting hung reviews manually

To abandon and then delete a review:

1. Open the review.
2. Choose **Tools > Abandon**.
3. Now, on the Crucible dashboard, click **My Abandoned Reviews** in the left-hand navigation bar.
4. In the list of abandoned reviews, click the name of the review you wish to remove.
5. Once the review details are displaying, choose **Tools > Delete**. The review will be instantly deleted.

Screenshot: Deleting a review in Crucible
Searching Crucible

Crucible has a powerful search engine that allows you to find reviews. There are two methods for searching in Crucible:

- **Quick Search** — The Quick Search allows you search all Crucible projects by entering a single search string. This search is the default search and will suggest “quick nav” results (header search box only). Results are weighted by most recent edit date.
- **Filtering Reviews** — An alternative method for searching for reviews is to display all reviews and apply a custom filter to the list. This is generally slower than searching, but allows you to specify filter criteria against a range of fields.
- **Comment Search** — If you want to find specific review comments, Crucible provides a powerful comment search.

See also Searching FishEye.

**On this page:**
- Using the Quick Search
- Filtering reviews
- Searching for Review Comments

Using the Quick Search

Before you begin:

- The Quick Search will also return changesets and files, if you are using FishEye with Crucible. For information on searching FishEye, see Searching FishEye in the FishEye documentation.

**To search Crucible using the Quick Search:**

1. Enter your search terms in the search box in the Crucible header. Crucible offers a number of criteria that you can use to refine your results, see Refining your Quick Search Criteria below.
2. Results will appear in a dropdown, as you type. Results will attempt to be matched against the review name, project and user.
   - If you want to use a quick search result, use the up- and down-arrows on your keyboard and press enter or use your mouse to select the item.
   - If the quick search results don’t have what you are looking for, press enter to run a search. Ensure that no items in the dropdown are selected when you press enter.
3. The Quick Search results page will be displayed. You can filter your results further, as described in Filtering Quick Search Results below.
   Results are sorted by relevance and boosted if they were edited recently. A maximum of 10 results are displayed per page.
   - If you have integrated your Crucible instance with a JIRA instance, you can display a summary of any JIRA issues referenced in your search results by hovering over the issue key. For more details, see JIRA integration in Crucible.
4. If you want to run another search, enter your new criteria in the main search box or in the search box in the header.
Note, only the search box in the header provides “quick nav” results.

Screenshot: Quick Search displaying “quick nav” matches

Refining your Quick Search Criteria

You can refine your search criteria before executing the search:

<table>
<thead>
<tr>
<th>Search Tool</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field Handles</strong></td>
<td>Use a field handle in your criteria to restrict your search to a particular field. Note, you cannot have multiple field handles in a query.</td>
<td>Enter &quot;detail&quot; — Search against title, objective, key, linked reviews, and linked issues. Enter &quot;reviewcomment&quot; — Search against review comments.</td>
</tr>
<tr>
<td><strong>Searching for Discrete Strings</strong></td>
<td>Enter a specific string within quotation marks and Crucible will match against the exact string. Note, this search is not case-sensitive.</td>
<td>Enter &quot;CR-2818&quot; and Crucible will only return results that match that exact string, i.e. it will not return a result with CR-FE-2818 or CR-28189.</td>
</tr>
</tbody>
</table>

Filtering Quick Search Results

You can filter Quick Search results using the controls in the left panel of the Quick Search page:

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>All repositories</strong></td>
<td>Type a repository name into the field, or click the down arrow to see list of repositories.</td>
</tr>
</tbody>
</table>
Source type | Click Files and directories, Commit messages, Diffs, Content or Committers to restrict the search results to just that source type.
---|---
All projects | Select or enter the name of the project that you want to restrict your results to. For example, if you enter 'CR' then the search results page will refresh to display only reviews in the 'CR' project.
⚠️ If you are using FishEye with Crucible, there will be a repositories dropdown in the ‘Source’ section. Selecting a FishEye repository in this dropdown will not filter the Crucible search results. It is only used to filter files and changesets returned in the search results. See Searching FishEye.
Reviews | Click this link to restrict your results to reviews that have a title, objective, key, linked reviews or linked issues that match the search criteria.
Comments | Click this link to restrict your results to reviews that have comments that match the search criteria.
Last modified | Filter by the date of the last change.
By | Filter by author name.

Filtering reviews
Crucible allows you to view all the reviews/snippets that you are involved with, as well as everybody's reviews/snippets. You can filter these lists to find reviews.

To filter a list of reviews:
1. Click Reviews in the header.
2. Click the list of reviews that you want to start with, in the sidebar of the 'Review Dashboard', e.g. 'All Open Reviews'.
3. Click Custom Filter in the reviews sidebar.
4. Update the filters with your search criteria (see table below) and then click Apply Filter.

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Find reviews by searching for words within the title.</td>
</tr>
<tr>
<td>Project</td>
<td>Find reviews under a particular project.</td>
</tr>
<tr>
<td>Author</td>
<td>Find reviews moderated by a particular authors.</td>
</tr>
<tr>
<td>Moderator</td>
<td>Find reviews moderated by a particular moderators.</td>
</tr>
<tr>
<td>Creator</td>
<td>Find reviews created by a particular creator.</td>
</tr>
<tr>
<td>Reviewer</td>
<td>Find reviews that are reviewed by a particular reviewer. This will default to the user logged in.</td>
</tr>
<tr>
<td>Reviewer Status</td>
<td>This is reliant on the above filter and is used to show reviews that have either been completed by the reviewer, not completed or all reviews.</td>
</tr>
<tr>
<td>Type</td>
<td>Choose either Review or Snippet.</td>
</tr>
<tr>
<td>Match Roles</td>
<td>To use all the above filters, choose all. To use any of the filters, choose any.</td>
</tr>
<tr>
<td>Review state checkboxes</td>
<td>Check any of the review state checkboxes (e.g. Draft, Pending Approval) to filter for reviews in those states.</td>
</tr>
</tbody>
</table>

Searching for Review Comments
To search for review comments:

1. Click **Reviews** in the header.
2. Enter your search string in the 'Comment Search' section at the bottom of the reviews sidebar.
3. Click **Search Comments**.
4. The 'Comment Search' page will display your results. You can refine your search using the search criteria on the page:

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Project</strong></td>
<td>Find comments on reviews under a particular project.</td>
</tr>
<tr>
<td><strong>Comment content</strong></td>
<td>Find comments that contain the specified text.</td>
</tr>
<tr>
<td><strong>Review Permalink</strong></td>
<td>Find comments made on the specified review.</td>
</tr>
<tr>
<td><strong>After</strong></td>
<td>Find comments made after a particular date.</td>
</tr>
<tr>
<td><strong>Before</strong></td>
<td>Find comments made before a particular date.</td>
</tr>
<tr>
<td><strong>Comment Author</strong></td>
<td>Find comments made by a particular user.</td>
</tr>
<tr>
<td><strong>Search Type</strong></td>
<td>Filter for comments marked as <strong>Defects</strong>. Check <strong>Comments</strong> to find comments that are not flagged as <strong>Defects</strong>.</td>
</tr>
<tr>
<td><strong>Review State</strong></td>
<td>Find comments on reviews that are in a particular state. See <strong>Review State Filter</strong> (above).</td>
</tr>
<tr>
<td><strong>Ranking</strong></td>
<td>Find defects have been given a particular ranking (e.g. 'Major', 'Minor').</td>
</tr>
<tr>
<td><strong>Ranking</strong></td>
<td>Find defects have been given a particular ranking (e.g. 'Major', 'Minor').</td>
</tr>
</tbody>
</table>

*Screenshot: Search Comment Filter Options*
Displaying Defect Metric Charts for Comment Search Results

Once you have retrieved results for a review comment search, you can click Defect Metrics in the left navigation pane to display defect classification charts.

Screenshot: Comment Search Results
JIRA integration in Crucible

When Crucible is integrated with JIRA Software, you and your team get all the benefits described on this page:

In Crucible, you can:

- See all the Crucible reviews related to a JIRA Software issue
- Create a Crucible review directly from an issue in JIRA Software
- Link your Crucible review to a JIRA Software issue
- Create a JIRA Software issue from a review comment
- Transition JIRA Software issues automatically
- Transition JIRA Software issues from within Crucible
- See issues from multiple instances of JIRA Software
- See open reviews or unreviewed commits for an entire version within JIRA Software

Related pages:

- Creating a review from JIRA
- Creating JIRA issues from the review
- Transitioning JIRA issues
- Linking Crucible to JIRA

Note that your Crucible and JIRA Software instances must be linked to make use of these JIRA Software integration features. See Linking Crucible to JIRA.

Check development progress of a version in JIRA Software

The Release Hub in JIRA Software shows the relevant issues and development information for a version – so you can determine which issues are likely to ship at a glance. With JIRA Software and Bitbucket Server connected, the release page can warn you about open reviews or unreviewed commits that could cause
problems for your release.

From the Release Hub you can also:

- Release a version
- Mark a version as complete
- Move incomplete issues to other versions
- Trigger release builds (if JIRA Software is connected to Bamboo)
- Warnings that help you reconcile what is happening in development with JIRA data.

To view the Release Hub (with the project sidebar enabled), navigate to a project, click on Releases, then select a version listed. See Checking the progress of a version more detailed information about using the Release Hub in JIRA Software.

See all the Crucible reviews related to a JIRA Software issue

In a JIRA Software issue, the Development panel shows the number of reviews that are linked to the issue. Click the reviews link to see details of those reviews.

Link your Crucible review to a JIRA Software issue

When creating, or editing, your review, Crucible will suggest a JIRA Software issue that can be linked to the review, if a JIRA Software issue key is found in the review title. You can:

- click the suggested JIRA Software issue key, to link it to the review
- delete the suggested JIRA Software issue and specify a different issue key and click Link to save it.
Create a JIRA Software issue from a review comment

When viewing any review comment (general, file, inline), you can click Create Issue in the comment to create a JIRA Software issue. Crucible suggests the JIRA Software instance, project and issue type, but you can modify these. This requires JIRA 5.0, or later, and is disabled if Crucible is integrated with an earlier version of JIRA Software.

See Creating JIRA issues from the review for more details.

Transition JIRA Software issues automatically

Your JIRA Software workflow can now respond to events in your linked development tools, for when a review is started, your JIRA Software workflow can be configured to automatically transition the related issue.
Configure this from transitions within the JIRA Software workflow editor. (Available with JIRA 6.3.3 and later.)

The events available in Crucible are:

- Review started
- Submitted for approval
- Review rejected
- Review abandoned
- Review closed
- Review summarized

**Transition JIRA Software issues from within Crucible manually**

For Crucible reviews that have linked JIRA Software issues, you can advance the JIRA Software workflow for the issue from within Crucible. You can do this at any time by clicking the linked issue, or when you close the review:

See [Transitioning JIRA issues](#) for more details.

See issues from multiple instances of JIRA Software
Crucible can link to more than one JIRA Software server at a time, so different teams can work with their own projects in different JIRA Software instances, or a single team can link to issues across multiple JIRA Software servers.

**Creating JIRA issues from the review**

From any review comment (general, file, inline) in Crucible, you can create a JIRA Software issue directly from the comment. This requires that Crucible is integrated with JIRA, version 5.0 or later, and is disabled if you have an earlier version of JIRA Software.

Inline issue creation allows:

- Tracking of the status of the comment
- A faster way to pull out incidental suggestions raised in reviews as JIRA Software issues
- A quick link back to the comment from the JIRA Software issue, using Remote Issue Links.

You might find this useful when:

1. Tracking the status of a review:
   - The 'Issues Raised from Comments' section in the review shows the open/closed status of related issues.
   - Raising related issues enforces dealing with subtasks before the review can be closed.
2. Closing off a review:
   - You can create JIRA Software issues, unrelated to the current review, to track matters to be dealt with later.

**Creating a JIRA Software issue**

To create a JIRA Software issue from a review, click Create Issue in an existing comment. Note that you need the 'Comment' permission in Crucible to see the Create Issue link.

Crucible suggests a JIRA Software instance, project and issue type, but you can choose from the available options. You can choose Sub-task from the JIRA Issue Type list if a JIRA issue is already linked to the review.

Crucible only displays required fields for the issue type; these can be configured in JIRA Software by your administrator.
Once the issue is created, the comment displays a link to the issue in JIRA Software, and in JIRA Software, the issue displays a link back to the comment in Crucible. The 'Issues raised from comments' section of the review displays links to the JIRA Software issues.

See also Creating a review from JIRA.

Transitioning JIRA issues

When Crucible is linked to JIRA Software, you can advance the workflow for a JIRA Software issue directly from within Crucible.

You can transition a JIRA Software issue in two ways:

- Transitioning any JIRA Software issue at any time
- Transitioning a linked JIRA Software issue when closing the review

### Related pages:

- JIRA integration in Crucible
- Creating JIRA issues from the review
- Linking Crucible to JIRA

Transitioning any JIRA Software issue at any time

You can easily transition a JIRA Software issue at any time from within Crucible. Click on a JIRA Software issue link anywhere in Crucible to see a dialog with the available workflow steps:

Click on a step in the dialog, and complete any displayed fields as required. If there are custom required fields that are unsupported by Crucible, just click Edit this field in JIRA to transition the issue directly in JIRA Software.
**Transitioning a linked JIRA Software issue when closing the review**

When closing a Crucible review you may also want to close a JIRA Software issue that is linked to that review.

In the Review Summary screen, click **Close** near the top right. In the 'Closed' dialog, the available workflow transitions for the linked JIRA Software issue appear in the **Transition issue** dropdown:

- **CR-FE-6163 Closed**
  - **Linked issue**
    - Issue: 💡 **FECRU-1401** — Add a review action in the UI to send manual reminder...
    - Status: ⚙️ To be reviewed
    - Transition issue: ✅ Close
    - Log work: ☑️ Submit 43m

Choose a step from the dropdown, and click **Close**.

**Notes**
- Only the transitions accessible by the user are displayed.
- The list of available transitions only appears if the user has visibility to any available workflow transitions.
- Crucible administrators can turn off JIRA Software issue transitioning by disabling the Crucible Issue Transitioning Plugin. See [Managing add-ons](#).

ℹ️ This feature does not support editing fields on the issue, only setting the **resolution** field if required by the transition.

**Administering Crucible**

The Admin area allows you to administer your Crucible instance and to manage your repositories, users and back-end settings.

Once Crucible is **installed** and running, you can log in to the Admin area by either:

- logging in with an administrator’s account.
- clicking **Administration** at the foot of the page.
- navigating to **http://HOSTNAME:8060/admin/**, where **HOSTNAME** is the name of the server on which you installed Crucible.

Once logged in as an administrator you can get to the Admin area by clicking the 'cog' menu in the FishEye/Crucible header, and choosing **Administration**.

For information on administering FishEye, please refer to the [FishEye documentation](#).

**Topics**

- [Best practices for Crucible configuration](#)
- [Crucible and FishEye](#)
- [Administering projects](#)
- [Configuring repositories](#)
- [Setting up users and security](#)
- [Permissions](#)
- [Migrating to an external database](#)
- [Backing up and restoring Crucible data](#)
- [Customizing Crucible](#)
- [Linking Crucible to JIRA](#)
- [Linking to another application](#)
Best practices for Crucible configuration

1. **Set up a separate FISHEYE_INST folder location on the same system for Crucible’s data.**
   
   This will allow for easy upgrades of the core program and neatly separated data backup.

2. **Run Crucible on a dedicated machine, accessing its data on the local file system.**
   
   This is the best environment for swift Crucible performance. Avoid running Crucible in a virtual environment.

3. **Do not give Crucible projects the same key as your JIRA projects.**
   
   When naming projects, take care to ensure that the key you assign to them is not the same as any of your JIRA projects. The reason for this is, if one of your Crucible projects has the same key as one of your projects in JIRA, then all links with that key will lead back to Crucible, rather than leading to JIRA, removing the ability to navigate between the two applications.

   To avoid this, name your Crucible project keys differently. For example, you could place the following text at the beginning of each project key: `CR-` to distinguish it. So, for this case, if you have an existing JIRA key of `RHUBARB`, you would create a Crucible key called `CR-RHUBARB` so that they do not conflict.

4. **Do not use the built-in HSQLDB database for production use.**
   
   The Crucible built-in database, running HSQLDB is somewhat susceptible to data loss during system crashes. We recommend that you do not use HSQLDB for production systems. External databases are generally more resistant to data loss during a system crash and are more suited for production use.

   To see a list of external databases that Crucible supports, see the Supported platforms page. For information on how to set up an external database, see the Crucible Database documentation.

**Crucible and FishEye**

This page gives an overview of the joint installation of Crucible and FishEye. Both Crucible and FishEye are Atlassian products.

- **FishEye** allows you to extract information from your source code repository and display it in sophisticated reports.
- **Crucible** allows you to request, perform and manage code reviews.
- Both of these products can run in isolation. If you are using Subversion, Git, Mercurial, CVS or Perforce you can significantly enhance your Crucible experience by also using FishEye.
  - See What happens if I decide to stop using FishEye with Crucible?

**Your Crucible installation package includes the files required for FishEye**

If you use FishEye and Crucible together, they run as one instance.

You’ll need the same number of (or more) users in FishEye as Crucible.

**Purchasing and installing Crucible and FishEye**

- Upgrading an existing Crucible installation to also use FishEye only requires a simple license change in the admin area.
- Upgrading an existing FishEye installation to also use Crucible only requires a simple license change in the admin area.
- See Upgrading from FishEye to Crucible.

**The <Crucible home directory> and FISHEYE_INST**

Throughout the Crucible documentation, references are made to the `<Crucible home directory>`, which refers to the location of the Crucible application. Be aware that, when Crucible is run with FishEye, this location...
is equivalent to the location referred to by `<FishEye home directory>` in the FishEye documentation. Crucible also makes use of this FishEye environment variable:

- FISHEYE_INST – the location of the FishEye data.

Refer to the FishEye documentation for more about the environment variables.

**Installing the Crucible binary files**

See the following for Crucible install instructions:

- Installing Crucible on Windows
- Installing Crucible on Linux and Mac

**Setting up a repository for use with stand-alone Crucible**

For complete instructions, see Configuring repositories.

**Setting up a repository for use with FishEye and Crucible**

If you intend to use Crucible and FishEye with:

- Subversion, please read Supported platforms, Subversion client setup, and granting permission to FishEye to scan your repository.
- Git, please read Supported platforms and Git Client setup.
- Perforce, please read Supported platforms and Perforce Client setup.
- CVS, please read Supported platforms and CVS Client setup.
- Mercurial, please read Supported platforms and Mercurial Client setup.

**Read more**

You can find more information in:

- Crucible Getting Started
- FishEye Getting started

**Administering projects**

A Crucible project provides a way to group and manage related reviews – typically reviews that are all involved with the same software project. A Crucible project allows you to

- define default moderators, authors and reviewers for the reviews in that project.
- define which people are eligible to be reviewers for the reviews in that project.
- use permission schemes to restrict who can perform particular actions (e.g. 'Create Review') in that project.

Every Crucible review belongs to a project. Each project has a name (e.g. ACME Development) and a key (e.g. ACME). The project key becomes the first part of that project’s review keys, e.g. ACME-101, ACME-102, etc.

By default, Crucible contains one project. This default project has the key 'CR' and the name 'Default Project'.

When administering your Crucible projects from the projects listing in the admin area, you can:

- Click Add a new project (at the top-right corner) to create a new project.
- Choose Crucible settings from the three-dots menu (in the ‘Actions’ column) for a project, to edit its settings.
- Click the bin icon for an existing project to delete it. See Deleting a project below.

**Deleting a project**
Before you begin:

- By default, Crucible contains one project; it has the key ‘CR’ and the name ‘Default Project’. This project cannot be deleted.
- Deleted projects cannot be recovered.

To delete a Crucible project:

1. Go to the admin area and click Projects (under ‘Project Settings’).
2. Click the bin icon (in the ‘Actions’ column) for the project you wish to remove.
   - You’ll be prompted to confirm the deletion.
   - If empty, the project disappears instantly.
   - If the project contains reviews, you will be prompted to either delete all the reviews in the project, or move them into the default project.

Creating a project

A Crucible project provides a way to group and manage related reviews – typically reviews that are all involved with the same software project. A Crucible project allows you to

- define default moderators, authors and reviewers for the reviews in that project.
- define which people are eligible to be reviewers for the reviews in that project.
- use permission schemes to restrict who can perform particular actions (e.g. ‘Create Review’) in that project.

Every Crucible review belongs to a project. Each project has a name (e.g. ACME Development) and a key (e.g. ACME). The project key becomes the first part of that project's review keys, e.g. ACME-101, ACME-102, etc:

By default, Crucible contains one project. This default project has the key ‘CR’ and the name ‘Default Project’.

To create a new project:

1. Click the ‘cog’ menu in the Crucible header, and choose Administration. You need to be logged in as an administrator to see this.
2. Click Projects (under ‘Project Settings’).
3. Click Add a new project (at the top-right corner).
4. Complete the fields in the ‘Edit Project’ page (described below).
5. Click Save to create your new project.

<table>
<thead>
<tr>
<th>Identification</th>
<th>Name – the plain language name as displayed in the Crucible interface.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Key – the project key used when giving reviews their unique code names. If you change the key for a project all open, and closed, reviews in the project are updated with the new key.</td>
</tr>
<tr>
<td>Content</td>
<td>Default Repository – the repository that contains the source code for this project. This is the repository that will be searched by default when you add files to a review.</td>
</tr>
<tr>
<td></td>
<td>Store the contents of files in reviews – check to have the source files under review stored in the Crucible database, along with the comments and review data. This retains a copy of all the source files under review even if the repository is disconnected from Crucible. See Storing all revisions under review.</td>
</tr>
<tr>
<td>Permission Scheme</td>
<td>Permission Scheme – the permission scheme applied to this project. (A permission scheme controls who can perform particular actions, for example, create a review.)</td>
</tr>
<tr>
<td>Moderator</td>
<td>Enable the Moderator role – clear to have reviews run by the author only. See Enabling the moderator role.</td>
</tr>
<tr>
<td></td>
<td>Default Moderator – the user who will be set as the moderator for all new reviews created in the project. Leave this field blank to force the review’s creator to choose a moderator. See Creating a review.</td>
</tr>
<tr>
<td>Default Reviewers</td>
<td>By default, allow anyone to join reviews after creation – sets the default state of the All ow anyone to join checkbox on the ‘Choosing reviewers’ screen.</td>
</tr>
<tr>
<td></td>
<td>Users – set the individual users to whom new reviews will be assigned by default.</td>
</tr>
<tr>
<td></td>
<td>Groups – set the groups to which new reviews will be assigned by default.</td>
</tr>
<tr>
<td>Allowed Review Participants</td>
<td>Use <strong>Users</strong> and <strong>Groups</strong> to restrict who can have a role (author/creator/moderator/reviewer) in this project’s reviews. These users will be the only ones whose names appear when a review is <strong>assigned</strong>. Leave these fields blank to allow all users to have access.</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Review Duration</td>
<td><strong>Default duration</strong> – the default length of time (in week days) for reviews in this project. If you leave the field blank, then no time restriction is applied. Reviews that are overdue will show up in red on the reviewer’s dashboards. Note that the review duration only affects the default due date that appears when <strong>creating a review</strong>. The review’s <strong>creator</strong> or <strong>moderator</strong> can specify a different date if they wish.</td>
</tr>
<tr>
<td>Default Review Objectives</td>
<td><strong>Default objectives</strong> – specify some text that will appear by default in the <strong>Review objectives</strong> field of each new review. This text can be edited, as with any text in the Review Objectives text box. See <strong>Setting default review objectives</strong>.</td>
</tr>
</tbody>
</table>

### Edit Project

#### Identification

<table>
<thead>
<tr>
<th>Name</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Key</td>
<td></td>
</tr>
</tbody>
</table>

#### Content

**Default Repository**  
FE  
- [ ] Store the contents of files in reviews

#### Permissions scheme

**Permission scheme**  
default

#### Moderator

- [ ] Enable the Moderator role for this project

<table>
<thead>
<tr>
<th>Default moderator</th>
<th>Enter user name</th>
</tr>
</thead>
</table>

#### Default reviewers

- [ ] By default, allow anyone to join reviews after creation

<table>
<thead>
<tr>
<th>Users</th>
<th>Enter user name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Groups</td>
<td>Start typing a group name then press enter to select.</td>
</tr>
</tbody>
</table>

#### Allowed review participants

(Leave blank to let all users access this project)

<table>
<thead>
<tr>
<th>Users</th>
<th>Enter user name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Groups</td>
<td>Start typing a group name then press enter to select.</td>
</tr>
</tbody>
</table>
Storing all revisions under review

When creating a project or editing a project's properties, you can set Crucible to save all files (and revisions of those) associated with a review to Crucible's database. This allows you to be able to view that file content whether or not the repository is online or accessible to Crucible. It also creates an enhanced audit trail should you require it, saving the review content regardless of whether or not it is deleted or lost from the repository.

Note that:

- The storage of files must be set per-project. Also, the storage only applies to reviews created after Revision Storage is enabled. This means that for existing projects, pre-existing reviews will not have files stored unless you look at them again after Revision Storage is enabled.
- The underlying repository and file permissions are not preserved when files are stored with the review.

Enabling file storage

You can enable file revision storage on the 'Edit Project' page.

For an existing project:

1. Go to the admin area and click Projects (under 'Project Settings').
2. In the list of projects, click Crucible settings under the three-dots menu (in the 'Actions' column) for the required project.
3. Check Store the contents of files in reviews (under 'Content').
4. Click Save.

Enabling the moderator role

By default, Crucible projects do not have a moderator. This allows for a streamlined review handling process, where the review author is the sole person who starts and stops the review. However, you can enable the moderator role for Crucible projects, if required.

The moderator role can only be set by a Crucible administrator.

On this page:

- Enabling the moderator role
- Removing the moderator role from an existing project
- Adding the moderator role to an existing project
Enabling the moderator role

The moderator role is configurable in Crucible as a per-project setting. By default, all reviews have an author and a moderator. However, the moderator role can be disabled.

To enable or disable the moderator role on a project:

1. Go to the admin area in Crucible and click Projects (under 'Project Settings').
2. In the list of projects, click Crucible settings under the three-dots menu (in the 'Actions' column) for the required project.
3. Check Enable the Moderator role (under 'Moderator').

Removing the moderator role from an existing project

When you remove the moderator role from an existing project, note that:

- Existing reviews, created before the change, will still retain the moderator they were assigned.
- Reviews created after the change will not have the moderator role.
- If the removal of the moderator conflicts with other Crucible project settings, a warning will be shown on the Projects page.

If in doubt about the impact of removing the moderator role, you can create a new project, and set the moderator status while doing that.

Adding the moderator role to an existing project

If you add the moderator role to an existing project, note that:

- Existing reviews, created before the change, will still have no moderator.
- Reviews created after the change will have the moderator role added.
- If the addition of the moderator role conflicts with other Crucible project settings, a warning will be shown on the Project page.

If in doubt about the impact of adding the moderator role, you can create a new project, and set the moderator status while doing that.

Setting default review objectives

To set default review objectives for all the reviews in a given project:

1. Go to the admin area and click Projects (under 'Project Settings').
2. In the list of projects, click Crucible settings under the three-dots menu (in the 'Actions' column) for the required project.
3. In the Default objectives text box specify the text that will appear by default in the Review Objectives field of each new review. This text will be able to be edited, as with any text in the Review Objectives text box.
4. Click Save.

See Editing a project for more information about project defaults.
Editing a project

Once a project is created, an administrator can edit the default values for settings such as repository, moderator, allowed reviewers, allowed groups and permissions scheme. These are the settings that are applied to any new review created for the project.

To edit project settings:

1. In the admin area, click Projects (under ‘Project Settings’).
2. In the list of projects, click Crucible settings under the three-dots menu (in the 'Actions' column) for the required project.
3. Modify the available settings, as required:

| Identification | • Name – the plain language name as displayed in the Crucible interface.  
|                | • Key – the project key used when giving reviews their unique code names. If you change the key for a project all open, and closed, reviews in the project are updated with the new key. |
| Content        | • Default Repository – the repository that contains the source code for this project. This is the repository that will be searched by default when you add files to a review.  
|                | • Store the contents of files in reviews – check to have the source files under review stored in the Crucible database, along with the comments and review data. This retains a copy of all the source files under review even if the repository is disconnected from Crucible. See Storing all revisions under review. |
| Permission Scheme | Permission Scheme – the permission scheme applied to this project. (A permission scheme controls who can perform particular actions, for example, create a review.) |
| Moderator      | • Enable the Moderator role – clear to have reviews run by the author only. See Enabling the moderator role.  
|                | • Default Moderator – the user who will be set as the moderator for all new reviews created in the project. Leave this field blank to force the review's creator to choose a moderator. See Creating a review. |
| Default Reviewers | • By default, allow anyone to join reviews after creation – sets the default state of the Allow anyone to join checkbox on the 'Choosing reviewers' screen.  
|                | • Users – set the individual users to whom new reviews will be assigned by default.  
|                | • Groups – set the groups to which new reviews will be assigned by default. |
4. Add additional FishEye repositories to the project if required – click Edit in the 'FishEye content' column. See How to add several repositories to one project in Crucible for further information.
Configuring repositories

Crucible needs access to your source code before you can create any reviews. This page describes how you connect Crucible to a repository.

By the way, if you want to connect to a Git repository you’ll need to have Git installed on the Crucible server. See Installing and upgrading Git.

The instructions for configuring your repositories differ, depending on your Crucible setup:

If you are running Crucible with Atlassian’s FishEye, you can manage your repositories using FishEye. See the FishEye documentation for more information.

If you are running Crucible alone, you can manage your repositories using native repository access in Crucible:

1. Go to the Crucible admin area.
2. Click Repositories (under ‘Repository Settings’), and then Native Repository Access (if necessary).
3. Click Add Existing...
4. Refer to the following pages in the FishEye documentation for details about setting up particular repositories:
   - Bitbucket Server
   - CVS
   - Git
   - Mercurial
   - Perforce
   - Subversion

Please also see the What happens if I decide to stop using FishEye with Crucible page for important information about light FishEye.
Crucible SCM plugins superseded by Native Repository Access

Crucible now ships with native repository access, which allows you to connect to repositories without a working version of FishEye. Crucible SCM plugins will still work, but we recommend that you stop using them in favor of native repository access. See What happens if I decide to stop using FishEye with Crucible for instructions.

Setting up a Git repository in Crucible

This page describes how to use Crucible's native repository access to connect to a Git repository. The process for doing this depends on where the Git repository is hosted – connecting to a Git repo that is hosted in Bitbucket Server is much easier.

This native access uses a FishEye component (without requiring a FishEye license), which is why the description below refers to FishEye in places. See What happens if I decide to stop using FishEye with Crucible for more information.

Crucible interacts with Git repositories by executing the Git command in a separate process. Hence, the server running Crucible needs to have Git installed. Crucible indexes Git repositories by making a private, bare clone of your repository within Crucible's cache area. It uses this private clone for most Git operations. See Git manifest for more information about indexing Git repositories.

See the Supported platforms page for the version of Git that is required by the server running Crucible.

Git repositories hosted in Bitbucket Server

When Bitbucket Server is integrated with FishEye:

- You can easily add Git repositories to FishEye. The repository behaves just like a native repository in FishEye, so your team gets all the benefits of FishEye indexing, browsing and searching.
- The repository becomes available to Crucible (when integrated), so you can perform in-depth code reviews for changes in the repository.
- When you add a Bitbucket Server repository to FishEye, a push to the repository will by default automatically trigger FishEye to run an incremental index. No further configuration is required – you don't have to configure polling for new commits, or set up dedicated FishEye web hooks in your Bitbucket Server instance.
- You'll need to have an account in the Bitbucket Server instance, as well as permission to view the repository that you want to add.

1. Click the 'cog' menu in the FishEye header, and choose Administration (you'll need to be logged in as an administrator to see this link).
2. Click Repositories (under 'Repository Settings').
3. Click the Bitbucket Server repositories tab, and authenticate with Bitbucket Server if necessary.
4. If multiple instances of Bitbucket Server are connected to FishEye, use the Bitbucket server list to choose the instance of Bitbucket Server that hosts the repository you wish to add.
5. Optionally, type a filter pattern to restrict the list of displayed repositories to those with a matching name, key or project.
6. Click Add for each repository that you wish to add to FishEye.
7. If the name of repository conflicts with already existing one, you will be asked to specify a different name.

Starting with FishEye version 4.2, regular users granted the 'Can add repository' permission can add repositories using the Bitbucket Server repositories tab. Note that they can see only FishEye repositories they have admin permission for.

When adding new repositories, FishEye will prevent the creation of a repository using a name that already exists – FishEye will prompt you for an alternative name.
When you add a Bitbucket Server repository:

- FishEye creates a read-only SSH key and adds that as an access key to the repository in Bitbucket Server. If this operation fails, the key will be added as a user key to your profile in Bitbucket Server. You can check if an access key was added by viewing the repository's settings in Bitbucket Server. See Using SSH keys to secure Git operations in the Bitbucket Server documentation for more information.

Git repositories hosted elsewhere

When adding or managing a Git repository, you can do the following:

- Define repository details, as described below.
- Set FishEye's repository options.

To add an external Git repository to FishEye:

1. Click the 'cog' menu in the FishEye header, and choose Administration (you'll need to be logged in as an administrator to see this link).
2. Click Repositories (under 'Repository Settings').
3. Click Native repository access, and then Add repository.
4. Complete the wizard:

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Repository Type</td>
<td>Select Git.</td>
</tr>
<tr>
<td></td>
<td>Display Name</td>
<td>A name for this repository. The name may contain alphanumeric, underscore, '-' or '.' characters and its length must not exceed 100 characters.</td>
</tr>
<tr>
<td></td>
<td>Note that a repository name is different from its key. See Renaming a repository for details.</td>
<td></td>
</tr>
</tbody>
</table>

| Description  | Enter a short description of this repository. |

<table>
<thead>
<tr>
<th>Step 2</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
</tbody>
</table>
| Repository Location   | Enter the URL describing the Git repository location. FishEye will clone this repository for indexing purposes. You can use any URL recognized by Git itself. FishEye recognizes the following URL’s:  
git://server_name[:port]/path_to_repository  
http://server_name[:port]/path_to_repository  
https://server_name[:port]/path_to_repository  
ssh://server_name[:port]/path_to_repository  
file://[hostname]/path_to_repository  
Do not use spaces in your URL. |
| Path                  | *(optional)* Enter the path within the Git repository that you want FishEye to index. This lets you limit FishEye to indexing a subset of the complete Git repository. |
| Authentication Style  | Choose the desired authentication style for your repository — No authentication, Generate key pair for SSH, Upload private key for SSH or Password for http(s). Please refer to Authentication for more information. |
| Block Size            | *(optional)* Enter how many commits you want FishEye to process in one batch. Larger values require more memory and increase the amount of work FishEye commits to the database in a single operation. The default is 400. The minimum being 1. This field only accepts positive whole numbers. Requires a repository restart. |
| Command Timeout       | *(optional)* Enter the time that a single Git command is allowed to take to execute. Any command that exceeds this time is terminated and the operation will fail. |
| Rename Detection      | *(optional)* Select which Git rename detection strategy FishEye will use to detect copy and move operations within the repository. Please refer to the Git documentation for more information. |

**Step 3**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Store Diff Info</td>
<td>Check this if you want FishEye to cache information about file diffs in its database. This is required for some FishEye features. See Configuring Repository Details for more information on this setting.</td>
</tr>
<tr>
<td>Enable Repository</td>
<td>Check this to enable the repository after adding (i.e. when you click the Add button).</td>
</tr>
<tr>
<td>After Adding</td>
<td></td>
</tr>
</tbody>
</table>

**Limitations**

Indexing of a Git repository can be slow when new branches are pushed. Performance in such cases can be improved by setting a command line option for FishEye. See this KB page for more information.

**Setting up a Perforce repository in Crucible alone**

This page describes how to configure Crucible access to Perforce repositories.

**Crucible SCM plugins superseded by Native Repository Access**

Crucible now ships with native repository access, which allows you to connect to repositories without having FishEye integrated with your Crucible instance. Crucible SCM plugins will still work, but we recommend that you stop using them in favor of native repository access. See What happens if I decide to stop using FishEye with Crucible for instructions.
Setting up a Perforce repository using native access

To set up native access to a Perforce repository:

1. Go to the Crucible admin area.
2. Click Repositories (under 'Repository Settings'), and then Native Repository Access (if necessary).
3. Click Add Existing...
4. Refer to Perforce in the FishEye documentation for detailed information about completing the wizard.

Setting up the Crucible Perforce SCM plugin

This section describes how to configure the Crucible Perforce SCM plugin to access Perforce repositories.

To set up Perforce in Crucible alone:

1. Ensure that the Perforce executable file is on the system path, in the Crucible server's Environment Variables
2. Start Crucible and go to the admin area.
3. Click Manage Add-ons (under 'Systems Settings').
4. Find and click on the Crucible Perforce SCM Plugin (click Show System Plugins) and then click Configure.
5. Click Add a repository and complete the form:

<table>
<thead>
<tr>
<th>Name</th>
<th>Choose a unique name for the repository.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Repository Server</td>
<td>Enter the base URL and port for the repository, for example: example.com:666.</td>
</tr>
<tr>
<td>Repository Path</td>
<td>Add the path to your Perforce repository. For example: //depot/code/example/main.</td>
</tr>
<tr>
<td>Perforce Username</td>
<td>Enter the username of the Perforce account that Crucible will use. (optional)</td>
</tr>
<tr>
<td>Perforce Password</td>
<td>Enter the password of the Perforce account that Crucible will use. (optional)</td>
</tr>
<tr>
<td>Note</td>
<td>Note that this account should only have read-only access to the repository.</td>
</tr>
</tbody>
</table>

6. Click Save.

Your Perforce repository is now set up for Crucible. You will be able to select changesets from it when creating reviews.

Notes

- There is no 'initial scanning' required in this process, as Crucible's access to Perforce (when running alone) is strictly on-demand. Data is not indexed, hence there is no scanning.
- Crucible executes the Perforce command-line tool to enable this functionality.

Setting up a Subversion repository in Crucible alone

This page describes how to configure Crucible access to Subversion repositories.

Setting up a Subversion repository using native access

To set up native access to a Subversion repository:

1. Go to the Crucible admin area.
2. Click Repositories (under 'Repository Settings'), and then Native Repository Access (if necessary).
3. Click Add Existing...
4. Refer to Subversion in the FishEye documentation for detailed information about completing the wizard.
Setting up the Crucible Subversion SCM plugin

This section describes how to configure the Crucible Subversion SCM plugin to access Subversion repositories. The plugin is bundled with Crucible.

**To set up Subversion in Crucible alone:**

1. Start Crucible and go to the **admin area**.
2. Click **Manage Add-ons** (under 'Systems Settings').
3. Find and click on **Crucible Subversion SCM Plugin** (click **Show System Add-ons**) and then click **Configure**.
4. Click **Add a repository** and complete the form:

<table>
<thead>
<tr>
<th>Name</th>
<th>Choose a unique name for the repository.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Repository Root</td>
<td>Enter the repository root URL for the repository. See Finding your repository root below for instructions on how to find this.</td>
</tr>
<tr>
<td>Repository Path</td>
<td>Add the path on the base URL where your repository. For example, if you used the root URL above, and the full path to your Subversion instance is '<a href="http://svn.example.com/svn5/">http://svn.example.com/svn5/</a>', you would enter 'svn5' into this field.</td>
</tr>
<tr>
<td>SVN Username</td>
<td>Enter the username of the Subversion account that Crucible will use. Note that this account should only have read-only access to the repository.</td>
</tr>
<tr>
<td>SVN Password</td>
<td>Enter the password of the Subversion account that Crucible will use.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

Your Subversion repository is now set up for Crucible. You will be able to select changesets from it when creating reviews.

Note that there is no 'initial scanning' required in this process, as Crucible’s access to Subversion (when running alone) is strictly on-demand. Data is not cached, hence scanning is not required.

**Finding your repository root**

Run the following command:

```
svn info SVN_URL
```

where SVN_URL is the complete URL of the repository you want to add.

You will get something like the following:

```
>svn info http://svn.example.com/svn5/
Path: svn5
URL: http://svn.example.com/svn5/
Repository Root: http://svn.example.com/
Repository UUID: ce062a09-193b-427a-a7b3-a85007076e5d
Revision: 83
Node Kind: directory
Last Changed Author: ryan
Last Changed Rev: 83
Last Changed Date: 2009-05-07 10:48:41 +1000 (Thu, 07 May 2009)
```

Next to "Repository Root" is the URL you should define as your repository root. The path will be whatever is
Enabling reviews from the server file system in Crucible

You can set up the server file system to be a code repository for Crucible. You will be able to browse files and directories on the hard drive and select files from it when creating reviews.

To set up the file system as a code repository in stand-alone Crucible:

1. Go to the admin area in Crucible.
2. Click Manage Add-ons (under ‘Systems Settings’).
3. Find and click on Crucible FileSystem SCM Plugin (click Show System Plugins, then click Enable if that is displayed).
4. Click Configure then Add a repository.
5. Complete the form:
   - Name: Choose a unique name for the repository.
   - Base Path: Choose the lowest level of directory that Crucible will access.
6. Click Save.

Setting up a repository via FishEye

To use FishEye to access an external source control repository, such as Subversion or Git, for Crucible, see the FishEye documentation for how to add a repository.

- CVS
- Git
- Mercurial
- Perforce
- Subversion

**Building index and cache**

FishEye needs to build an index and cache of the contents of your repository, so some information will not appear in FishEye until this is complete. This may take some time to complete, depending on the size of the repositories.

ℹ️ We recommend you access the repository with a user that has only read access to the repository.

Configuring commit hooks

The incremental indexing process causes Crucible to poll all repositories at the specified interval to check for new commits, even though there might not be any new information to index. If you have a large number of repositories (> 100), this can lead to:

- A time lag between a commit being made and it appearing in Crucible.
- A high load on the Crucible server, and on the SCM.

Commit hooks allow you to set up your SCM so that indexing of a repository is triggered by a commit to the repository itself. This means that Crucible only runs the indexing process when necessary, and allows automatic polling to be disabled. Commits will appear sooner in Crucible, and the server load will be reduced.

To set up commit hooks you:

1. Set the REST API token in FishEye or Crucible. See the FishEye-Crucible REST API developer documentation.
2. Integrate the commit hook with your SCM.

On this page:

- Triggering scanning remotely
- Integrating with your SCM
  - Bitbucket and GitHub
Triggering scanning remotely

Once you've set your REST API token you can use it to trigger scanning when your repository is updated.

The basic way to do this is set up a shell script similar to:

```
echo Triggerring scan
/usr/bin/curl -X POST -H "X-Api-Key: <YOUR-API-KEY-HERE>"
<URL><PORT><optional CONTEXT>/rest-service-fecru/admin/repositories-v1/<REPOSITORY-NAME>/scan
```

**e.g.**

```
echo Triggerring scan
/usr/bin/curl -X POST -H "X-Api-Key: abcdefg123456"
http://atlas:8060/fecru/rest-service-fecru/admin/repositories-v1/widget/scan
```

Try running the script; if everything is fine, it will output "[]", and will trigger scanning in Crucible. If there are problems, curl will show an appropriate message.

If you're running on Windows, you'll need curl or a similar program. You can download the Windows version of curl [here](#). You'll need to save the script as a batch file (with the .bat extension).

**Note:** be sure to specify the full path to the curl binary on your system.

Integrating with your SCM

**Bitbucket and GitHub**

Both of these hosting services provide service hooks that can be used to trigger repository indexing in Crucible.

**Bitbucket**

In Bitbucket, go to the admin page for your repository, click **Hooks** and choose **FishEye**.

See the [Bitbucket documentation](#) for more information about setting up a Bitbucket service hook.

**GitHub**

In GitHub, go to the admin page for your repository, click **Service Hooks** and choose **FishEye** from the available hooks.

**CVS**

1. Checkout the CVSROOT module of your cvs repository:

   ```
cvs co CVSROOT
   ```

2. Edit the CVSROOT/loginfo file.
3. Add the following line to the file:

```
ALL /usr/bin/curl -X POST -H "X-Api-Key: <YOUR-API-KEY-HERE>" -m 20
<URL>:/optional
CONTEXT>/rest-service-fecru/admin/repositories-v1/<CVS-REPOSITORY-NAME>/scan > /dev/null 2>&1 &
```

e.g.
```
ALL /usr/bin/curl -X POST -H "X-Api-Key: abcdefg123456"
http://atlas:8060/fecru/rest-service-fecru/admin/repositories-v1/cvs_widget/scan > /dev/null 2>&1 &
```

4. Commit your changes:
```
cvs commit CVSROOT/loginfo
```

**SVN**

1. Log into your svn server, go to the repository directory, find the hooks subdirectory there:

```
cd /var/www/svn/hooks
```

2. If it doesn’t exist, create a new file called `post-commit` (or `post-commit.bat` on Windows), make sure it’s executable by the user that the svn process runs as:

```
touch ./post-commit
chmod 755 ./post-commit
```

3. Make sure the file starts with the following shebang line, pointing to your shell:

```
#!/bin/sh
```

4. Add the following to the `post-commit` file:

```
/usr/bin/curl -X POST -H "X-Api-Key: <YOUR-API-KEY-HERE>" -m 20
<URL>:/optional
CONTEXT>/rest-service-fecru/admin/repositories-v1/<SVN-REPOSITORY-NAME>/scan > /dev/null 2>&1 &
```

e.g.
```
/usr/bin/curl -X POST -H "X-Api-Key: abcdefg123456"
http://atlas:8060/fecru/rest-service-fecru/admin/repositories-v1/svn_widget/scan > /dev/null 2>&1 &
```

You can find more details about svn hooks [here](#).
Perforce

1. As a Perforce administrator execute the following command:

   p4 triggers

2. The trigger table form will be presented.
3. Add a field value for the field 'Triggers', named trigger-X, where X is the next number available for the trigger:

   trigger-04 change-commit //... "usr/bin/curl -s -o /dev/null -X
   POST -H X-Api-Key:<YOUR-API-KEY-HERE> -m 20 <URL>:<PORT></optional
   CONTEXT>/rest-service-fecru/admin/repositories-v1/<PERFORCE-REPOSITORY-NAME>/scan

   e.g.

   trigger-04 change-commit //... "usr/bin/curl -s -o /dev/null -X
   POST -H "X-Api-Key: abcdefg123456"
   http://atlas:8060/fecru/rest-service-fecru/admin/repositories-v1/perforce_widget/scan

4. You can customize the trigger to run only for a specific depot or directory, by replacing the //... above (which causes the trigger to be executed for every file) by a standard Perforce file pattern syntax. You can find more details about Perforce triggers in the Perforce System Administrator's guide.

Git

1. Choose the repository you want to trigger the scans from. Usually this is the repository that all of your developers push to, and that you run CI from. Note that hooks are not propagated when cloning repositories.
2. Go to the hooks subdirectory of your repository:

   cd /var/www/git/project/hooks

3. If it doesn't exist, create a new file called post-receive. Make sure it's executable by the Git server process.

   touch ./post-receive
   chmod 755 ./post-receive

4. Make sure the file starts with the following line, pointing to your shell:

   #!/bin/sh

5. Add the following to the post-receive file:
/usr/bin/curl -X POST -H "X-API-Key: <YOUR-API-KEY-HERE>" -m 20 <URL>:<PORT>/optional CONTEXT>/rest-service-fecru/admin/repositories-v1/<GIT-REPOSITORY-NAME>/scan > /dev/null 2>&1 &

e.g.


**NOTE:** Not all methods of serving a Git repository support commit hooks - if serving over http, you need to use smart-http (either using git-httpd-backend or a dedicated repository manager like gitolite). You can find more information about smart http [here](#). Serving the repository over ssh or git-daemon should allow you to run commit hooks as well.

**Mercurial**

1. Choose the repository you want to trigger the scans from. Usually this is the repository that all of your developers push to, and that you run CI from. Note that hooks are not propagated when cloning repositories.

2. Go to the `.hg` subdirectory of your repository:

   ```
cd /var/www/hg/project/.hg
   ```

3. If it doesn't exist create a file named `.hgrc`:

   ```
touch ./hgrc
   ```

4. Add the following to the `.hgrc` file:

   ```
[hooks]
changegroup = /usr/bin/curl -X POST -H "X-API-Key: <YOUR-API-KEY-HERE>" -m 20 <URL>:<PORT>/optional CONTEXT>/rest-service-fecru/admin/repositories-v1/<HG-REPOSITORY-NAME>/scan > /dev/null 2>&1 &
   ```

   e.g.

   ```
[hooks]
   ```

**NOTE:** Not all methods of serving a Mercurial repository support commit hooks - if serving over http, you can't use static-http serving.
Decreasing polling frequency

Once your commit hook is set up and successfully notifying Crucible about new commits to your repository, you can decrease the polling frequency on your repository (for example to 1 or 2 hours, instead of the default 1 minute).

With commit hooks configured, scheduled polling is only useful if the hook fails, for example because of connectivity issues to the server hosting Crucible. This will decrease the server load, but allow Crucible to still occasionally check for changes, and update the repository if needed. Note that after changing the polling frequency, Crucible will need to be restarted.

```
trigger-04 change-commit //... 
"/usr/bin/curl -s -o /dev/null -X POST -H 
X-Api-Key:YOUR-API-KEY-HERE -m 20 
http://SERVER:PORT/CONTEXT/rest-service-fecru/admin/repositories-v1/PERF 
ORCE-REPOSITORY-NAME/scan
```

Setting up users and security

User management and security settings are described in the FishEye documentation. See:

- Managing users and groups in FishEye
- External user directories
- Configuring external authentication sources
- Configuring FishEye security

Other related security resources

- Configuring user managed mappings
- Creating a permission scheme

Permissions

A permission is the ability to perform a particular action in Crucible, e.g. 'Create Review'. Permissions in Crucible are managing through the use of permission schemes.

A permission scheme assigns particular permissions to any or all of the following:

- Particular Users.
- Particular Groups.
- All logged-in users.
- Anonymous Users
- People in particular Review Roles, such as:
  - Author
  - reviewer
  - creator
  - moderator

The scheme's permissions will apply to all reviews belonging to the project(s) with which the scheme is
associated.
You can create as many permission schemes as you wish. Each permission scheme can be associated with many projects or just one project, allowing you to tailor appropriate permissions for individual projects as required.

Further reading
- Creating a permission scheme
- Associating a permission scheme with a project
- Agile permissions schemes in Crucible

Creating a permission scheme

This page contains information on how to create a permission scheme in Crucible.

On this page:
- Creating a permission scheme
- Editing a permission scheme
- List of Crucible permissions

Creating a permission scheme

To create a permission scheme:
1. In the admin area, click Permission Schemes, under ‘Security Settings’.
2. Under ‘Add a new permission scheme’, enter a Name to uniquely identify your new scheme.
3. Click Add. Your new permission scheme will have the default assignees shown in the permissions table below.
4. If required, edit this permission scheme, as described below.

Next step: see Associating a permission scheme with a project.

Screenshot: Adding a Permission Scheme

<table>
<thead>
<tr>
<th>Add a new permission scheme</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Add</td>
</tr>
</tbody>
</table>

Editing a permission scheme

To edit a permission scheme:
1. In the admin area, click Permission Schemes under ‘Security Settings’.
2. Click edit for the scheme you wish to change.
3. Click edit for the permission you wish to modify, and choose the appropriate assignee(s) for this permission:

<table>
<thead>
<tr>
<th>Allow Anonymous users</th>
<th>Assign this permission to anonymous users</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow All logged in users</td>
<td>Assign this permission to all logged-in users</td>
</tr>
</tbody>
</table>
4. Click Save.

Screenshot: Editing the 'Close' permission

**Edit User Action**

**Close: Ability to close a review once it has been summarized.**

- **Allow All logged in users**
- **Individuals**
  - [ ] Seb Ruiz
  - Start typing a user name then press enter to select.
- **Groups**
  - Start typing a group name then press enter to select.
- **Review Participants**
  - [ ] Reviewer
  - [ ] Creator
  - [ ] Author
  - [ ] Moderator

[Save] [Cancel]

List of Crucible permissions

The following permissions are available:

<table>
<thead>
<tr>
<th>Permission</th>
<th>Description</th>
<th>Default Assignees</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abandon</td>
<td>Ability to abandon (i.e. cancel) a review.</td>
<td>Creator, Author, Moderator</td>
</tr>
<tr>
<td>Approve</td>
<td>Ability to approve a review (i.e. issue it to the reviewers).</td>
<td>Creator, Author, Moderator</td>
</tr>
<tr>
<td>Close</td>
<td>Ability to close a review once it has been summarizes.</td>
<td>Creator, Author, Reviewer, Moderator</td>
</tr>
<tr>
<td>Comment</td>
<td>Ability to add or remove a comment to or from a review.</td>
<td>Creator, Author, Reviewer, Moderator</td>
</tr>
<tr>
<td>Complete</td>
<td>Ability of a reviewer to change their individual review status to Complete.</td>
<td>Reviewer</td>
</tr>
</tbody>
</table>
## Create
Ability to create a review.

| All logged-in users |

## Delete
Ability to delete a review.

| Creator Author Moderator |

## Edit Review Details
Ability to edit a review's details and change the set of revisions being reviewed.

| Creator Author Reviewer Moderator |

## Re-Open
Ability to re-open a closed or abandoned review.

| Creator Author Reviewer Moderator |

## Recover
Ability to resurrect an abandoned (i.e. canceled) review.

| Creator Author Reviewer Moderator |

## Reject
Ability to reject a review submitted for approval (i.e. prevent it from being issued to reviewers).

| Creator Author Moderator |

## Submit
Ability to submit a review for approval (i.e. request that the review be issued to the reviewers).

| Creator Author Moderator |

## Summarize
Ability to summarize a review. (Normally this would be done after all reviewers have completed their review.)

| Creator Author Moderator |

## Uncomplete
Ability of a reviewer to change their individual review status from Complete to Uncomplete.

| Reviewer |

## View
Ability to view a review. (People without this permission will not know that the review exists.)

| Anonymous users All logged-in users Creator Author Reviewer Moderator |

---

### Associating a permission scheme with a project

This page explains how to associate a permission scheme with a Crucible project and show details of the default permission schemes included with Crucible.

**On this page:**
- Associating a permission scheme with a Crucible project
- Overview of the permission schemes bundled with Crucible
  - Default permission scheme settings
  - Agile permission scheme settings
- Related links

**Associating a permission scheme with a Crucible project**

To associate a permission scheme with a project:
1. In the admin area, click **Projects** (under 'Project Settings').
2. Find the project you wish to associate with your permission scheme, and click **Edit** (in the 'Crucible Settings' column).
3. Under 'Permissions Scheme', choose a scheme from the **Permission Scheme** list.
   - You will be shown a list of the schemes that have been created in Crucible. You can **create a new permission scheme** if necessary.
4. Click **Save**.

### Overview of the permission schemes bundled with Crucible

Crucible comes with two permission schemes. 'Default' and 'Agile'. The following tables show the default settings in detail; note that these can be easily edited by admin users to suit your needs.

#### Default permission scheme settings

This table shows the various permissions and which user groups have them by default.

<table>
<thead>
<tr>
<th>Permission</th>
<th>Anonymous</th>
<th>All Logged In</th>
<th>Individuals</th>
<th>Groups</th>
<th>Review Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abandon</td>
<td>false</td>
<td>false</td>
<td>None</td>
<td>None</td>
<td>Creator, Moderator</td>
</tr>
<tr>
<td>Approve</td>
<td>false</td>
<td>false</td>
<td>None</td>
<td>None</td>
<td>Moderator</td>
</tr>
<tr>
<td>Close</td>
<td>false</td>
<td>false</td>
<td>None</td>
<td>None</td>
<td>Moderator</td>
</tr>
<tr>
<td>Comment</td>
<td>false</td>
<td>false</td>
<td>None</td>
<td>None</td>
<td>Reviewer, Creator, Author, Moderator</td>
</tr>
<tr>
<td>Complete</td>
<td>false</td>
<td>false</td>
<td>None</td>
<td>None</td>
<td>Reviewer</td>
</tr>
<tr>
<td>Create</td>
<td>false</td>
<td>true</td>
<td>None</td>
<td>None</td>
<td>No roles. All logged-in users</td>
</tr>
<tr>
<td>Delete</td>
<td>false</td>
<td>false</td>
<td>None</td>
<td>None</td>
<td>Creator, Moderator</td>
</tr>
<tr>
<td>Edit Review Details</td>
<td>false</td>
<td>false</td>
<td>None</td>
<td>None</td>
<td>Creator, Moderator</td>
</tr>
<tr>
<td>Recover</td>
<td>false</td>
<td>false</td>
<td>None</td>
<td>None</td>
<td>Creator, Moderator</td>
</tr>
<tr>
<td>Reject</td>
<td>false</td>
<td>false</td>
<td>None</td>
<td>None</td>
<td>Moderator</td>
</tr>
<tr>
<td>Re-Open</td>
<td>false</td>
<td>false</td>
<td>None</td>
<td>None</td>
<td>Moderator</td>
</tr>
<tr>
<td>Submit</td>
<td>false</td>
<td>false</td>
<td>None</td>
<td>None</td>
<td>Creator</td>
</tr>
<tr>
<td>Summarize</td>
<td>false</td>
<td>false</td>
<td>None</td>
<td>None</td>
<td>Moderator</td>
</tr>
<tr>
<td>Uncomplete</td>
<td>false</td>
<td>false</td>
<td>None</td>
<td>None</td>
<td>Reviewer</td>
</tr>
<tr>
<td>View</td>
<td>false</td>
<td>true</td>
<td>None</td>
<td>None</td>
<td>Reviewer, Creator, Author, Moderator</td>
</tr>
</tbody>
</table>

- The default permission scheme has changed since Crucible 1.6.

#### Agile permission scheme settings

This table shows the various permissions and which user groups have them by default.

<table>
<thead>
<tr>
<th>Permission</th>
<th>Anonymous</th>
<th>All Logged In</th>
<th>Individuals</th>
<th>Groups</th>
<th>Review Roles</th>
</tr>
</thead>
</table>

- **Crucible 4.0**
- Copyright © 2016 Atlassian. All rights reserved.
- Created by Atlassian in 2016. Licensed under a **Creative Commons Attribution 2.5 Australia License**.
<table>
<thead>
<tr>
<th>Role</th>
<th>Create</th>
<th>Approve</th>
<th>Close</th>
<th>Comment</th>
<th>Complete</th>
<th>Create</th>
<th>Delete</th>
<th>Edit Review Details</th>
<th>Recover</th>
<th>Reject</th>
<th>Re-Open</th>
<th>Submit</th>
<th>Summarize</th>
<th>Uncomplete</th>
<th>View</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abandon</td>
<td>false</td>
<td>false</td>
<td>false</td>
<td>None</td>
<td>None</td>
<td>true</td>
<td>false</td>
<td>false</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>true</td>
</tr>
<tr>
<td>Approve</td>
<td>false</td>
<td>false</td>
<td>false</td>
<td>None</td>
<td>None</td>
<td>true</td>
<td>false</td>
<td>false</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>true</td>
</tr>
<tr>
<td>Close</td>
<td>false</td>
<td>false</td>
<td>false</td>
<td>None</td>
<td>None</td>
<td>true</td>
<td>false</td>
<td>false</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>true</td>
</tr>
<tr>
<td>Comment</td>
<td>false</td>
<td>false</td>
<td>false</td>
<td>None</td>
<td>None</td>
<td>true</td>
<td>false</td>
<td>false</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>true</td>
</tr>
<tr>
<td>Complete</td>
<td>false</td>
<td>false</td>
<td>false</td>
<td>None</td>
<td>None</td>
<td>true</td>
<td>false</td>
<td>false</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>true</td>
</tr>
<tr>
<td>Create</td>
<td>false</td>
<td>true</td>
<td>false</td>
<td>None</td>
<td>None</td>
<td>true</td>
<td>false</td>
<td>false</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>true</td>
</tr>
<tr>
<td>Delete</td>
<td>false</td>
<td>false</td>
<td>false</td>
<td>None</td>
<td>None</td>
<td>true</td>
<td>false</td>
<td>false</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>true</td>
</tr>
<tr>
<td>Edit Review Details</td>
<td>false</td>
<td>false</td>
<td>false</td>
<td>None</td>
<td>None</td>
<td>true</td>
<td>false</td>
<td>false</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>true</td>
</tr>
<tr>
<td>Recover</td>
<td>false</td>
<td>false</td>
<td>false</td>
<td>None</td>
<td>None</td>
<td>true</td>
<td>false</td>
<td>false</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>true</td>
</tr>
<tr>
<td>Reject</td>
<td>false</td>
<td>false</td>
<td>false</td>
<td>None</td>
<td>None</td>
<td>true</td>
<td>false</td>
<td>false</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>true</td>
</tr>
<tr>
<td>Re-Open</td>
<td>false</td>
<td>false</td>
<td>false</td>
<td>None</td>
<td>None</td>
<td>true</td>
<td>false</td>
<td>false</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>true</td>
</tr>
<tr>
<td>Submit</td>
<td>false</td>
<td>false</td>
<td>false</td>
<td>None</td>
<td>None</td>
<td>true</td>
<td>false</td>
<td>false</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>true</td>
</tr>
<tr>
<td>Summarize</td>
<td>false</td>
<td>false</td>
<td>false</td>
<td>None</td>
<td>None</td>
<td>true</td>
<td>false</td>
<td>false</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>true</td>
</tr>
<tr>
<td>Uncomplete</td>
<td>false</td>
<td>false</td>
<td>false</td>
<td>None</td>
<td>None</td>
<td>true</td>
<td>false</td>
<td>false</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>true</td>
</tr>
<tr>
<td>View</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td>None</td>
<td>None</td>
<td>true</td>
<td>false</td>
<td>false</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>true</td>
</tr>
</tbody>
</table>

### Related links

- [Creating a permission scheme](#)

### Agile permissions schemes in Crucible

This page contains information about using and editing Agile permission schemes in Crucible.

#### Understanding the Agile Permissions Scheme

*Agile development* teams may not want to use the default Crucible permission schemes that require one person to approve or summarize reviews. Crucible ships with a pre-defined Agile permission scheme. By Agile, we mean permission schemes that have no moderator and very liberal permissions, suited to Agile or self-organizing teams.

To use the Agile permissions scheme when creating a project, simply select **agile** from the Permissions Scheme list on the 'Edit Project' screen.

#### Considerations

If you began your installation of Crucible with Crucible 2.1 or later, then this permission scheme will appear in the list of permission schemes in the administration menu.
If you have upgraded from an earlier version of Crucible (pre Crucible 2.0), then the Agile permission may not appear by default. However, you can still create the equivalent by disabling the moderator when creating projects, allowing freer access to summarizing, closing and generally tending to Crucible reviews.

If you disable the moderator role on the Edit Project screen, then Crucible will check the current permission scheme. If the current permission scheme requires a moderator, a warning will be shown and you will be prompted to create a new permission scheme which will be called 'Agile' (or Agile-X if the name Agile already exists, where X is a number appended to the scheme name). The new permissions scheme will not require a moderator to carry out any actions.

Screenshot: Warnings on Permission Schemes that Require a Moderator

Migrating to an external database

This page contains information about migrating Crucible from its default embedded HSQL database to an external database. Advantages of using a database other than the embedded HSQL database include:

- **Improved Protection Against Data Loss**: The Crucible built-in database, running HSQLDB is somewhat susceptible to data loss during system crashes. External databases are generally more resistant to data loss during a system crash. HSQLDB is not supported in production environments and should only be used for evaluation purposes.

- **Performance & Scalability**: if you have many users on your Crucible instance, running the database on the same server as FishEye may slow it down. When using the embedded database, the database will always be hosted and run on the same server as Crucible.

- **Data Stored in the Crucible Database**: The Crucible database stores all information besides the cache for repository scans. This means all reviews, comments, review states, user data and user preferences information.

On this page:

- Supported Databases
- Support for Other Databases
- Notes

Supported Databases

You can use a number of alternatives to the built-in HSQLDB database for storing FishEye and Crucible's relational data. The supported alternative databases are listed on the Supported platforms page. Please note, that only the database versions listed on that page are supported.

The pages linked below outline the steps required to switch to an external database:

- Migrating to MySQL
- Migrating to Oracle
- Migrating to PostgreSQL
- Migrating to SQL Server
Support for Other Databases

If you are using another database product that you would like to see supported, please create a JIRA issue for it under the Crucible project.

Notes

Crucible uses Read Committed transaction isolation. There is no requirement to configure this explicitly when setting up an external database - Crucible will configure the transaction isolation when connecting to the database.

Migrating to MySQL

This page describes how to use FishEye/Crucible with both MySQL Enterprise Server and MySQL Community Server. Note that when they are used together, FishEye and Crucible share the same external database.

To switch to a MySQL database, install MySQL and then follow the steps below. Please note that during the migration of database servers, the FishEye/Crucible instance will not be available to users or to external API clients.

⚠️ Note that for FishEye 2.9+, the JDBC driver for MySQL is not bundled with FishEye/Crucible (due to licensing restrictions).

### MySQL 5.6.x and 5.7.x compatibility

- For MySQL 5.6, FishEye/Crucible requires at least version 5.6.11.
- For MySQL 5.7, FishEye/Crucible requires at least version 5.7.5.

Prerequisites

To start with:

1. Install a supported version of MySQL. Check the Supported platforms page for the exact versions that are supported. Note that MariaDB and Percona variants of MySQL are not supported, and are known to cause issues when used with FishEye.
2. Download and install the JDBC driver, if necessary. Note that for FishEye 2.9+, the JDBC driver for MySQL is not bundled with FishEye/Crucible (due to licensing restrictions).
   a. Download the MySQL Connector/J JDBC driver from the MySQL download website.
   b. Expand the downloaded zip/tar.gz file.
   c. Copy the mysql-connector-java-x.y.zz-bin.jar file to your FISHEYE_INST/lib directory. If the lib/ directory doesn't already exist, you will need to create it.
   d. Restart FishEye/Crucible.

On this page:

- Prerequisites
- Step 1. Create a MySQL database
- Step 2. Configure FishEye/Crucible to use MySQL, and migrate data

Related pages:

- Migrating to PostgreSQL
- Migrating to Oracle
- Migrating to SQL Server
- Migrating to an external database
- Troubleshooting Databases

Step 1. Create a MySQL database
Set up a MySQL database as follows:

- Configure the database to use the InnoDB storage engine
- Create a database on MySQL for FishEye/Crucible to use
- Create a FishEye user on the database
- Configure the database to use `utf8` character set encoding
- Configure the database to use `utf8_bin` collation (to ensure case sensitivity).

Here is an example of how to do that. When FishEye/Crucible and MySQL run on the same machine (accessible through localhost), issue the following commands (replacing fisheyeuser and password with your own values):

```
mysql> SET GLOBAL storage_engine = 'InnoDB';
mysql> CREATE DATABASE fisheye CHARACTER SET utf8 COLLATE utf8_bin;
mysql> GRANT ALL PRIVILEGES ON fisheye.* TO 'fisheyeuser'@'localhost'
    IDENTIFIED BY 'password';
mysql> FLUSH PRIVILEGES;
mysql> QUIT
```

For MySQL 5.6 and later, replace the first statement (SET GLOBAL storage_engine = 'InnoDB') with the following:

```
mysql> SET GLOBAL default_storage_engine = 'InnoDB';
```

This creates an empty MySQL database with the name fisheye, and a user that can log in from the host that FishEye is running on who has full access to the newly created database. In particular, the user should be allowed to create and drop tables, indexes and other constraints.

You will also need to set the Server Character set to `utf8`. This can be done by adding the following in `my.ini` for Windows or `my.cnf` for other operating systems (create the file at `/etc/my.cnf` if it doesn't already exist). It has to be declared in the Server section, which is the section after `[mysqld]`:

```
[mysqld]
character-set-server=utf8
```

You'll need to restart MySQL for that change to take effect. Now use the `status` command to verify database character encoding information:

```
mysql> use fisheye;
mysql> status;
```

Screenshot: Using the MySQL status command
Step 2. Configure FishEye/Crucible to use MySQL, and migrate data

In order to migrate to a different database backend, you must create a backup of sql data, configure the database and finally import the data using a backup restoration process. This can be done from either the FishEye/Crucible administration console, which streamlines the process, or using the command line tool which FishEye/Crucible provides.

Option 1: Migrate using the UI (FishEye/Crucible Administration)

1. Navigate to the Database page in FishEye/Crucible's Administration console.

   To log in to the Admin area, you can either:
   - click Administration at the foot of the page.
   - navigate to http://HOSTNAME:8060/admin/, where HOSTNAME is the name of the server on which you installed FishEye.

   Once logged in as an administrator you can also get to the Admin area by clicking the 'cog' menu in the FishEye/Crucible header, and choosing Administration.

2. Choose Edit > Test Connection to verify that FishEye/Crucible can log in to the database.

3. Select MySQL from the database type.

4. Fill in the appropriate fields, replacing the host, port, database name, username and password using the same connection details as used when creating the MySQL database in Step 1 above.

5. Click Test Connection to validate the values.

   Screenshot: Testing the connection
If this fails, verify that you have the MySQL JDBC driver .jar file in the classpath (see Prerequisites section above for instructions on how to install the driver). Also, ensure that the database user can log in to the database from the machine that FishEye/Crucible is running on and that all the required privileges are present.

6. Click **Save & Migrate** to start the migration process.

During the migration process (which will take several minutes, depending on the size of your database and network throughput), the product will be inaccessible to users and external API clients. Users will see a maintenance screen that informs them of the process. Should the migration fail for any reason, FishEye/Crucible will not switch to the new database, and will report on the encountered problems. Because the destination database may now contain some, but not yet all data, drop all tables, indexes and constraints before attempting a new migration.

*Screenshot: Migrating the database*
Option 2: Migrate using the command line

1. Create a backup of the sql data from the FishEye/Crucible instance. Read Backing up and restoring FishEye data and Backing up and restoring Crucible data for information on how to create a backup.

2. Run the following command from the <FishEye installation directory>/bin directory:

```bash
$ ./fisheyectl.sh restore --sql \
   --file /path/to/backup.zip \ 
   --dbtype mysql \ 
   --jdbcurl jdbcmysql://hostname/dbname \ 
   --username crucible \ 
   --password password
```

3. When the import is complete, FishEye/Crucible can be started and will use MySQL.

**Migrating to Oracle**

To switch to an Oracle database, install Oracle and follow the steps below. When they are used together, FishEye and Crucible share the same external database.

Please note that during the migration of database servers, the FishEye/Crucible instance will not be available to users or to external API clients.

Oracle support for FishEye/Crucible and Crucible was introduced in version 2.5.0. In order to migrate to Oracle, your instance must be currently running at least version 2.5. If you are running an older version, then you will be required to first upgrade FishEye/Crucible and then migrate.

**On this page:**
- Step 1. Install and Create a Oracle Database
- Step 2. Configure FishEye/Crucible to use Oracle, and Migrate Data

**Related pages:**
- Migrating to MySQL
- Migrating to PostgreSQL
- Migrating to SQL Server
- Migrating to an external database
- Troubleshooting Databases

**Step 1. Install and Create a Oracle Database**

1. The JDBC drivers for Oracle are bundled with FishEye/Crucible. Skip to step 2 if this meets your needs. If you want to install a specific, different version of the bundled JDBC driver, download the Oracle JDBC driver .jar file from the Oracle website (http://www.oracle.com/technetwork/database/features/jdbc/index-091264.html) and copy the .jar file to your FISHEYE_INST/lib directory (create the lib/ directory if it doesn’t already exist). Move the existing JDBC .jar file to another location (and back it up). Restart FishEye/Crucible to have it pick up the new driver.

2. Because creating a database with Oracle is a complex process, we recommend speaking to your resident DBA for creation of a new database for usage with FishEye/Crucible. We highly recommend installing Oracle with the AL32UTF8 encoding otherwise you may see encoding issues in the product.

**Permissions**

Ensure the database user has CREATE TABLE, CREATE SEQUENCE and CREATE TRIGGER permissions in addition to the read/write permissions to the database.
Step 2. Configure FishEye/Crucible to use Oracle, and Migrate Data

In order to migrate to a different database backend, you must create a backup of sql data, configure the database and finally import the data via a backup restoration process. This can be done from either the FishEye/Crucible administration console, which streamlines the process, or via the command line tool which FishEye/Crucible provides.

Option 1: Migrate using the UI (FishEye/Crucible Administration)

1. Navigate to the Database page in FishEye/Crucible's Administration console.

   To log in to the Admin area, you can either:
   - click Administration at the foot of the page.
   - navigate to http://HOSTNAME:8060/admin/, where HOSTNAME is the name of the server on which you installed Fisheye.

   Once logged in as an administrator you can also get to the Admin area by clicking the 'cog' menu in the FishEye/Crucible header, and choosing Administration.

2. Then choose Edit > Test Connection to verify that FishEye/Crucible can log in to the database.

3. Select Oracle from the database type

4. Fill in the appropriate fields, replacing the host, port, database name, username and password using the same connection details as used when creating the Oracle database in Step 1 above.

5. Click on Test Connection to validate the values.

   Screenshot: Testing the Connection

   ![Database Configuration](image)

   If this fails, verify that you have the Oracle JDBC driver .jar file in the classpath (by placing the .jar file in FISHEYE_INST/lib). Also, ensure that the database user can log in to the database from the machine that FishEye/Crucible is running on and that all the required privileges are present.

6. Click Save & Migrate Data to start the migration process.

   During the migration process (which will take several minutes, depending on the size of your database and network throughput), the product will be inaccessible to users and external API clients. Users will see a maintenance screen that informs them of the process. Should the migration fail for any reason, FishEye/Crucible will not switch to the new database and report on the encountered problems. Because the destination database may now contain some, but not yet all data, drop all tables, indexes and constraints before attempting a new migration.
Option 2: Migrate using the command line

1. Create a backup of the sql data from the FishEye/Crucible instance. Information on how to create a backup can be found at Backing up and restoring FishEye data \ Backing up and restoring Crucible data

2. Run the following command from the <FishEye installation directory>/bin directory:

```
$ ./fisheyectl.sh restore --sql \
  --file /path/to/backup.zip \
  --dbtype oracle \
  --jdbcurl jdbc:oracle:thin:@hostname:port:dbname \
  --username crucible \
  --password password
```

3. When the import is complete, FishEye/Crucible can be started and will use Oracle.

Migrating to PostgreSQL

To switch to a PostgreSQL database, install PostgreSQL and follow the steps below. When they are used together, FishEye and Crucible share the same external database.

Please note that during the migration of database servers, the FishEye/Crucible instance will not be available to users or to external API clients.

On this page:

- Step 1. Install and Create a PostgreSQL Database
- Step 2. Configure FishEye/Crucible to use PostgreSQL, and Migrate Data
Step 1. Install and Create a PostgreSQL Database

1. The JDBC drivers for PostgreSQL are bundled with FishEye/Crucible. Skip to Step 2 if this meets your needs. If you want to install a specific, different version of the bundled JDBC driver, download the PostgreSQL JDBC driver .jar file from the PostgreSQL website and copy the .jar file to your FISHEYE_INST/lib directory (create the lib/ directory if it doesn't already exist). Move the existing JDBC .jar file to another location (and back it up). Restart FishEye/Crucible to have it pick up the new driver.

2. Create a new database user (replacing 'username' and 'password' with the appropriate values):

   $ psql
   > create user username password 'password';

3. Create a UTF-8 database and make the newly created user the owner:

   > create database crucible ENCODING 'UTF-8' OWNER username;

4. Make sure the user has full access to the database:

   > grant all on database crucible to username;

Step 2. Configure FishEye/Crucible to use PostgreSQL, and Migrate Data

In order to migrate to a different database backend, you must create a backup of SQL data, configure the database and finally import the data via a backup restoration process. This can be done from either the FishEye/Crucible administration console, which streamlines the process, or via the command line tool which FishEye/Crucible provides.

Option 1: Migrate using the UI (FishEye/Crucible Administration)

1. Navigate to the Database page in FishEye/Crucible's Administration console.
   
   To log in to the Admin area, you can either:
   - click Administration at the foot of the page.
   - navigate to http://HOSTNAME:8060/admin/, where HOSTNAME is the name of the server on which you installed Fisheye.

   Once logged in as an administrator you can also get to the Admin area by clicking the 'cog' menu in the FishEye/Crucible header, and choosing Administration.

2. Choose Edit > Test Connection to verify that FishEye/Crucible can log in to the existing database.

3. Select PostgreSQL from the database Type.

4. Fill in the appropriate fields, using the same connection details as used when creating the PostgreSQL database in Step 1 above.
   a. Driver Location: either your own PostgreSQL JDBC or the Bundled one that came with FishEye
   b. URL: create this field by replacing the host, port, and database name with your own (i.e. jdbc:postgresql://localhost:5432/<dbname> e.g. jdbc:postgresql://localhost:5432/crucible)
c. **Username:** your DB username  
d. **Password:** your DB password  
e. **Minimum Pool Connections:** 5 is the default  
f. **Maximum Pool Connections:** 20 is the default  
g. **Parameters:** (one per line)  
   i. useUnicode=true  
   ii. characterEncoding=UTF8  
5. Click **Test Connection** to validate the values.  

**Screenshot: Testing the Connection**

<table>
<thead>
<tr>
<th>Type</th>
<th>Driver Location</th>
<th>URL</th>
<th>User Name</th>
<th>Password</th>
<th>Minimum Pool Connections</th>
<th>Maximum Pool Connections</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>PostgreSQL</td>
<td>MySQL</td>
<td>jdbc:postgresql://localhost:5432/crucible</td>
<td>crucible</td>
<td>**********</td>
<td>5</td>
<td>20</td>
<td>useUnicode=true</td>
</tr>
</tbody>
</table>

If this fails, verify that you have the PostgreSQL JDBC .jar file in the classpath (by placing the .jar file in FISHEYE_INST/lib). Also, ensure that the database user can log in to the database from the machine that FishEye/Crucible is running on and that all the required privileges are present.  
6. Click **Save & Migrate** to start the migration process.  

During the migration process (which will take several minutes, depending on the size of your database and network throughput), the product will be inaccessible to users and external API clients. Users will see a maintenance screen that informs them of the process. Should the migration fail for any reason, FishEye/Crucible will not switch to the new database and report on the encountered problems. Because the destination database may now contain some, but not yet all data, drop all tables, indexes and constraints before attempting a new migration. If successful, the following message is displayed:  

**Screenshot: Migrating the Database**
Option 2: Migrate using the command line

1. Create a backup of the sql data from the FishEye/Crucible instance. Information on how to create a backup can be found at [Backing up and restoring FishEye data](#) / [Backing up and restoring Crucible data](#).
2. Run the following command from the `<FishEye installation directory>/bin` directory:

   ```bash
   $ ./fisheyectl.sh restore --sql
   --file /path/to/backup.zip
   --dbtype postgresql
   --jdbcurl jdbc:postgresql://hostname/dbname
   --username crucible
   --password password
   ```

3. When the import is complete, FishEye/Crucible can be started and will use PostgreSQL.

Migrating to SQL Server

To migrate FishEye/Crucible to an SQL Server database, install SQL Server and follow the steps below. When they are used together, FishEye and Crucible share the same external database.

Before you begin

Check that you are using version of SQL Server that is supported for use with FishEye. See [Supported platforms](#).

An existing Java bug prevents connection with Java 1.6.0_29 and above (including Java 1.7.0). Read more about the issue and possible workarounds [here](#).

Step 1. Install and create an SQL Server database

---

*Created by Atlassian in 2016. Licensed under a [Creative Commons Attribution 2.5 Australia License](#).*
See the SQL Server Online resources (MSDN) for instructions on how to install and create an SQL Server database.

Please note the following FishEye/Crucible-specific information when installing and creating an SQL Server database:

- The JDBC jtds drivers for SQLServer are bundled with FishEye/Crucible. We do not support using the Microsoft distributed jdbc driver.
- The FishEye database user must have permission to connect to the database and to create and populate tables.
- The database user should not be the database owner, but should be in the db_owner role. (See SQL Server Startup Errors for details.)
- Your database must be configured to use the Latin1_General_CS_AS collation set.
- Your database should be configured to use snapshot mode for the transaction isolation level. To enable snapshot mode, run:

```
ALTER DATABASE crucible
SET READ_COMMITTED_SNAPSHOT ON;
```

See this and this Microsoft MSDN articles for more information.

Note that it is preferable to run the above command after stopping FishEye/Crucible (and with no other applications connected to the SQL Server database), especially if you find that the alter statement does not complete quickly.

**On this page:**

- Before you begin
- Step 1. Install and create an SQL Server database
- Step 2. Configure FishEye/Crucible to use SQL Server and migrate data

**Related pages:**

- Migrating to MySQL
- Migrating to PostgreSQL
- Migrating to Oracle
- Migrating to an external database
- Troubleshooting Databases

**Step 2. Configure FishEye/Crucible to use SQL Server and migrate data**

In order to migrate to a different database backend, you must create a backup of your SQL data, configure the database and finally import the data via a backup restoration process. This can be done from either the Crucible administration console, which streamlines the process, or via the command line tool which Crucible provides. These two methods are described below. The following resources may be of interest:

- Backing up and restoring FishEye data
- Backing up and restoring Crucible data
- SQL Server Online resources (MSDN)

**Option 1: Migrate using the UI (FishEye/Crucible Administration)**

Before you begin:

- Note, during the migration process (which will take several minutes, depending on the size of your database and network throughput), the FishEye/Crucible instance will be inaccessible to users and external API clients. Users will see a maintenance screen that informs them of the process.
- If you are attempting a migration after a previous migration has failed, you must drop all tables, indexes and constraints before attempting a new migration. This is because the destination database may contain data from the previous migration attempt.
• Verify that you have the jtds JDBC driver .jar file in the classpath (by placing the .jar file in FISHEYE_INST/lib).
• Ensure that the database user can log in to the database from the machine that FishEye/Crucible is running on and that all the required privileges are present.
• If your database is hosted on a SQL Server cluster, you must include the instance name in the JDBC URL:

\[
jdbc:jtds:sqlserver://<server>[:<port>][/<database>];instance=<instance_name>
\]

Please ensure that you use a SQL Server user account to log into your database, not a Windows user account.

To configure FishEye/Crucible to use SQL Server and migrate data using the administration console:

1. Navigate to the Database page (under ‘System Settings’) in FishEye/Crucible’s Administration console.

To log in to the Admin area, you can either:
• click Administration at the foot of the page.
• navigate to http://HOSTNAME:8060/admin/, where HOSTNAME is the name of the server on which you installed Fisheye.

Once logged in as an administrator you can also get to the Admin area by clicking the ‘cog’ menu in the FishEye/Crucible header, and choosing Administration.

2. Configure FishEye/Crucible to use SQL Server, as follows:
   • Select appropriate SQLServer version from the Type dropdown, matching the version of database you are running.
   • Complete the appropriate fields, replacing the URL (host, port and database name), User Name and Password as required, using the same connection details as used when creating the SQL Server database in Step 1 above.

   NOTE: The default SQL server instance listens on port 1433. If your instance is not the default, use the port number that is associated with your particular instance.e.g. URL:jdbc:jtds:sqlserver://localhost:1433;databaseName=your database name here;

3. Click Test Connection to verify that FishEye/Crucible can log in to the database (see ‘Testing the Connection’ screenshot below).

4. Click Save & Migrate Data to start the migration process (see ‘Migrating the Database’ screenshot below). If the migration fails, FishEye/Crucible will not switch to the new database and will report the problems encountered.

Screenshots: Configuring FishEye/Crucible to use SQL Server and migrating data (click to view full-size images)

Option 2: Migrate using the command line

To configure FishEye/Crucible to use SQL Server and migrate data using the command line:

1. Create a backup of the sql data from the FishEye/Crucible instance. Information on how to create a
Backup can be found at Backing up and restoring FishEye data \ Backing up and restoring Crucible data.

2. Run the following command from the <FishEye installation directory>/bin directory:

```
$ ./fisheyectl.sh restore --sql \
  --file /path/to/backup.zip \
  --dbhype sqlserver2012 \
  --jdbcurl
"jdbc:jtds:sqlserver://hostname:port;databaseName=dbName;" \
  --username crucible \
  --password password
```

3. When the import is complete, FishEye/Crucible can be started and will use SQLServer.

Backing up and restoring Crucible data

Crucible data can be backed up from the admin interface or command line. This page contains the command syntax, options and the required procedure to backup and restore your Crucible instance.

Backing up Crucible data

The Crucible admin backup process

1. Navigate to the Crucible Admin area (click the Administration link in the footer of any Crucible page).
2. Click Backup (under 'System' heading in the left navigation bar).
3. The File Path field indicates where the backup file (in .zip format) will be stored. You can manually edit this path to change it. Under 'Include', a list of check boxes is shown, with the following items:

   - Backing up Crucible data
     - The Crucible admin backup process
     - The Crucible command line backup process
     - Components of a Crucible backup
     - Backup command line options
     - Command line examples
     - Advanced backup command line settings
     - Known limitations
   - Scheduling Crucible backups
   - Restoring Crucible data
     - Restoring Crucible data from the command line
     - Command line restore options
     - Advanced command line restore settings

4. Once you have chosen your options, click Create Backup Now.

Screenshot: The Crucible Backup Screen
The Crucible command line backup process

1. Open a command line interface on the Crucible server computer.
2. Navigate to the `<Crucible home directory>/bin/` directory.
3. Run the backup command on the command line with the desired options.
4. The backup is created as a new Zip archive file and placed in the `FISHEYE_INST/backup/` directory.

Note that if your Crucible instance uses a custom `FISHEYE_INST` directory; make sure the `FISHEYE_INST` environment variable is properly set when running the backup command.

Components of a Crucible backup

The Crucible backup is highly configurable and allows for many different configurations. This table shows the various components of the backup, what they are for and how they can be used.

<table>
<thead>
<tr>
<th>Component</th>
<th>Purpose</th>
<th>Defaults</th>
</tr>
</thead>
<tbody>
<tr>
<td>SQL Database</td>
<td>Refers to the SQL content database (used by both FishEye and Crucible and containing all user profile data, reviews and their comments).</td>
<td>Backed up by default.</td>
</tr>
<tr>
<td>Cache</td>
<td>The cache contains data that reflects the state of FishEye's repositories. Without it, FishEye must re-scan its repositories after a backup is restored. The cache also contains OSGi library data that increases startup time. These too can be excluded and will be generated automatically when the application is started.</td>
<td>The cache is not backed up by default as it tends to be large (running a risk of pushing the maximum file size for Java backups), while also representing replaceable data.</td>
</tr>
<tr>
<td>Plugins</td>
<td>Plugins are 3rd-party extensions that you may have installed, and configuration for all plugins (this includes configuration for Crucible's set of standard plugins).</td>
<td>Configuration data for all plugins are backed up by default, as well as all plugins installed in <code>FISHEYE_INST/var/plugins/user</code>.</td>
</tr>
<tr>
<td>Templates</td>
<td>In this context, these are custom freemarker templates that you or your users have created. They live in <code>FISHEYE_INST/template</code>.</td>
<td>Templates are backed up by default. You can choose to exclude them from the backup if your templates directory is covered by some other backup mechanism.</td>
</tr>
</tbody>
</table>
Uploads | In this context, uploads refers to files which are added to Crucible via the web interface (such as patch file reviews). It also includes each repository-backed file that went under review, when Crucible is configured to make a local copy of every reviewed file. | Uploads are backed up by default. You can choose not to back them up for example when the 
FISHEYE_INST/var/data/uploads directory is already covered by some other backup mechanism.

ActiveObjects | Configuration data stored by plugins | Backed up by default

Note that the backup will always include the configuration data (config.xml), your license file and the FishEye user data.

Backup command line options

These examples are for use in a Linux-like operating system. When using these commands on Windows, use the file name fisheyectl.bat and use the correct slashes. Run the command from the <Crucible home directory>/bin/directory.

The basic syntax of the backup command is as follows:

```
$ ./fisheyectl.sh backup [OPTIONS]
```

To see inline help for all backup options, run the following command in the <Crucible home directory>/bin/directory:

```
$ ./fisheyectl.sh backup --help
```

<table>
<thead>
<tr>
<th>Option</th>
<th>Switch</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quiet mode</td>
<td>-q OR --quiet</td>
<td>Suppresses output</td>
<td>No</td>
</tr>
<tr>
<td>Output filename</td>
<td>-f OR --file</td>
<td>Specify a different path and filename to the FISHEYE_INST/backup/backup_YYYY-DD-MM_HHmm.zip file. When filename is omitted, the backup filename contains the date and time.</td>
<td>FISHEYE_INST/backup/ is the default directory.</td>
</tr>
<tr>
<td>Compression level</td>
<td>--compression OR -c</td>
<td>Sets the Zip compression level, from 1-9. Runs at level 6 if no argument is passed.</td>
<td>Yes (6)</td>
</tr>
<tr>
<td>Anonymize</td>
<td>-a OR --anonymise</td>
<td>Anonymizes the SQL database by replacing all text with 'x'. This is only useful when sending a backup to Atlassian as part of a support case. Please do not anonymize data unless the Support Engineer handling your support case has specifically requested the data anonymized (as often anonymized data will not help reproduce the issue).</td>
<td>No</td>
</tr>
<tr>
<td>Cache Backup</td>
<td>--cache</td>
<td>Include the repository caching files in the backup. These hold information gained from scanning the repositories and can be quite large (many gigabytes). However, it can shorten the time needed to re-scan the repositories after data is restored.</td>
<td>No. By data is backup</td>
</tr>
</tbody>
</table>

Command line examples

These examples are for use in a Linux-like operating system. When using these commands on Windows, use the filename fisheyectl.bat and use the correct slashes. Run the command from the <Crucible home directory>/bin/directory.
Backing up with compression of 9, quiet mode and setting an output location

```bash
$ ./fisheyectl.sh backup --compression 9 -q -f /application_backups/fisheye/20090215.zip
```

Backup including cache data (also includes all default components)

```bash
$ ./fisheyectl.sh backup --cache
```

Restoring a backup with cache data (also restores all default components)

```bash
$ ./fisheyectl.sh restore --cache
```

Advanced backup command line settings

In some cases it might be preferable to only backup a limited set of items. This could be useful when your instance uses an external database such as MySQL or PostgreSQL and your DBA has already configured automatic backups in the database. The commands below allow this.

<table>
<thead>
<tr>
<th>Option</th>
<th>Switch</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exclude Plugins</td>
<td>--no-plugins</td>
<td>Excludes plugins from the backup.</td>
<td>No. By default, plugins are included in every backup.</td>
</tr>
<tr>
<td>Exclude Templates</td>
<td>--no-templates</td>
<td>Excludes templates from the backup.</td>
<td>No. By default, templates are included in every backup.</td>
</tr>
<tr>
<td>Exclude Uploads</td>
<td>--no-uploads</td>
<td>Excludes uploaded files (such as patch reviews, stored in Crucible's internal database) from the backup.</td>
<td>No. By default, uploads are included in every backup.</td>
</tr>
<tr>
<td>Exclude SQL Database</td>
<td>--no-sql</td>
<td>Excludes the SQL content database used by both FishEye and Crucible.</td>
<td>No. By default, this data is included in every backup.</td>
</tr>
<tr>
<td>Show help</td>
<td>--help OR -h</td>
<td>Shows inline help on the command line.</td>
<td>No</td>
</tr>
</tbody>
</table>

Known limitations

Please note that the below limitations are common for any Java based backup tool.

**Archives Containing Over 65535 Files**

Versions of Java earlier than v1.6 (b25) are incapable of handling zip files that contain more than 65,535 files. The solution for this problem is to either upgrade to a version of Java later than v1.6 (b25), or ensure that the archive does not exceed the threshold (contains less than 65,535 files). The FishEye cache (not included in backups by default) can be a contributor of many small files. Hence, exclude the cache from backups if this is likely to be a concern.

**Archives Larger Than 4GB**

Java has trouble reading and writing zip files that are larger than 4GB. As of release 1.5 Java appears capable of reliably creating archives that are over 4GB, but remains unable to extract them. For details see Sun's bug report. Also be aware of the fact that some file systems (including FAT32) have trouble with files larger than 4GB.
As a workaround, make sure you do not create archives that are larger than 4GB. The FishEye cache (not included in backups by default) can be a contributor of a lot of small files (although these tend to compress very well). If you still want to archive everything and end up with an archive that is too large, consider creating separate backups for the FishEye cache and uploaded files respectively.

**Scheduling Crucible backups**

To set a schedule for automatic backups, open the administration screen and click 'Backup' under 'System' on the left navigation bar. The ‘Backup’ page opens. Now, click the link ‘Manage Scheduled Backups’ at the bottom of the page. The ‘Scheduled Backups’ page opens.

On the ‘Scheduled Backups’ page, click ‘Edit’ to adjust the backup schedule. Set the desired options and click ‘Save’.

The options for scheduled backups are detailed in the table below.

<table>
<thead>
<tr>
<th>Option name</th>
<th>Description</th>
<th>Allowed Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable Scheduled Backups</td>
<td>Stops regular backups from taking place.</td>
<td>On (disabled) or Off (enabled)</td>
</tr>
<tr>
<td>Backup path</td>
<td>The path where the backup .zip file will be stored.</td>
<td>Any system or network path that FishEye or Crucible can access.</td>
</tr>
<tr>
<td>Backup file prefix</td>
<td>Characters that will be added to the beginning of the backup file name.</td>
<td>Any string of characters that can be used as part of a filename on the local operating system.</td>
</tr>
<tr>
<td>Backup file date pattern</td>
<td>Sets a date for the next (or initial) backup to take place.</td>
<td>Any valid date in the format <code>yyyy_MM_dd</code> (year, month, day of the month).</td>
</tr>
<tr>
<td>Backup frequency</td>
<td>Sets how often the backup will take place.</td>
<td>Can be set to 'every day', 'every Sunday', 'Monday to Friday' and 'first day of the month'.</td>
</tr>
<tr>
<td>Backup time (HH:mm)</td>
<td>The time when the backup will take place.</td>
<td>Any valid 24-hour time in the format <code>HH:mm</code> (hours, minutes).</td>
</tr>
<tr>
<td>Include</td>
<td>Specifies which items must be included in the backups (these components are explained at the top of this page).</td>
<td>As per the options for regular on-demand backup (These components are explained at the top of this page).</td>
</tr>
</tbody>
</table>

*Screenshot: Scheduling Backups in FishEye and Crucible*
Scheduled Backups

Please choose the schedule for your backups carefully. FishEye and Crucible will be unavailable for the duration of the backup process.

Your managed repositories will not be backed up!
FishEye does not automatically backup content stored in your managed repositories. Please ensure that a backup process which is satisfactory to your requirements is in place. Read more

Schedule backups

DISABLE SCHEDULED BACKUPS

Switch scheduled backups on and off.

Backup directory

Project directory for the backup files.

Backup file prefix

The prefix for the generated backup file.

Backup file data pattern

The date and time format you specify will be added to the file prefix to differentiate between backup files.

Backup frequency

How often do you want FishEye and Crucible to run a backup.

Backup Time

The time when FishEye and Crucible will run the backup.

Include

- ActiveObjects
- repository and application caches
- plugins and their configuration data
- SQL database
- web templates
- uploaded files and local copies of files under review

Save | Cancel

Be aware that scheduled backups can fill up disks unless you regularly move or delete old archives.

Restoring Crucible data

Restoring Crucible data from the command line

There is currently no way to restore a backup from the web interface because Crucible must be shut down during a data restore.

Restoring a backup will irreversibly overwrite the data of your installation with the data from the backup archive. If you made a backup from production which connected to an external database, and restore this backup to a test server without specifying another database to restore too, you will drop and restore to your production database. Thus when restoring to a test server, always ensure you specify the correct database to restore to (or restore to an in-built database).

1. **Install Crucible** into a new, empty directory (this must be the same version that the backup was created from, or later).
   
   ![Warning](https://example.com/)
   
   Note that you cannot restore data into versions of Crucible which are older than the version that created the backup.

2. Make sure the Crucible instance is not running.
3. Open a command line interface on the Crucible server computer.
4. Run the restore command on the command line with the desired options.
5. The specified elements will be restored.
6. Start the Crucible instance.
7. When using FishEye integrated with Crucible, you will need to re-index your repositories after restoring data, unless the backup archive was created with the --cache option.

Command line restore options

These examples are for use in a Linux-like operating system. When using these commands on Windows, use the filename fisheyectl.bat and use the correct slashes. Run the command from the <Crucible home directory>.
The basic syntax of the restore command is as follows:

```bash
$ ./fisheyectl.sh restore -f /path/to/backup_2009-10-02_1138.zip [OPTIONS]
```

To see inline help for all backup options, run the following command in the <Crucible home directory>/bin/ directory:

```
$ ./fisheyectl.sh restore --help
```

Restores a FishEye/Crucible backup instance.
If you are using an external database (as opposed to the default built-in database), make sure the JDBC driver file is present in the FISHEYE_INST/lib directory when running restore.

<table>
<thead>
<tr>
<th>Option</th>
<th>Switch</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Suppress output</td>
<td>--quiet OR -q</td>
<td>Suppress the output messages from the restore program on the command line.</td>
<td>No</td>
</tr>
<tr>
<td>Choose file to restore from</td>
<td>--file PATH/FILENAME OR -f PATH/FILENAME</td>
<td>Restore the backup from PATH/FILENAME.</td>
<td>Yes (required)</td>
</tr>
<tr>
<td>Show inline help</td>
<td>--help OR -h</td>
<td>Displays help for options on the command line.</td>
<td>No</td>
</tr>
</tbody>
</table>

**Advanced command line restore settings**

By default, the restore program will restore all items found in the backup archive (so if you included the caches using the --cache option, these will automatically be restored). However, it is possible to only restore a subset of items from the backup, by explicitly specifying the item names on the command line and only those will be restored.

<table>
<thead>
<tr>
<th>Option</th>
<th>Switch</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restore FishEye cache</td>
<td>--cache</td>
<td>Restore the repository cache backup.</td>
</tr>
<tr>
<td>Restore plugins</td>
<td>--plugins</td>
<td>Restore 3rd-party plugins and their configuration data.</td>
</tr>
<tr>
<td>Restore templates</td>
<td>--templates</td>
<td>Restore freemarker templates from the backup (the restored instance will use the built-in templates).</td>
</tr>
<tr>
<td>Restore uploads</td>
<td>--uploads</td>
<td>Restore uploads (e.g. patch files uploaded into Crucible and contents of files under review).</td>
</tr>
<tr>
<td>Restore Crucible reviews</td>
<td>--sql</td>
<td>Restore the SQL database containing user profiles, reviews and review comments.</td>
</tr>
<tr>
<td>Set database type</td>
<td>--dbtype OR -t</td>
<td>SQL database type (mysql, postgresql, sqlserver2008, sqlserver2012 or hsql). Only required when restoring to a database location different to that used at backup time.</td>
</tr>
</tbody>
</table>
### Set JDBC URL

<table>
<thead>
<tr>
<th>Option</th>
<th>--jdbcurl OR -j</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>JDBC URL of the SQL database. Only required when restoring to a database location different to that used at backup time (not applicable for hsql).</td>
</tr>
</tbody>
</table>

### Set JDBC username

<table>
<thead>
<tr>
<th>Option</th>
<th>--username OR -u</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>JDBC username of the SQL database. Only required when restoring to a database location different to that used at backup time (not applicable for hsql).</td>
</tr>
</tbody>
</table>

### JDBC password

<table>
<thead>
<tr>
<th>Option</th>
<th>--password OR -p</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>JDBC password of the SQL database. Only required when restoring to a database location different to that used at backup time (not applicable for hsql).</td>
</tr>
</tbody>
</table>

### JDBC class

<table>
<thead>
<tr>
<th>Option</th>
<th>--driver OR -d</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Specifies the JDBC driver class name needed to access the SQL database. Only required when restoring to a database location different to that used at backup time and when using a different JDBC driver than the standard driver associated with the database specified through <code>--dbtype</code>. (Not applicable for 'built-in'.)</td>
</tr>
</tbody>
</table>

### Notes on migrating backup data

When the process restores a SQL database, it looks at the configuration data (`config.xml`) included in the backup archive to learn which database product was used and how to connect to it. When Crucible uses the built-in HSQLDB database (which is the default), the restored instance will also use that. However, when the restored instance will use a different database than the backed up instance (for instance, HSQLDB was used at the time the backup was created, but it needs to be restored on MySQL), use the command line options to point the process to the new database.

#### Command line example: migrating backup data to MySQL

These examples are for use in a Linux-like operating system. When using these commands on Windows, use the filename `fisheyectl.bat` and use the correct slashes. Run the command from the `<Crucible home directory>/bin/` directory.

**Restoring to a Crucible instance that uses a different database (ensure the mysql driver jar file is present in the FISHEYE_INST/lib directory)**

```
$ ./fisheyectl.sh restore \
  --username john \
  --password smith \
  --jdbcurl jdbc:mysql://localhost:3306/crucible \
  --dbtype mysql \
  --file /path/to/backup_2009-10-02_1138.zip
```

### Customizing Crucible

This section describes the ways in which you can configure Crucible.

- Customising the welcome message
- Customizing email notifications
- Customising the defect classifications
- Configuring user managed mappings
- Enabling Access Logging in Crucible

#### Customising the welcome message

Crucible administrators can customize the welcome message that is displayed when Crucible starts by clicking Front Page Customization (under 'Global Settings') in the admin area.
You can provide either or both of:

- a custom welcome message that is displayed to users when they first log in.
- a custom support message that also appears on the opening page, and which gives contact details for your own support organization.

The changes you make are applied immediately, without needing to restart Crucible.

Using HTML

The content in the welcome screen can be formatted using basic HTML tables, image references or anchor tags, such as the following:

```html
<a href="http://www.atlassian.com">Link to Atlassian Home Page</a>
```

Editing the config.xml file

You can also directly edit the XML file that contains the welcome and support messages. This file is called `config.xml`, and is located in the Crucible installation folder.

To do this, simply add the following XML tags to `config.xml`:

```xml
<content>
  <front-page-message>Example welcome message here</front-page-message>
  <support-message>Example support message here</support-message>
</content>
```

Customizing email notifications

Email notifications in Crucible can be customized to change their formatting, by editing template files. This page
contains instructions for this process.

**Editing Crucible email templates**

Template files for Crucible are stored in the `<Crucible home directory>/template/crucible/` folder and the `<Crucible home directory>/template/shared` folder.

There are sets of templates for both HTML and plain-text emails, as listed in the table below. Note that these templates do not support embedding full diffs into notifications. They are only for changing the appearance and order of certain content inside the messages.

You can edit templates in any text editor:

- Either: Stop Crucible before editing templates to avoid disrupting notifications that may otherwise be sent.
- Or: Avoid editing a live template file, as Crucible may try to use it while you are editing. This could have unpredictable results. Instead, back up the template file (it's wise to keep original versions of all these files), edit a copy you have made, then overwrite the 'live' template once you have finished.
- After an edit, the change to the email template will take place immediately. No restart is required.

**Advanced editing of Crucible email templates**

The email notification templates use the Freemarker format. Freemarker is a general templating engine enabling automated content.

If you are familiar with Freemarker, more advanced customizations can be made to the email notification templates. However, you make such adjustments at your own risk.

See [Freemarker Data Model for Email Templates](https://confluence.atlassian.com/prod/freemarker-data-model-for-email-templates-1508425212.html) in the FishEye documentation for details of the data model used by FishEye/Crucible.

**Crucible email template files**

The following template files for Crucible notification are stored in the `<Crucible home directory>/template/crucible/` folder, or its subfolders and `<Crucible home directory>/template/shared` or its subfolders.

<table>
<thead>
<tr>
<th>Template filename</th>
<th>HTML</th>
<th>Plain-text</th>
</tr>
</thead>
<tbody>
<tr>
<td>common-mention-macros.ftl</td>
<td>Both</td>
<td></td>
</tr>
<tr>
<td>notification-subject.ftl</td>
<td>Shared</td>
<td></td>
</tr>
<tr>
<td>changeset-header.ftl</td>
<td>Shared</td>
<td></td>
</tr>
<tr>
<td>util.ftl</td>
<td>Shared</td>
<td></td>
</tr>
<tr>
<td>all-completed-notification.ftl</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>all-uncompleted-notification.ftl</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>batch-comment-note.ftl</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>batch-reviewer-note.ftl</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>batch-revision-added-note.ftl</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>batch-state-note.ftl</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>comment-render-macro.ftl</td>
<td>✔</td>
<td>✗</td>
</tr>
<tr>
<td>crucible-layout.ftl</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>
See also Customizing FishEye Email Notifications.
Freemarker Data Model for Email Templates

Customizing Crucible email templates with Freemarker

See the Freemarker documentation for instructions on Freemarker syntax. Use the templates that ship with Crucible as a guide to the properties available on each object.

Specific email types will have extra data associated with them, and this data will be available in that particular template (but not in others).

Example

The syntax to access the data-model, using the data model object ‘link’ as an example, place this code into the email at the desired position.

```
${notification.link}
```

Customising the defect classifications

This page explains how to customize defects and their classifications in Crucible.

On this page:

- Defects in Crucible comments
- Changing classification settings
- Default Crucible classifications
  - Ranking
  - Classification
Defects in Crucible comments

Defects are comments made by reviewers that indicate a problem in a review. Defects can be classified by rank and type. Custom classifications can also be defined. The default classifications are shown in the screenshot below.

Changing classification settings

Only Crucible Admin users can edit defect classifications.

To change the default classifications:

1. In the Admin area, click Crucible under 'Global Settings'.
2. Click Edit Defect Classifications.
3. You can add and remove classifications, and add fields to, or remove fields from, classifications.

Any changes made to defect classifications will only apply to reviews created after the change is saved.

Screenshot: Editing defect classifications in Crucible
Defect Classifications

Note: Changes will only apply to new reviews
Current defect classification version is 9.

### Default Crucible classifications

There are two default defect classifications that are preset in Crucible: Ranking and Classification. These settings (and their sub-categories) can be edited or removed; other custom classifications can be added.

#### Ranking

Crucible users can rank a defect as **Major** or **Minor**, indicating the importance of the defect.

#### Classification

This setting helps to provide more detail about the defect. This classification can be set to one of the options described in the following table:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Missing</td>
<td>The defect applies to code or information that is missing (absent).</td>
</tr>
<tr>
<td>Extra (superfluous)</td>
<td>The defect applies to code or information that should be removed.</td>
</tr>
<tr>
<td>Ambiguous</td>
<td>The defect applies to code or information that is not clear or easy to understand.</td>
</tr>
<tr>
<td>Inconsistent</td>
<td>The defect applies to code or information that is applied in several different ways.</td>
</tr>
<tr>
<td>Improvement desirable</td>
<td>The defect applies to code or information that needs to be revised.</td>
</tr>
<tr>
<td>Not conforming to standards</td>
<td>The defect applies to code or information that breaks established conventions.</td>
</tr>
<tr>
<td>Risk-prone</td>
<td>The defect applies to code or information that takes unacceptable risks.</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------------------------------------------------------</td>
</tr>
<tr>
<td>Factually incorrect</td>
<td>The defect applies to code or information that is wrong.</td>
</tr>
<tr>
<td>Not implementable</td>
<td>The defect applies to code or information that may be impossible to create.</td>
</tr>
<tr>
<td>Editorial</td>
<td>The defect applies to code or information where the classification as a defect may be subject to personal opinion.</td>
</tr>
</tbody>
</table>

### Configuring user managed mappings

In FishEye and Crucible, Administrators can control whether users can use the Author Mapping setting to map their own FishEye/Crucible usernames to repository committer accounts or not. By default, the setting allows users to set their own mappings.

If you wish to lock down the mappings for security or audit reasons, this setting lets you restrict all management of mappings to FishEye/Crucible administrators only.

To do this, click **Administration** in the footer of the FishEye/Crucible interface and then **Authentication** (under 'Security Settings') in the left navigation bar. You can set **User Managed Mappings** either **On** or **Off**. The setting is applied immediately.

#### Built-in

<table>
<thead>
<tr>
<th>Feature</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Public Signup</td>
<td>OFF (Turn On)</td>
</tr>
<tr>
<td>Use CAPTCHA for Signup</td>
<td>ON (Turn Off)</td>
</tr>
<tr>
<td>User managed mappings</td>
<td>ON (Turn Off)</td>
</tr>
</tbody>
</table>

### Enabling Access Logging in Crucible

To enable access logging in FishEye 3.0 and later:

1. Stop Fisheye/Crucible,
2. Create the file `<FishEye install directory>/content/WEB-INF/jetty-web.xml` with the following content:
<xml version="1.0" encoding="ISO-8859-1" ?
<!DOCTYPE Configure PUBLIC "/Mort Bay Consulting//DTD Configure//EN" "http://www.eclipse.org/jetty/configure.dtd" >
<Configure class="org.eclipse.jetty.webapp.WebAppContext">
  <Set name="handler">
    <New class="com.cenqua.fisheye.web.jetty.FishEyeRequestLogHandler">
      <Set name="requestLog">
        <New id="RequestLogImpl" class="org.eclipse.jetty.server.NCSARequestLog">
          <Arg><SystemProperty name="jetty.logs" default="/var/log/" />fisheye-access-yyyy_mm_dd.log</Arg>
          <Set name="retainDays">90</Set>
          <Set name="append">true</Set>
          <Set name="extended">false</Set>
          <Set name="LogTimeZone">GMT</Set>
        </New>
      </Set>
    </New>
  </Set>
</Configure>

3. Restart Fisheye/Crucible.

This will create an access log in <FishEye install directory>/var/log/fisheye-access-yyyy_mm_dd.log format (e.g. fisheye-access-2010_03_17.log). If you want to change the path to your <FishEye install directory>, change the default="/var/log/" to the path to the log folder in FISHEYE_INST.

The log directory must exist
If the path to the log directory given by the default attribute of the SystemProperty tag (defined in the line 10 in the jetty-web.xml above) does not exist, then FishEye will fail to start and will not log any error message.

The path given in the example below is correct when FISHEYE_INST and the <FishEye install directory> are the same directory, otherwise please use the absolute path of your FISHEYE_INST/var/log directory.

Log format
The logs are written in NCSA format:
Please refer to the [Jetty documentation](#) for more configuration options.

**Compatibility**

If you are using an earlier version of FishEye than FishEye 2.7.8, replace `com.cenqua.fisheye.web.jetty.FishEyeRequestLogHandler` by `org.mortbay.jetty.handler.RequestLogHandler`.

`FishEyeRequestLogHandler` was added in 2.7.8 to fix an issue where the user credentials would not be added to the NCSA log: [FE-3040](#).

**Linking Crucible to JIRA**

**JIRA Software** is Atlassian's issue tracking and project management application.

See [JIRA integration in Crucible](#) for a description of all the integrations you get when Crucible is linked with JIRA Software.

This page describes how to integrate JIRA Software with Crucible. If you're linking Crucible to an Atlassian Cloud JIRA Software instance, please see [Link to server applications from Cloud](#).

When Crucible was first installed, JIRA Software integration may have been configured using the setup wizard, which configures the JIRA Software connection automatically for user management. See [Configuring JIRA integration in the Setup Wizard](#).

However, JIRA Software integration with Crucible can be configured at any time after installation, as described on this page.

**Initial configuration in JIRA Software**

Configure the following setting in each instance of JIRA Software that you wish to link to Crucible:

- **Allow remote API access**

Consider also the following, to make full use of the integration between Crucible and JIRA Software:

- **Enable subtasks**
- **Allow unassigned issues**
Linking Crucible with JIRA Software instances

You can integrate Crucible with one or more instances of JIRA Software from the Crucible administration area. There are two parts to integrating with a JIRA Software instance:

- Setting up an application link between JIRA Software and Crucible, described below, for sharing information and facilitating integration features.
- Linking Crucible with JIRA Software for delegating user and group management to your JIRA Software server. You would only do this with one instance of JIRA Software.

Configuring an application link with JIRA Software

This section describes how to create a two-way applications link between Crucible and JIRA Software.

To create a new application link between Crucible and JIRA Software:

1. Go to your Crucible administration screen and click Application Links (under 'Global Settings').
2. Enter the URL for the JIRA Software instance you want to link to and click Create new link.
3. Complete the application link wizard to connect Crucible to your JIRA Software server. You must make use of the automatic link-back from JIRA Software to Crucible to get full integration (you'll need the JIRA system administrator global permission for that).

For Crucible 3.2 and later, creating a new application link now uses OAuth by default and enables both 3-legged OAuth (3LO) and 2-legged OAuth (2LO).

To update an existing application link with JIRA Software:

When you update an older application link to use OAuth, 3-legged authentication is applied by default. However, you'll need to explicitly enable 2-legged authentication in order to see Crucible information in the JIRA Software issue development panel (when integrated with JIRA 6.2 or later). Enable 2LO for the application link as follows:

1. Go to the Crucible admin area and click Add-ons > Application Links.
2. Click Edit for the app link with JIRA Software.
3. For both Outgoing Authentication and Incoming Authentication:
   a. Click OAuth
   b. Check Allow 2-legged OAuth.
   c. Click Update.

The application link update process will involve you logging into JIRA Software for a short time to configure the JIRA Software end of the link, before returning you to Crucible.

Connecting to JIRA Software for user management

To manage your Crucible users in JIRA Software, you first configure a connection with JIRA Software, then set up the user directory in JIRA.

See Connecting to JIRA for user management for details.
Inline issue creation

Inline issue creation allows a user to create a JIRA Software issue from a review comment. The user must have the 'Comment' permission in Crucible to see the Create Issue link in the comment. See Creating JIRA issues from the review.

This requires that Crucible is integrated with JIRA 5.0, or later, and is disabled if Crucible is integrated with an earlier version of JIRA Software.

When creating the issue, the Create Issue dialog only displays required fields for the selected issue type.

- A JIRA Software administrator can configure other fields to be required (and so displayed) from within JIRA Software. See Specifying Field Behavior.
- Not all field types are supported. In particular, unbundled custom field types are not supported. See Supported fields for inline issue creation.
- If any required field for the selected issue type is not supported, Crucible displays an error, with a link to create the issue directly in JIRA Software. This link will pre-populate the project, issue type, summary and description fields, but will not create a link from the comment to the issue.

In the new issue in JIRA Software, you see a link back to the comment in Crucible. However:

- Issue links may be disabled in JIRA Software.
- The JIRA Software login that Crucible uses needs permission to create links.
- The FishEye plugin (available from the Atlassian Marketplace) must be installed in JIRA Software for permission checking on the display of issue links in JIRA Software.

You can disable the Inline Issue Creation plugin in Crucible to restore the earlier behavior.

**Having trouble integrating your Atlassian products with application links?**
We've developed a guide to troubleshooting application links, to help you out. Take a look at it if you need a hand getting around any errors or roadblocks with setting up application links.

Supported fields for inline issue creation

Inline issue creation allows a user to create a JIRA Software issue from a review comment. See Creating JIRA issues from the review.

This requires JIRA 5.0, or later, and is disabled if Crucible is integrated with an earlier version of JIRA Software. See Linking Crucible to JIRA.

When creating the issue, the Create Issue dialog only displays required fields for the selected issue type. However, a JIRA Software administrator can configure other fields to be required (and so displayed) from within JIRA Software. See Specifying Field Behavior.

Note that:

- Unbundled custom field types in JIRA Software are not supported for inline issue creation.
- If any required field for the selected issue type is not supported, Crucible displays an error, with a link to create the issue directly in JIRA Software. This link will pre-populate the project, issue type, summary and description fields, but will not create a link from the comment to the issue.

The tables below list the supported JIRA Software field types.

### Built-in fields

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>Affects Version/s</td>
<td><strong>YES</strong></td>
</tr>
<tr>
<td>Assignee</td>
<td>N/A</td>
</tr>
<tr>
<td>Attachment</td>
<td>N/A</td>
</tr>
<tr>
<td>Documentation for Crucible 4.0</td>
<td></td>
</tr>
<tr>
<td>-------------------------------</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Component/s</th>
<th>YES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>YES</td>
</tr>
<tr>
<td>Due Date</td>
<td>NO</td>
</tr>
<tr>
<td>Environment</td>
<td>YES</td>
</tr>
<tr>
<td>Fix Version/s</td>
<td>YES</td>
</tr>
<tr>
<td>Issue Type</td>
<td>N/A</td>
</tr>
<tr>
<td>Labels</td>
<td>YES</td>
</tr>
<tr>
<td>Linked Issues</td>
<td>NO</td>
</tr>
<tr>
<td>Log Work</td>
<td>NO</td>
</tr>
<tr>
<td>Priority</td>
<td>YES</td>
</tr>
<tr>
<td>Reporter</td>
<td>N/A</td>
</tr>
<tr>
<td>Resolution</td>
<td>N/A</td>
</tr>
<tr>
<td>Security Level</td>
<td>YES</td>
</tr>
<tr>
<td>Summary</td>
<td>YES</td>
</tr>
<tr>
<td>Time Tracking</td>
<td>YES</td>
</tr>
</tbody>
</table>

**Bundle custom field types**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bug Import Id</td>
<td>N/A</td>
</tr>
<tr>
<td>Date Picker</td>
<td>NO</td>
</tr>
<tr>
<td>Free Text Field</td>
<td>YES</td>
</tr>
<tr>
<td>Hidden Job Switch</td>
<td>NO</td>
</tr>
<tr>
<td>Job Checkbox</td>
<td>NO</td>
</tr>
<tr>
<td>Multi Checkboxes</td>
<td>NO</td>
</tr>
<tr>
<td>Multi Select</td>
<td>NO</td>
</tr>
<tr>
<td>Number Field</td>
<td>YES</td>
</tr>
<tr>
<td>Radio Buttons</td>
<td>NO</td>
</tr>
<tr>
<td>Select List</td>
<td>NO</td>
</tr>
<tr>
<td>Text Field</td>
<td>YES</td>
</tr>
</tbody>
</table>

Created by Atlassian in 2016. Licensed under a Creative Commons Attribution 2.5 Australia License.
Using Crucible gadgets

This page explains how to add a Crucible gadget to a JIRA Software dashboard. The process is similar for adding a gadget to a Confluence page.

On this page:

Overview of Crucible gadgets
1. Add an application link from Crucible to JIRA Software
2. Add the Crucible gadget to JIRA Software’s Gadget Directory
3. Add the Crucible gadget to a JIRA Software dashboard

Overview of Crucible gadgets

As of the release of Crucible 2.3, you can display Crucible data in other Atlassian applications, such as JIRA Software and Confluence, by using Crucible gadgets.

Crucible bundles the following gadgets by default:

<table>
<thead>
<tr>
<th>Gadget Name</th>
<th>Description and Gadget URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hassle Review</td>
<td>This gadget shows you who you are still waiting on; in other</td>
</tr>
<tr>
<td>Blockers</td>
<td>words, which reviewers haven't completed your reviews.</td>
</tr>
<tr>
<td></td>
<td>The URL for this gadget is:</td>
</tr>
<tr>
<td></td>
<td><a href="http://HOSTNAME:8060/rest/gadgets/1.0/g/com.atlassian.fecru.fecru-g">http://HOSTNAME:8060/rest/gadgets/1.0/g/com.atlassian.fecru.fecru-g</a></td>
</tr>
<tr>
<td></td>
<td>Where HOSTNAME:8060 is the hostname of your Crucible instance.</td>
</tr>
<tr>
<td>Gadget</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Overdue Reviews</td>
<td>This gadget shows you reviews that are yet to be completed in the project, across all authors. This gadget is useful for managers or team leads.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Review Inbox</td>
<td>This gadget is a list of Crucible to-do items including reviews to do, comments to read or reviews to summarize.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Review Coverage</td>
<td>This gadget shows content from the innovative Review Coverage report, letting you investigate how much of your codebase has been under code review.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1. Add an application link from Crucible to JIRA Software

Go to the admin area in Crucible and set up an application link to JIRA Software.

When completing the wizard, leave the Also create a link checkbox selected, and choose the These servers fully trust each other option.
2. Add the Crucible gadget to JIRA Software's Gadget Directory

As a JIRA Software administrator you allow the use of these gadgets by adding them to the Gadget Directory. You'll need the URL listed in the table above for each gadget that you want to add.

See the JIRA Software documentation for details on this process.

3. Add the Crucible gadget to a JIRA Software dashboard

As a JIRA Software user, you can add gadgets to a JIRA Software dashboard that you have created.

Once added, the gadget will appear on your JIRA Software dashboard and display information drawn from Crucible and FishEye.

You can also add Crucible gadgets to the Confluence dashboard. See the General Gadgets Documentation for more information.

Linking to another application

Application Links (sometimes called "AppLinks") is a bundled plugin that allows you to link Atlassian applications to each other. Linking two applications allows you to share information and access one application's functions and resources from within the other.

Atlassian recommends only using OAuth authentication for application links, because of the greater security inherent with that protocol. We no longer recommend the Trusted Applications and Basic authentication types.

Create an application link

1. Click the 'cog' menu in the Crucible header, and choose Administration. You need to be logged in as an administrator to see this.
2. Choose Application Links in the left-hand panel. You'll see any links that have already been set up.
3. Enter the URL of the application you want to link to, then click Create new link.
   - If you check The servers have the same set of users... then this link will be configured using OAuth (with impersonation) authentication.
   - If you are not an admin on both servers you won't be able to set up a 2-way (reciprocal) application link. If you want to go ahead and create a 1-way link anyway, clear the I am an administrator on both instances checkbox.
4. Use the wizard to finish configuring the link. If the application you are linking to does not have the Application Links plugin, you must supply additional information to set up a link with OAuth authentication.

When you complete the wizard, the Application Links plugin will create the link between your applications using the most secure authentication method that is supported between the two applications. See the Application Links User Guide for more information.

The new link will appear on the "Configure Application Links" page, where you can:

- Edit the settings of the application link (for example, to change the authentication type of the link) using the Edit icon.
- Specify the default instance if you have multiple links to the same type of application (for example, to multiple JIRA servers) using the Make Primary link. See Making a primary link for links to the same application type for more information.

Impersonating and non-impersonating authentication types

Atlassian's application links provide both OAuth and OAuth with impersonation authentication types:

OAuth authentication

Non-impersonating authentication allows you to link applications when the applications don't share the same user base.

It always uses a pre-configured user, and not the logged-in user, when making a request. The server handling the request determines the level of access to use based on the access permissions of that pre-configured user,
and this is used for requests from all users.
See OAuth security for application links for more information.

OAuth with impersonation

Impersonating authentication makes requests on behalf of the user who is currently logged in. People see only the information that they have permission to see. This authentication type should only be used when the two servers share the same user base.

Impersonation provides greater convenience for your users – they don't need to authenticate when they request restricted resources from the remote application. The following restrictions apply:

- Both applications must be Atlassian applications.
- Users should have the same user account and use the same password on both applications.

See OAuth security for application links for more information.

Troubleshooting

**Having trouble integrating your Atlassian products with application links?**
We've developed a guide to troubleshooting application links, to help you out. Take a look at it if you need a hand getting around any errors or roadblocks with setting up application links.

Running Crucible as a Windows service

For Crucible 3.4 and later, 32-bit and 64-bit Windows installers are available. Each installer sets up the service wrapper, adds Crucible as a Windows service, and starts the service, automatically.

The installer is the recommended way to install Crucible as a service on Windows. See Installing Crucible on Windows.

If you use the FishEye installer for Windows, you can edit JVM settings using the tool included with the installer. See JVM system properties for more information.

The content on this page describes the old, deprecated method of configuring Crucible as a Windows service, and is only retained here for informational purposes.

On this page:

- Installing the Java Service Wrapper
- Setting Crucible environment variables for Windows Services
- Troubleshooting
  - Extracting files from wrapper.zip
  - Warning when using 64-bit Java JDK
  - Wrapper configuration and "-server" parameter

Installing the Java Service Wrapper

To install the Java Service Wrapper on Windows:

1. Download wrapper.zip from here.
2. Unzip the wrapper zip file into your <Crucible home directory> (that is, the directory into which Crucible was originally installed). Note, the resulting folder structure should be similar to <Crucible home directory>.
3. Tell the wrapper where to find the Java JDK by editing the `<Crucible home directory>\wrapper\conf\wrapper.conf` file, replacing this:

```
# Java Application
wrapper.java.command=java
```

with the following, and comment out the option you don't wish to use:

```
# Java Application

# Option 1: If you have JAVA_HOME defined in your Windows system environment variables, then you can use:
wrapper.java.command=%JAVA_HOME%/bin/java

# Option 2: If you have multiple JDKs installed, and you don't want to use a Windows environment variable to specify which one to use, provide the absolute path to where the JDK is installed (e.g. C:/Java/jdk1.7.0_05/bin/java):
wrapper.java.command=C:/<path to Java location>/bin/java
```

To get confirmation in the wrapper log that the wrapper is using the correct Java JDK, add the following lines to the `wrapper.conf` file:

```
# Tell the Wrapper to log the full generated Java command line.
wrapper.java.command.loglevel=INF
```

You can find the logs at `<Crucible home directory>\var\log\wrapper.log`.

4. Set the FISHEYE_INST environment variable (and other Crucible-specific environment variables) in the `<Crucible home directory>\wrapper\conf\wrapper.conf` file, following the instructions below.

5. Install Crucible as a service as follows:
   a. Open an Administrator command prompt by searching for 'Command prompt' in the Windows Start menu, right-clicking on `Command Prompt` and then choosing `Run as administrator`.
   b. Change directory to `<Crucible home directory>\wrapper\bin` and run `Fisheye-Install-NTService.bat`. If you run into any problems starting the wrapper, you'll find its logs in `<Crucible home directory>\var\log\wrapper.log`.

6. Start the Crucible service (which has the name 'Fisheye') from the Windows Control Panel; you can search in the Start menu for 'services', and in the list of services, right-click on the 'Fisheye' item and choose `Start`. You can also stop the Crucible service in this way.

Please note that:

- If you make changes to the `wrapper.conf` file, having already started the service, you need to stop and then restart the service for it to make use of the changed configuration.
- If in future you move the Crucible home directory, you will need to uninstall (using `Fisheye-Uninstall-NTService.bat`) and then reinstall the Crucible service.

### Setting Crucible environment variables for Windows Services

Please note, that if you run Crucible as a Windows service, any Crucible-specific environment variables must be set in your `<Crucible home directory>\wrapper\conf\wrapper.conf` file.
If you run into any problems starting the wrapper, you’ll find its logs in `<Crucible home directory>\var\log\wrapper.log`.

If there are other Java parameters you wish to add, then you will need to add them under the additional parameters section, e.g.

```java
# JDK Additional Parameters for jmx
wrapper.java.additional.4=-Dcom.sun.management.jmxremote
wrapper.java.additional.5=-Dcom.sun.management.jmxremote.port=4242
wrapper.java.additional.6=-Dcom.sun.management.jmxremote.authenticate=false
wrapper.java.additional.7=-Dcom.sun.management.jmxremote.ssl=false
wrapper.java.additional.8=-Dcom.sun.management.jmxremote.authenticate=false
wrapper.java.additional.9=-Dcom.sun.management.jmxremote.password.file=wrapper/jmxremote.password
wrapper.java.additional.10=-Dwrapper.mbean.name="wrapper:type=Java Service Wrapper Control"
```

To add the FISHEYE_INST environment variable, the Java MaxPermSize parameter, or the -Xrs options, use the following:

```java
wrapper.java.additional.11=-Dfisheye.inst="c:/path/to/FISHEYE_INST"
wrapper.java.additional.12=-XX:MaxPermSize=128m
wrapper.java.additional.13=-Xrs
```

Note that the `-Xrs` options should be used when running Crucible as a service under Windows to prevent the JVM closing when an interactive user logs out.

Your memory settings can also be found in this file:

```java
# Initial Java Heap Size (in MB)
wrapper.java.initmemory=256

# Maximum Java Heap Size (in MB)
wrapper.java.maxmemory=1024
```

Increase these values if you have a large repository or expect to use more memory (init of 256, and a max of 1024 are the default values).

In FishEye/Crucible 1.6.4 and higher, you can check the JVM input arguments by clicking System info, under 'System Settings' in the admin area.

**How to change JVM settings when using FishEye installer**

If you are using the new Crucible installer for Windows, up to Crucible 3.4.3 you can edit JVM options using this tool:

```
http://www.apache.org/dist/commons/daemon/binaries/windows/commons-daemon-1.0.15-bin-windows.zip
```

To use it, you need to rename "prunmgr.exe" from the zip file to "Atlassian FishEye.exe" or "Atlassian Crucible.exe" depending on which installer you used. Then JVM options such as Xmx and XX:MaxPermSize can be edited on the Java tab.

**For Crucible 3.4.4 onwards** the tool is included in the installer. You can use it by going to Windows Start Menu > All Programs > Crucible > Configure Crucible.
Troubleshooting

Extracting files from wrapper.zip

Some customers have reported trouble running the wrapper. These can be avoided by:

- Uncompressing wrapper.zip with Winzip or WinRAR rather than using the **Extract All** command in the Windows right-click contextual menu.
- If the wrapper.zip filename appears green instead of black in Windows Explorer, decrypt it, prior to unzipping its contents, by right-clicking on the file, choose **Properties**, click the **Advanced** button, then clear the **Encrypt contents to secure data** checkbox.

Warning when using 64-bit Java JDK

When using a 64-bit Java JDK with the wrapper obtained via the link in the install instructions above, you may see the following in the wrapper.log file:

```
WARNING - Unable to load the Wrapper's native library 'wrapper.dll'. The file is located on the path at the following location but could not be loaded:
C:\installs\service\fisheye28\wrapper\lib\wrapper.dll.

Please verify that the file is readable by the current user and that the file has not been corrupted in any way. System signals will not be handled correctly.
```

This is caused by using a 64-bit JDK (even on a 64-bit machine). Changing to a 32-bit version of the JDK will prevent this warning. Community Edition versions of the 64-bit Windows Java Service Wrapper are not currently available.

Wrapper configuration and "-server" parameter

Please note that the wrapper configuration provided above uses the `-server` parameter to enable the **Java HotSpot(TM) Server VM**. This feature is only available if you use the JDK. If you use the JRE you will likely get the following error in your logs:

```
INFO | jvm 1 | 2010/12/20 18:19:28 | Error: missing `server` JVM at `C:\Program Files\Java\jre6\bin\server\jvm.dll'.
```

A common issue is that customers remove the `-server` parameter from the `wrapper.conf` file. Please note that if you do this, the wrapper script will ignore any of the following JVM parameters in the file unless you change the sequence to be in order, starting from `wrapper.java.additional.1`. This is an issue with the Wrapper application.

In this situation it's best to install and run Fisheye/Crucible with the JDK to get all the advantages of the `-server` functionality. You also need to force the wrapper to use the JDK by specifying the path to the Java JDK in the `wrapper.conf` file, as described in the installation instructions above.

Managing add-ons

An add-on is an installable component that supplements or enhances the functionality of Crucible in some way. For example, the **Automatic Review Creator** automatically creates a Crucible review each time a commit is made to a FishEye repository. Other add-ons are available for reviewing changes in Git or Subversion source code repositories, and for using Crucible features directly from the IntelliJ IDEA interface.

Crucible comes with many pre-installed add-ons (called system add-ons). You can install more add-ons, either by acquiring the add-on from the **Atlassian Marketplace** or by uploading it from your file system. This means that you can install add-ons that you have developed yourself. For information about developing your own add-ons for Crucible, see the **Crucible Developer documentation**.

On this page:
- About the Universal Plugin Manager (UPM)
- Administering Add-ons in Crucible

Created by Atlassian in 2016. Licensed under a **Creative Commons Attribution 2.5 Australia License**.
About the Universal Plugin Manager (UPM)

You administer add-ons for Crucible using the Universal Plugin Manager (UPM). The UPM is itself an add-on that exposes add-on administration pages in the Crucible Administration Console. UPM works across Atlassian applications, providing a consistent interface for administering add-ons in Crucible, Confluence, FishEye, JIRA, Bitbucket Server and Bamboo.

UPM comes pre-installed in recent versions of all Atlassian applications, so you do not normally need to install it yourself. However, like other add-ons, the UPM software is subject to regular software updates. Before administering add-ons in Crucible, therefore, you should verify your version of the UPM and update it if needed.

Administering Add-ons in Crucible

You can update the UPM, or any add-on, from the UPM's own add-on administration pages. Additionally, you can perform these tasks from the UPM administration pages:

- Install or remove add-ons
- Configure add-on settings
- Discover and install new add-ons from the Atlassian Marketplace
- Enable or disable add-ons and their component modules

To manage add-ons, go to the Crucible admin area, and click Manage Add-ons, under 'System Settings'.

For information on performing these add-on administration tasks, see the Universal Plugin Manager documentation.

Crucible FAQ
## Crucible FAQ

Answers to frequently asked questions about configuring and using Crucible.

- **Crucible Resources**
- **General FAQs**
  - Can I deploy Crucible or FishEye as a WAR?
  - How do I force reviews to include SVN property changes?
  - How to Automate Daily Crucible Backups
- **Licensing FAQ**
  - What happens if I decide to stop using FishEye with Crucible
  - Do I need a FishEye license to run Crucible?
  - Updating your Crucible license
- **Support Policies**
  - Bug Fixing Policy
  - New Features Policy
  - Security Bugfix Policy
- **Troubleshooting**
  - JIRA Integration Issues
  - Problems with very long comments and MySQL migration
- **Contribution to the Crucible documentation**
- **Glossary**
  - approve
  - authors in Crucible
  - code review
  - comment
  - creator
  - defect
  - moderator
  - participant
  - permission scheme
  - permissions in Crucible
  - projects in Crucible
  - review duration
  - reviewer
  - role
  - state
  - statement of objective
  - users in Crucible
- **Collecting analytics in Crucible**

Most setup issues are likely to be related to the FishEye component of Crucible. Refer to the FishEye documentation:

- FishEye documentation
- FishEye FAQs

**Top Evaluator Questions**

- Can Crucible add support for new repositories?
- Can I purchase Crucible on its own?
- Can I trial Crucible without FishEye?
- How can I do reviews from the file system?
- How does Crucible help enforce compliance and auditability?
- How do I convince my team of the benefits of code review?
- How do I do pre-commit reviews?
- How do I raise defects in JIRA?
- How do I review patch diffs?
- What user permissions and review security is available?

Do you still have a question, or need help with Crucible? Please create a support request.

## Crucible Resources

Created by Atlassian in 2016. Licensed under a Creative Commons Attribution 2.5 Australia License.
Can I deploy Crucible or FishEye as a WAR?

Unfortunately FishEye and Crucible cannot be deployed as a WAR. FishEye has some special needs for performance reasons that are not easily supported on third-party containers. While this is an often requested feature, there are no immediate plans to provide a WAR version of FishEye or FishEye+Crucible. However the upcoming separate edition of Crucible (i.e. without FishEye) may at some stage be available as a WAR.

How do I force reviews to include SVN property changes?

Subversion (SVN) allows you to store arbitrary name/value pairs, called ‘SVN properties’, in association with files
and directories. You can use these properties to store metadata, and Subversion also uses them, for example to store where code is branched from.

These name/value pairs can only be changed as part of a changeset or commit in Subversion. As such, you will have changesets with purely changes to SVN properties, or changesets with a mix of textual changes and changes to SVN properties.

Crucible 2.6 introduced review creation without metadata to prevent SVN properties from being included in reviews. This functionality was on by default.

For Crucible 3.0 and later, this functionality is disabled by default, and affects the following actions:

- Creating a review — The Create Review link is disabled in the activity stream, dashboard and changeset page for any changeset where all the file revisions only differ by SVN properties.
- Adding content to a review — SVN property-only changesets cannot be added to the review from the ‘Add Content’ dialog. Changesets with a mix of SVN property changes and textual changes can be added to the review, however only the file revisions with textual changes are added. File revisions with both textual changes and SVN property changes are always added.

Note that you can explicitly add a particular file revision to a review regardless of whether it is a textual change or metadata-only change.

The prime motivation behind metadata checking is to prevent the creation of reviews with a large number of files which have no effective content changes. Sometimes this sort of problem is seen when there is some wholesale SVN property change, for example setting the line endings on all files (svn:eol-style). In that respect, this is a performance setting as it avoids the creation of large reviews. The properties themselves are still stored and managed in FishEye. There is no major performance impact on including properties in reviews.

Enabling this functionality can be done by starting up Crucible with the following system property:

```
-Dcrucible.detect.metadata.revision.changes=true
```

**Crucible 3.0+ Changes**

In Crucible 3.0 and later the default value of this setting was changed from true to false. Due to the phased nature of FishEye indexing, changesets are available for review much earlier in their overall processing. In particular changesets are available for review prior to having their line count and diff information processed. In this state all changes look somewhat like metadata only changes. Reviews created in this state with metadata detection enabled will cause the changes to be excluded from the review.

**How to Automate Daily Crucible Backups**

Configuring Crucible backups is easy. To set daily Crucible backups, open the administration page, click Backup (under ‘System’ on the left), and simply follow the instructions set out on the Backing up and restoring Crucible page.

**Licensing FAQ**

### Crucible Licensing FAQ

- **What happens if I decide to stop using FishEye with Crucible** — Crucible can be run as an application alone, without FishEye. However, if you decide to stop using FishEye with Crucible, you will lose certain functionality and will need to make configuration changes.
- **Do I need a FishEye license to run Crucible?** — FishEye and Crucible are separate products. They can be run separately, and they can also be run together.
- **Updating your Crucible license**

**What happens if I decide to stop using FishEye with Crucible**

Crucible can be run as an application alone, without FishEye. However, if you decide to stop using FishEye with Crucible, you will lose certain functionality and will need to make configuration changes.

**On this page:**
How do I run Crucible without FishEye?

- **Have a valid Crucible license but not a FishEye license**
  To run Crucible without FishEye you need to have a valid Crucible license but not a FishEye license. If you want to disable FishEye enter `Disabled` in the license field. Crucible will actually use a "light" mode of FishEye that comes pre-bundled and does not need to be installed separately. For more information on Crucible with light FishEye, see How is Crucible without FishEye different from using Crucible with FishEye? below.

- **No need to reconnect your repositories**
  Any repositories that you have currently defined in FishEye will not be visible in Crucible after removing FishEye (no more `Source` tab). The repositories however, will continue to update as usual without any intervention. You can add additional repositories as described in the FishEye documentation. Note, all repositories supported in FishEye are supported in light FishEye.

  *Legacy "lightSCM" plugins, like the Crucible Subversion SCM plugin, will still work. However, the functionality will be limited compared to using Crucible with light FishEye. See the Can I still use lightSCM plugins with Crucible? section below for more information.*

- **You need to reindex your repositories after removing a FishEye license**
  When you remove a FishEye license, and operate with only a Crucible license, you need to reindex those repositories that were originally indexed under a FishEye license. You do not need to remove those repositories, you just need to run a re-index to create an index which is compatible with your new license setup.

How is Crucible without FishEye different from using Crucible with FishEye?

The following changes in functionality will occur if you use Crucible without FishEye (i.e. use Crucible with "light" FishEye).

**Conducting Reviews**

- When using Iterative reviews in Crucible, you will not be prompted when a new version of a file is available.

**Viewing Repositories/Files**

- Files and changesets displayed in activity streams (e.g. the dashboard activity stream) will not render as links to the relevant files/changesets.
- You will not be able to see your content roots and repositories associated with projects.
- You will no longer be able to see repository lists and browse repositories using the ‘Source’ tab.

**Charts**

- You will not be able to view charts or code metrics.

Do I need a FishEye license to run Crucible?

FishEye and Crucible are separate products. They can be run separately, and they can also be run together.

We recommend that you run Crucible together with FishEye. If you choose to run Crucible alone without FishEye, you will have access to your repositories via the "light" FishEye implementation bundled with Crucible. However, a number of FishEye's advanced features will not be available to you, including pre-caching repository content (for improved performance), the ability to search and browse through repositories and FishEye's activity graphs.
For more information, please read the following FAQ: What happens if I decide to stop using FishEye with Crucible

### Updating your Crucible license

When you upgrade or renew your Crucible license, you will receive a new license key – you’ll need to update your Crucible server with the new license.

Note that you can access your current license, or obtain a new license, by going to my.atlassian.com.

#### Related pages:

- Crucible and FishEye
- What happens if I decide to stop using FishEye with Crucible

#### To update your Crucible license key:

1. Log in to Crucible Admin area.
2. Click System Info (under ‘System Settings’).
3. Click Edit License and paste your new license key into the appropriate text box.
4. Paste your new license into this box. Obtain a new license by clicking my.atlassian.com in the 'Information' section.
5. Click Update.

---

**Support Policies**

Welcome to the support policies index page. Here, you’ll find information about how Atlassian Support can help you and how to get in touch with our helpful support engineers. Please choose the relevant page below to find out more.

- Bug Fixing Policy
- New Features Policy
- Security Bugfix Policy

To request support from Atlassian, please raise a support issue in our online support system. To do this, visit support.atlassian.com, log in (creating an account if need be) and create an issue under Crucible. Our friendly support engineers will get right back to you with an answer.

**Bug Fixing Policy**
Summary

- Our Support team will help with workarounds and bug reporting
- We'll generally fix critical bugs in the next maintenance release
- We schedule non-critical bugs according to a variety of considerations

Report a bug

Building an add-on

Are you developing an add-on for an Atlassian product or using one of our APIs? Report any related bugs here.

Bug reports

Atlassian Support is eager and happy to help verify bugs—we take pride in it! Create an issue in our support system, providing as much information as you can about how to replicate the problem you're experiencing. We'll replicate the bug to verify, then lodge the report for you. We'll also try to construct workarounds if possible.

Search existing bug reports

Use our issue tracker to search for existing bugs, and watch the ones that are important to you. When you watch an issue, we'll send you an e-mail notification when the issue's updated.

How we approach bug fixing

Maintenance (bug fix) releases come out more frequently than major releases, and attempt to target the most critical bugs affecting our customers. The notation for a maintenance release is the final number in the version (the 1 in 6.0.1, for example).

If a bug is critical (production application down or major malfunction causing business revenue loss or high numbers of staff unable to perform their normal functions) we'll fix it in the next maintenance release, provided that:

- The fix is technically feasible (it doesn't require a major architectural change)
- It doesn't impact the quality or integrity of a product

For non-critical bugs, the developer assigned to fixing bugs prioritises the bug according to these factors:

- How many of our supported configurations are affected by the problem
- Whether there is an effective workaround or patch
- How difficult the issue is to fix
- Whether many bugs in one area can be fixed at one time

Developers responsible for fixing bugs also monitor comments on existing and new bugs, so you can comment to provide feedback if you need to. We give high priority to security issues.

When considering the priority of a non-critical bug, we try to determine a value score for a bug. The score takes into account the severity of the bug from our customers’ perspective, how prevalent the bug is, and whether new features on our roadmap may render the bug obsolete. Our developers combine the value score with a complexity score (how difficult the bug is) when selecting issues to work on.

Further reading

See Atlassian Support Offerings for more support-related information.

New Features Policy

Summary

- We encourage and display customer comments and votes openly in our issue tracking system, http://jira.a
How to track what features are being implemented

When a new feature or improvement is scheduled, the 'fix-for' version will be indicated in the JIRA issue. This happens for the upcoming release only. We maintain roadmaps for more distant releases internally, but because these roadmaps are often pre-empted by changing customer demands, we do not publish them.

How Atlassian chooses what to implement

In every major release we aim to implement highly requested features, but it is not the only determining factor. Other factors include:

- **Customer contact**: We get the chance to meet customers and hear their successes and challenges at Atlassian Summit, Atlassian Unite, developer conferences, and road shows.
- **Customer interviews**: All product managers at Atlassian do customer interviews. Our interviews are not simply to capture a list of features, but to understand our customers' goals and plans.
- **Community forums**: There are large volumes of posts on answers, of votes and comments on jira.lassian.com, and of conversations on community forums like groups on LinkedIn.
- **Customer Support**: Our support team provides clear insights into the issues that are challenging for customers, and which are generating the most calls to support
- **Atlassian Experts**: Our Experts provide insights into real-world customer deployments, especially for customers at scale.
- **Evaluator Feedback**: When someone new tries our products, we want to know what they liked and disliked and often reach out to them for more detail.
- **In product feedback**: The JIRA Issue Collectors that we embed our products for evaluators and our Early Access Program give us a constant pulse on how users are experiencing our product.
- **Usage data**: Are customers using the features we have developed?
- **Product strategy**: Our long-term strategic vision for the product.
- Please read our post on Atlassian Answers for a more detailed explanation.

How to contribute to feature development

**Influencing Atlassian’s release cycle**

We encourage our customers to vote on issues that have been raised in our public JIRA instance, http://jira.lassian.com. Please find out if your request already exists - if it does, vote for it. If you do not find it you may wish to create a new one.

**Extending Atlassian products**

Atlassian products have powerful and flexible extension APIs. If you would like to see a particular feature implemented, it may be possible to develop the feature as a plugin. Documentation regarding the plugin APIs is available. Advice on extending either product may be available on the user mailing-lists, or at Atlassian Answers.

If you require significant customisations, you may wish to get in touch with our partners. They specialise in extending Atlassian products and can do this work for you. If you are interested, please contact us.

Further reading

See Atlassian Support Offerings for more support-related information.

**Security Bugfix Policy**

See Security @ Atlassian for more information on our security bugfix policy.

Troubleshooting
Crucible Troubleshooting

The most common cause of FishEye/Crucible issues is an incorrect symbolic setup (trunk/branch/tag) for Subversion repositories. If you are using Subversion and your initial index is taking forever, double-check that your symbolic setup matches your repository.

FishEye runs with the default Java heap of 64 megabytes. This is sometimes problematic for FishEye, especially for Subversion repositories during the initial scan. You can give FishEye’s JVM more memory by setting the FISHEYE_OPTS environment variable.

Starting Crucible with the command line options --debug --debug-perf will print a lot of information to Crucible's logs. This can give you an insight into what is happening and possibly where you are stuck. Attach these logs along with your config.xml to an Atlassian support ticket, to speed up your support request.

JIRA Integration Issues

*Users are mapped to their own accounts when using Trusted Applications.*

If you (or the general account used for JIRA access, if not using Trusted Applications) do not have the permissions to carry out the JIRA actions linked from Crucible, an error will occur. Depending on the error returned from JIRA, Crucible may not display the error correctly or display it at all, simply reporting that “An error has occurred”. To investigate what the error was, you can access the Crucible debug log, named fisheye-debug.log.YYYY-MM-DD under the dist.inst/var/log folder of your Crucible installation. In the debug log, look for the date and time when your error took place. Here, you will be able to follow the links and see what error the JIRA instance was producing by clicking through to JIRA.

If you are using JIRA 4.0 you will not be able to create subtasks in versions of Crucible prior to 2.0.5. If you are affected by this bug, please upgrade to at least 2.0.6 (2.0.5 is affected by another bug CRUC-2471).

Problems with very long comments and MySQL migration

*Affects Version*

This issue was introduced in Crucible 2.0 and fixed in Crucible 2.1.

*Issue Symptoms*

There is a known issue with Crucible 2.0.x and very long comments when migrating your database to MySQL. In some circumstances, this might result in truncation of very long comments, causing data loss.

Depending on your MySQL configuration, you may see an error message like this while migrating to MySQL, causing the migration to fail:

```
2009-07-16 16:56:12,390 ERROR [ThreadPool1] fisheye.app com.cenqua.crucible.actions.admin.database.DBEditHelper-doGet -
  Database migration failed:
  java.sql.BatchUpdateException: Data truncation: Data too long for column 'cru_message' at row 1
  java.sql.BatchUpdateException: Data truncation: Data too long for column 'cru_message' at row 1
```

You may not see the message if you are running MySQL with default settings.

For more information, see the JIRA issue.
Workaround

If your data contains very long comments or review descriptions (longer than 21,845 multibyte unicode characters), consider avoiding use of MySQL until you can upgrade the product. Alternatively, use PostgreSQL or the default (built-in) HSQLDB database.

This issue is now resolved. This issue was introduced in Crucible 2.0 and fixed in Crucible 2.1.

Requesting Support

If you require assistance in resolving the problem, please raise a support request under the Crucible project.

Contributing to the Crucible documentation

Would you like to share your Crucible hints, tips and techniques with us and with other Crucible users? We welcome your contributions.

On this page:

- Updating the documentation
  - Getting permission to update the documentation
  - Our style guide
  - How we manage community updates
- Contributing documentation in other languages

Updating the documentation

Have you found a mistake in the documentation, or do you have a small addition that would be so easy to add yourself rather than asking us to do it? You can update the documentation page directly

Getting permission to update the documentation

Please submit the Atlassian Contributor License Agreement.

Our style guide

Please read our short guidelines for authors.

How we manage community updates

Here is a quick guide to how we manage community contributions to our documentation and the copyright that applies to the documentation:

- Monitoring by technical writers. The Atlassian technical writers monitor the updates to the documentation spaces, using RSS feeds and watching the spaces. If someone makes an update that needs some attention from us, we will make the necessary changes.
- Wiki permissions. We use wiki permissions to determine who can edit the documentation spaces. We ask people to sign the Atlassian Contributor License Agreement (ACLA) and submit it to us. That allows us to verify that the applicant is a real person. Then we give them permission to update the documentation.
- Copyright. The Atlassian documentation is published under a Creative Commons CC BY license. Specifically, we use a Creative Commons Attribution 2.5 Australia License. This means that anyone can copy, distribute and adapt our documentation provided they acknowledge the source of the documentation. The CC BY license is shown in the footer of every page, so that anyone who contributes to our documentation knows that their contribution falls under the same copyright.

Contributing documentation in other languages

Have you written a guide to Crucible in a language other than English, or translated one of our guides? Let us know, and we will link to your guide from our documentation.
Glossary

Code review terminology can be confusing as there are many different words for the concepts, roles and process. Crucible has adopted the following terms (click for definitions):

approve
authors in Crucible
code review
comment
creator
defect
moderator
participant
permission scheme
permissions in Crucible
projects in Crucible
review duration
reviewer
role
state
statement of objective
users in Crucible
approve

Issuing a review to the reviewers is known as approving the review.

authors in Crucible

The author is the person primarily responsible for acting on the outcomes of the review. In the vast majority of cases the author will be the person who made the code change under review.

Note: to map your repository username to your FishEye/Crucible username, see Changing your User Profile.

code review

Without prejudice to 'code inspection', 'peer review' or a myriad of other terms, Crucible uses the phrase code review for simplicity.

See Getting Started.

comment
A comment is a short textual note that is linked to a review, revision/diff, source line, or to another comment. See Commenting on reviews.

creator

The creator is the person who creates the review. In most cases this person will also act as moderator.

defect

A defect is a comment flagged as something that requires addressing and includes optional defect classifications. See Flagging Defects and Customising the defect classifications.

moderator

The moderator is the person responsible for creating the review, approving the review, determining when reviewing is finished, summarizing the outcomes and closing the review. By default, the moderator is the creator. See also author, the person whose changes to the code are to be reviewed.

participant

Crucible uses the terms creator, author, moderator, and reviewer to describe the roles of review participants.

permission scheme

A permission scheme assigns particular permissions to any or all of the following:

- Particular Users.
- Particular Groups.
- All logged-in users.
- Anonymous Users
- People in particular Review Roles, such as:
  - Author
  - reviewer
  - creator
  - moderator

The scheme's permissions will apply to all reviews belonging to the project(s) with which the scheme is associated.

You can create as many permission schemes as you wish. Each permission scheme can be associated with many projects or just one project, allowing you to tailor appropriate permissions for individual projects as required.

See Creating a permission scheme.

permissions in Crucible

A permission is the ability to perform a particular action in Crucible, e.g. 'Create Review'. Permissions are assigned to particular users, groups or review roles by means of permission schemes.

The following permissions are available:

<table>
<thead>
<tr>
<th>Permission</th>
<th>Description</th>
<th>Default Assignees</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abandon</td>
<td>Ability to abandon (i.e. cancel) a review.</td>
<td>Creator Author Moderator</td>
</tr>
<tr>
<td>Approve</td>
<td>Ability to approve a review (i.e. issue it to the reviewers).</td>
<td>Creator Author Moderator</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
<td>Permissions</td>
</tr>
<tr>
<td>------------</td>
<td>------------------------------------------------------------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>Close</td>
<td>Ability to close a review once it has been summarized.</td>
<td>Creator, Author, Reviewer, Moderator</td>
</tr>
<tr>
<td>Comment</td>
<td>Ability to add or remove a comment to or from a review.</td>
<td>Creator, Author, Reviewer, Moderator</td>
</tr>
<tr>
<td>Complete</td>
<td>Ability of a reviewer to change their individual review status to Complete.</td>
<td>Reviewer</td>
</tr>
<tr>
<td>Create</td>
<td>Ability to create a review.</td>
<td>All logged-in users</td>
</tr>
<tr>
<td>Delete</td>
<td>Ability to delete a review.</td>
<td>Creator, Author, Reviewer, Moderator</td>
</tr>
<tr>
<td>Edit Review Details</td>
<td>Ability to edit a review's details and change the set of revisions being reviewed.</td>
<td>Creator, Author, Reviewer, Moderator</td>
</tr>
<tr>
<td>Re-Open</td>
<td>Ability to re-open a closed or abandoned review.</td>
<td>Creator, Author, Reviewer, Moderator</td>
</tr>
<tr>
<td>Recover</td>
<td>Ability to resurrect an abandoned (i.e. canceled) review.</td>
<td>Creator, Author, Reviewer, Moderator</td>
</tr>
<tr>
<td>Reject</td>
<td>Ability to reject a review submitted for approval (i.e. prevent it from being issued to reviewers).</td>
<td>Creator, Author, Reviewer, Moderator</td>
</tr>
<tr>
<td>Submit</td>
<td>Ability to submit a review for approval (i.e. request that the review be issued to the reviewers).</td>
<td>Creator, Author, Reviewer, Moderator</td>
</tr>
<tr>
<td>Summarize</td>
<td>Ability to summarize a review. (Normally this would be done after all reviewers have completed their review.)</td>
<td>Creator, Author, Reviewer, Moderator</td>
</tr>
<tr>
<td>Uncomplete</td>
<td>Ability of a reviewer to change their individual review status from Complete to Uncomplete.</td>
<td>Reviewer</td>
</tr>
<tr>
<td>View</td>
<td>Ability to view a review. (People without this permission will not know that the review exists.)</td>
<td>Anonymous users, All logged-in users, Creator, Author, Reviewer, Moderator</td>
</tr>
</tbody>
</table>

**projects in Crucible**

A Crucible *project* provides a way to group and manage related reviews – typically reviews that are all involved...
Documentation for Crucible 4.0

with the same software project. A Crucible project allows you to

- define default moderators, authors and reviewers for the reviews in that project.
- define which people are eligible to be reviewers for the reviews in that project.
- use permission schemes to restrict who can perform particular actions (e.g. 'Create Review') in that project.

Every Crucible review belongs to a project. Each project has a name (e.g. ACME Development) and a key (e.g. ACME). The project key becomes the first part of that project's review keys, e.g. ACME-101, ACME-102, etc:

By default, Crucible contains one project. This default project has the key 'CR' and the name 'Default Project'. See Creating a project.

**review duration**

The review duration is the period of time for which a review will run.

See Editing a project.

**reviewer**

A reviewer is a person assigned to review the change. Reviewers can make comments and indicate when they have completed their review. The moderator and author are implicitly considered to be participants of the review, but are not reviewers.

**role**

See participant.

**state**

A Crucible review moves through the following states in the following sequence:

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft</td>
<td>See Creating a Review.</td>
</tr>
<tr>
<td>Require Approval</td>
<td>Relevant only when the moderator is not the creator. See Issuing a Review.</td>
</tr>
<tr>
<td>Under Review</td>
<td>See Issuing a Review and Reviewing the Code.</td>
</tr>
<tr>
<td>Summarize</td>
<td>See Summarizing and Closing the Review.</td>
</tr>
<tr>
<td>Closed</td>
<td>See Summarizing and Closing the Review.</td>
</tr>
</tbody>
</table>

Reviews can be re-opened, i.e. moved from Summarize or Closed back to Under Review.

A review may also be in the following states:

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abandoned</td>
<td>This happens when a review is deleted.</td>
</tr>
<tr>
<td>Rejected</td>
<td>Any reviews that a moderator has rejected.</td>
</tr>
<tr>
<td>Needs Fixing</td>
<td>This means that the review state is not understood by Crucible, and indicates a programming or data issue. The review moderator can move the review into a known state if this happens.</td>
</tr>
</tbody>
</table>

**statement of objective**

A statement of objective is an optional text description of the review and any specific areas the reviewers should focus on.

**users in Crucible**

A user is a person using Crucible.

**Collecting analytics in Crucible**

We are continuously working to make Crucible better. Data about how you use Crucible helps us do that. We have updated our Privacy Policy so that we may collect usage data automatically, unless you disable collection. The data we collect includes information about the systems on which your installation of Crucible is
operating, the features you use in Crucible, and your use of common IT terminology within the product. For more details, see our Privacy Policy, in particular the ‘Analytics Information from Downloadable Products’ section.

See also our End User Agreement.

How to change data collection settings?

You can opt in to, or out of, data collection at any time. A Crucible admin can change the data collection settings by going to Analytics (under ‘Global Settings’) in the Crucible admin area.

How is data collected?

We use the Atlassian Analytics plugin to collect event data in Crucible. Analytics logs are stored locally and then periodically uploaded to a secure location.

Releases

The following pages are in the latest documentation for Crucible:

- the Crucible upgrade guide
- the Crucible security advisories
- the End of support announcements for Crucible
- the full release notes for every Crucible release.

You can get automated notifications about Crucible releases by subscribing to the Atlassian dev tools blog.

The change logs for the releases (linked below) have details of the related bug-fix releases.

**Crucible 4.2**

**28 September 2016**

- Track work for reviews using comments
- Repository renaming
- Review workflow conditions API
- Improved Bitbucket Server integrations

Read more in the Crucible 4.2 release notes and changelog.

See also the Crucible upgrade guide.

**Crucible 4.1**

**28 June 2016**

- Individual repository management permissions
- Updated Edit Review dialog
- Subversion 1.9 supported
- Subversion FSFS format 7 supported
- Subversion merges supported

Read more in the Crucible 4.1 release notes and changelog.

See also the Crucible upgrade guide.

**Crucible 4.0**

**15 March 2016**
Embedded Crowd for user management
Global permissions for application access
Improved blame annotations
Updated Application Links with built-in diagnostics
Git 2.7.3 and Hg 3.7.2 are supported

Read more in the Crucible 4.0 release notes and changelog.
See also the Crucible upgrade guide.

Crucible 3.10
28 October 2015

- Review Activity shows more activity types
- Better blame control
- Support for Atlassian Bitbucket Server
- Project keys must be uppercase
- SNI support
- LDAP synchronization

Read more in the Crucible 3.10 release notes and changelog.
See also the Crucible upgrade guide.

Crucible 3.9
28 July 2015

- New Review Activity gives easy access to review comments
- Several performance improvements
- Oracle 12c is now supported
- Git 2.5.0 and Mercurial 3.5 are now supported
- Java 7 support is removed
- Internet Explorer 9 support is removed

Read more in the Crucible 3.9 release notes and changelog.
See also the Crucible upgrade guide.

Crucible 3.8
28 April 2015

- Support for more SCM diff formats by the patch parsers
- New database index for the Review Dashboard and Review Search
- Improved Git indexing time for new branches

Read more in the Crucible 3.8 release notes and changelog.
See also the Crucible upgrade guide.

Crucible 3.7
27 January 2015

- Automatic updates for branch reviews
- Create branch reviews from the activity stream
- Git 2.x support
- Mercurial 3.x support since Crucible 3.6.3
- Internet Explorer 9 support is deprecated
Read more in the Crucible 3.7 release notes and changelog.
See also the Crucible upgrade guide.

Crucible 3.6
28 October 2014
- Branch reviews
- Actions menu
- Crucible analytics
- Performance improvements for diff calculations and the user listing page
- SSL cipher suite configuration change

Read more in the Crucible 3.6 release notes and changelog.
See also the Crucible upgrade guide.

Crucible 3.5
22 July 2014
- ADG improvements to review comments
- Administration REST APIs – /projects and /permission-schemes/
- No config needed for Stash repository update events
- New passivation mechanism to optimize Java VM heap usage
- Java 8 is now supported
- JIRA versions earlier than 5.0 are no longer supported

Read more in the Crucible 3.5 release notes and changelog.
See the Crucible upgrade guide.

Crucible 3.4
15 April 2014
- Importing Git repositories from Atlassian Stash
- Git indexing performance gains
- Review actions dialog
- Administration REST APIs – /repositories/
- Automatic fullscreen mode for reviews
- Header stalking behavior
- Installers for 64-bit and 32-bit Windows

Read more in the Crucible 3.4 release notes and changelog.
See the Crucible upgrade guide.

Crucible 3.3
11 February 2014
- Improved review subheader
- Administration REST APIs
- Subversion 1.8 is now supported
- Microsoft Internet Explorer 11 is now supported

Read more in the Crucible 3.3 release notes and changelog.
See the Crucible upgrade guide.
Crucible 3.2

27 November 2013

- Quick Search filters
- User data moved to the SQL database
- Improved protection against XSRF
- Internally managed Git repositories no longer supported by FishEye 3.2
- Microsoft SQL Server 2012 is now supported (support for SQL Server 2005 is deprecated)
- Microsoft Internet Explorer 10 is now supported (support for IE 8 is deprecated)
- MySQL 5.0 is deprecated
- PostgreSQL 8.2 is deprecated
- FishEye communication with JIRA versions older than 5.0 is no longer supported
- More in the release notes and changelog

See the Crucible upgrade guide.

Crucible older release notes (click to expand)

Crucible 3.1

27 August 2013

- Dashboard improvements
- QuickNav and QuickSearch improvements
- New JIRA issue dialog
- Transition JIRA issues from within Crucible
- Small improvements: native SVN 1.7, OpenJDK
- More in the release notes and changelog

See the Crucible upgrade guide.

Crucible 3.0

30 May 2013

- Redesigned user experience
- Review CLI tool
- Iterative pre-commit reviews
- Platform upgrades: Jetty 8, Infinity 3 DB
- Optimized indexing for new SVN repositories
- Small improvements
- More in the release notes and changelog

See the Crucible upgrade guide.

Crucible 2.10

15 January 2013

- Inline issue creation
- Repository management REST API
- Repository review creation limit
- More in the release notes
- Crucible 2.10 upgrade guide

Crucible 2.9

14 November 2012
• Simpler JIRA integration
• Better performance of the Reviews tab in JIRA
• Faster review creation for large teams
• More in the release notes
• Crucible 2.9 upgrade guide

Crucible 2.8

15 August 2012
• Mentions
• Shares
• Improved performance for the projects listing
• Support for Subversion 1.7
• End of life announcements
• More in the release notes
• Crucible 2.8 Upgrade Guide

Crucible 2.7

7 September 2011
• JIRA Transitions in Crucible
• Review Reminders
• Small Improvements
• More in the release notes
• Crucible 2.7 Upgrade Guide

Crucible 2.6

6 June 2011
• New Quick Search
• HTML Emails for Reviews
• Dashboard and Navigation Improvements
• SQL Server Support
• Oracle Support
• Review Creation without Metadata Changes
• Improved Patch Anchoring
• More in the release notes
• Crucible 2.6 Upgrade Guide

Crucible 2.5

8 February 2011
• Oracle (Beta)
• Redesigned Activity Stream
• Improved Header
• Comment Notification Batching
• More in the release notes
• Crucible 2.5 Upgrade Guide

Crucible 2.4

20 October 2010
• Easier Application Linking

Created by Atlassian in 2016. Licensed under a Creative Commons Attribution 2.5 Australia License.
• Native Repository Access
• Starter Licenses
• Adding Changesets to Reviews Simplified
• User Interface Improvements
• Snippets Tweaks
• More in the release notes
• Crucible 2.4 Upgrade Guide

Crucible 2.3
26 May 2010
• Snippet Reviews
• Changeset Discussions
• Mercurial SCM Alpha
• Review Coverage report
• Revamped Installation Process
• Gadgets
• More in the release notes
• Crucible 2.3 Upgrade Guide

Crucible 2.2
18 February 2010
• Smart Pre-Commit (Patch) Support
• 'No Moderator' Reviews
• Wizard-Like Review Creation
• Integrated Timetracking Between Crucible and JIRA
• Edit Mode for Reviews
• More in the release notes
• Crucible 2.2 Upgrade Guide

Crucible 2.1
12 November 2009
• Wiki Markup Rendering
• Progress Tracking
• Usability and Productivity Updates
• Streamlined JIRA Integration
• Review Time Tracking
• Review History Dialog
• "Blockers" Reports
• Threaded Comments
• Plugin Developer Tools
• More in the release notes
• Crucible 2.1 Upgrade Guide

Crucible 2.0
30 June 2009
• Support for iterative reviews
• New User Interface
• Indicators for read/unread comments
• Enhanced JIRA integration
• More in the release notes
Crucible 1.6
23 September 2008

- Support for non-FishEye repositories
- Confluence page reviews
- Shared file system repositories
- Enhanced pre-commit reviews & image support
- Multiple admin users
- Expanded API
- More in the release notes
- Crucible 1.6 Upgrade Guide

Crucible 1.5
14 April 2008

- Project Dashboard
- Filtered comments & defects search, with statistical summary
- Customizable email templates
- Improvements to Crucible Plugin API beta
- More in the release notes
- Crucible 1.5 Upgrade Guide

Crucible 1.2
5 Dec 2007

- Reviews grouped into projects
- Customizable permission schemes
- Plugin API
- Enhancements to user management
- JIRA integration
- Crucible 1.2 includes FishEye 1.4
- More in the release notes
- Crucible 1.2 Upgrade Guide

Crucible 1.1
18 September 2007

- Pre-commit review (patch review)
- Review participants can keep track of their progress through a review by marking each file as "done"
- Side-by-side diff mode within the Review display
- Syntax highlighting when displaying a diff
- More in the release notes
- Crucible 1.1 Upgrade Guide

Crucible 1.0.x Changelog

Security advisories (click to expand)

- Crucible Security Advisory 2015-01-21
- FishEye and Crucible Security Advisory 2014-05-21
- FishEye and Crucible Security Advisory 2014-02-26
- FishEye and Crucible Security Advisory 2013-07-16
- FishEye and Crucible Security Advisory 2012-08-21
- FishEye and Crucible Security Advisory 2012-05-17
- FishEye and Crucible Security Advisory 2012-01-31
- FishEye and Crucible Security Advisory 2011-11-22
- FishEye and Crucible Security Advisory 2011-05-16
- FishEye and Crucible Security Advisory 2011-01-12
- Crucible Security Advisory 2010-06-16
- Crucible Security Advisory 2010-05-04